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TraceCompass-2.1.0

Date:

2016/09/28

Section

Content

Pass

Fail

1 Integration 0 29
2 Junit Tests 0 18
3 TMF - Project View 0 144
4 TMF - EventsEditor 0 23
5 TMF - BookmarksView 0 17
6 TMF - Filters View 0 12
7 TMF - Colors View 0 6
8 TMF - Histogram View 0 50
9 TMF - Sequence Diagram 0 37
10 TMF - Statistics View 0 18
11 TMF - Time Chart View 0 26
12 TMF - Custom Parsers 0 28
13 TMF - State System Explorer 0 14
14 |TMF - Call Stack View 0 24
15 TMF - Remote Fetching 0 52
16 LTTng 2.0 - Control Flow View 0 54
17 LTTng 2.0 - Resources View 0 40
18 LTTng 2.0 - Control View 0 128
19 GDB Tracing 0 26
20 Tracing RCP 0 31
21 LTTng 2.0 - Memory Analysis 0 20
22 LTTng 2.0 - CPU Analysis 0 26

Total Comments SWTBot
29 0
18 18
145 With comments 44
26 With comments 10
17 With comments 2
12 With comments 12

6 With comments 6
50 With comments 2
37 With comments 2
18 With comments 2
26 With comments 1
28 With comments 5
14 0
24 With comments 10
52 15
54 With comments 5
40 With comments 3
128  |with comments 20
26 0
32 0
22 With comments 2
27 With comments 0
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23 Trace Synchronization 0 13 13 With comments 0
24 XML analysis 0 40 40 With comments 0
25 Network Trace analysis 0 11 11 With comments 3
26 Critical path 0 45 45 With comments 0
27 LTTng 2.0 - I/O Analysis 0 18 21 With comments 0
28 LTTng 2.0 - VM Analysis 0 39 39 With comments 0
29 LAMI 0 18 18 0
30 Flame Graph 0 19 24 With comments 2
Total: 0 1007 11 1018 162
Open Fixed Total
Bug Reports 13 0 13




Integration

2.1.0-TraceCompassTestCases - Integration

Test Case

Action

Verification

1 Verify C/C++ EPP Package RC1
1.1 Download EPP Package Download, extract and start EPP package EPP Package starts
Version of Tracing Features Verify that all tracing features and plug-ins are present and have the
1.2 Go to Help -> About Eclipse -> Installion Details correct version (TMF, LTTng, CTF, GDBTrace)
1.3 |TMF presence Open Tracing perspective Tracing perspective opens
1.4 |LTTng presence Open LTTng Kernel perspective LTTng Kernel perspective
1.5 |GDB Tracepoint Analysis presence Open GDB Trace perspective GDB Tracepoint analysis perspective
Go to Help -> Install New Software... -> Update site "Neon - http://downloaqgVerify that all LTTng Kernel, LTTng UST and GDB Trace are availab)
1.6 |Neon Update Site eclipse.org/staging/neon/"
2 Verify C/C++ EPP Package RC2
Download, extract and start EPP package. Check the mailing list for the pac|
2.1 |Download EPP Package https://dev.eclipse.org/mailman/listinfo/epp-dev EPP Package starts
Version of Tracing Features Verify that all tracing features and plug-ins are present and have the
2.2 Go to Help -> About Eclipse -> Installation Details correct version (TMF, LTTng, CTF, GDBTrace)
2.3 | TMF presence Open Tracing perspective Tracing perspective opens
2.4 |LTTng presence Open LTTng Kernel perspective LTTng Kernel perspective
2.5 |GDB Tracepoint Analysis presence Open GDB Trace perspective GDB Tracepoint analysis perspective
Go to Help -> Install New Software... -> Use the testing update site "Neon -| Verify that all LTTng Kernel, LTTng UST and GDB Trace are availab)
2.6 |Neon Update Site http://download.eclipse.org/staging/neon/"
3 Verify C/C++ EPP Package RC3
3.1 |Download EPP Package Download, extract and start EPP package EPP Package starts
Version of Tracing Features Verify that all tracing features and plug-ins are present and have the
3.2 Go to Help -> About Eclipse -> Installation Details correct version (TMF, LTTng, CTF, GDBTrace)
3.3 |TMF presence Open Tracing perspective Tracing perspective opens
3.4 |LTTng presence Open LTTng Kernel perspective LTTng Kernel perspective
3.5 |GDB Tracepoint Analysis presence Open GDB Trace perspective GDB Tracepoint analysis perspective
Go to Help -> Install New Software... -> Use the testing update site "Neon -| Verify that all LTTng Kernel, LTTng UST and GDB Trace are availab)
3.6 |Neon Update Site http://download.eclipse.org/staging/neon/"
4  Verify C/C++ EPP Package RC4
4.1 Download EPP Package Download, extract and start EPP package EPP Package starts
Verify that all tracing features and plug-ins are present and have the
Version of Tracing Features correct version (TMF, LTTng Control, LTTng Kernel, LTTng UST, CTF,
4.2 Go to Help -> About Eclipse -> Installation Details GDBTrace)
4.3 | TMF presence Open Tracing perspective Tracing perspective opens
4.4 |LTTng presence Open LTTng Kernel perspective LTTng Kernel perspective
4.5 |GDB Tracepoint Analysis presence Open GDB Trace perspective GDB Tracepoint analysis perspective
Go to Help -> Install New Software... -> Use the testing update site "Neon -| Verify that all LTTng Kernel, LTTng UST and GDB Trace are availab)
4.6 |Neon Update Site http://download.eclipse.org/staging/neon/"
5 Verify Update Site
Download Eclipse for Committers and install LTTng Kernel, LTTng UST,
GDBTrace and PCAP Network Analysis from main Mars testing Update site
5.1 |Neon Update Site "Neon - http://download.eclipse.org/staging/neon/" Verify that installation was successful
Download Eclipse for Committers and install LTTng Kernel, LTTng Control,
LTTng UST, GDBTrace and PCAP Network Analysis from the Linux Tools
Update site
5.2 |Trace Compass Update Site http://download.eclipse.org/tracecompass/neon/milestones Verify that installation was successful
Download Eclipse for Committers from Neon SRO and install LTTng, LTTng
Kernel, GDBTrace and PCAP Network Analysis from main Mars Update site;.
http://download.eclipse.org/releases/neon
Upgrade using Neon Update Site Try to update the installation using the testing Neon update site.
5.3 Neon - http://download.eclipse.org/staging/neon/ Verify that installation was successful

Pass

Pass
Pass
Pass
Pass

Pass

Pass

Pass
Pass
Pass
Pass

Pass

Pass

Pass
Pass
Pass
Pass

Pass

Pass

Pass
Pass
Pass
Pass

Pass

Pass

Pass

Pass

Comment
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5.4

Upgrade using Trace Compass Update
Site

Download Eclipse for Committers from Neon SRO and install LTTng, LTTng
Kernel, LTTng UST, GDBTrace and PCAP Network Analysis from the Trac
Compass release Update site.
http://download.eclipse.org/tracecompass/releases/2.0.1/repository

Try to update the installation using the Trace Compass update site http:
/ldownload.eclipse.org/tracecompass/neon/milestones

Verify that installation was successful

5.5

Upragde from previous EPP

Download Eclipse previous C/C++ EPP package. Try to upgrade using both|
update sites:

(TODO find correct job: https://hudson.eclipse.org/packaging/job/luna.epp-
tycho-build/128/artifact/org.eclipse.epp.packages/archive/repository/)

"Mars - http://download.eclipse.org/releases/maintenance”

The information about the update sites to use is usually posted on epp-dev

Verify that installation was successful

6.1

Verify Update Site

Trace Compass update site

Release outside release train

Download Eclipse standard and install LTTng Kernel, LTTng Control, LTTng
UST, GDBTrace and PCAP Network Analysis from main
Update site: http://download.eclipse.org/tracecompass/stable/repository/

Verify that installation was successful

N/A

6.2

Upgrade using Trace Compass
update site

Download Eclipse standard from Luna SRO and install LTTng, LTTng Kerne|
LTTng UST, GDBTrace and PCAP Network Analysis from the Luna SRO
Linux Tools Update site.

http://download.eclipse.org/linuxtools/update-3.1

Try to update the installation using the Trace Compass update site.

http://download.eclipse.org/tracecompass/stable/repository/

Verify that installation was successful

N/A




Junit Tests

18

Target:

Ubuntu 12.04 64 bit and on
Hudson

2.1.0-TraceCompassTestCases - JUnits

1.1

Test Case

Junit Test Cases
CTF Core Tests Plug-in

Run manually or with Jenkins

Verification

All test cases passed

1.2

CTF Parser Tests Plug-in

Run manually or with Jenkins

All test cases passed

1.3

State System Core Tests Plug-in

Run manually or with Jenkins

All test cases passed

14

TMF Core Tests Plug-in

Run manually or with Jenkins

All test cases passed

1.5

TMF Ul Tests Plug-in

Run manually or with Jenkins

All test cases passed

1.6

TMF Ul SWTBot Tests Plug-in

Run manually or with Jenkins

All test cases passed

1.7

CTF Support for TMF SWTBot
Tests Plug-in

Run manually or with Jenkins

All test cases passed

1.8

TMF Xml Analysis Core Tests
Plug-in

Run manually or with Jenkins

All test cases passed

1.9

TMF Xml Analysis Ul Tests Plug-in

Run manually or with Jenkins

All test cases passed

e

.10

LTTng Control Core Tests Plug-
in

Run manually or with Jenkins

All test cases passed

-

1

LTTng Control Ul Tests Plug-in

Run manually or with Jenkins

All test cases passed

-

12

LTTng Kernel Analysis Core
Tests Plug-in

Run manually or with Jenkins

All test cases passed

-

A3

LTTng Kernel Analysis Ul Tests
Plug-in

Run manually or with Jenkins

All test cases passed

-

.14

LTTng Kernel Ul SWTBot Tests
Plug-in

Run manually or with Jenkins

All test cases passed

-

15

LTTng Userspace Tracer Analysis
Core Test Plug-in

Run manually or with Jenkins

All test cases passed

-

.16

LTTng Userspace Tracer Analysis
Ul Test Plug-in

Run manually or with Jenkins

All test cases passed

-

A7

GDB Tracepoint Analysis Core
Tests Plug-in

Run manually or with Jenkins

All test cases passed

-

.18

GDB Tracepoint Analysis Ul Tests

Plug-in

Run manually or with Jenkins

All test cases passed

Pass
Pass
Pass
Pass
Pass
Pass

Pass

Pass

Pass

Pass
Pass

Pass

Pass

Pass

Pass

Pass

Pass

Pass

Comment




TMF - Project View

2.1.0-TraceCompassTestCases - ProjectView

144

44

Target: |Ubuntu 16.04 64 bit
Test Case Action Verification
1 Preparation
1.1 Step 1 Open LTTng Kernel perspective LTTng perspective opens with correct views SWTBot Pass
1.2 Step 2 Open Navigator View (used for independent verification) Navigator View opens SWTBot Pass
2 Project Creation
2.1 New Project Wizard Open New Tracing Project Wizard Tracing Project Wizard opens SWTBot Pass
2.2 Create project Specify a project name and Ffinish Tracing project appears in Project Explorer/Navigator | SWTBot Pass
2.3 Project structure Open the new Tracing project Project contains Experiments and Traces folders SWTBot Pass
3 Traces Folder
1) Download traces.zip (if necessary) and unzip into a local
directory ${local}
2) Import Custom Text and XML parsers
(ExampleCustomXmlParser.xml,
ExampleCustomTxtParser.xml) from directory
traces/customParsers into your workspace from the
Manage Custom Parsers dialog.
Preparation SWTBot Pass
3.1 Traces Folder menu Select the Traces folder and open its context menu Correct menu opens (Import, Refresh) SWTBot Pass
3.2 Trace Import Wizard Select Import Trace Import Wizard appears SWTBot Pass
1) Browse to directory ${local}/traces/import/
2) Select trace ExampleCustomTxt.log
3) Keep <Auto Detection>, Select "Import unrecognized
traces", unselect "Overwrite existing without warning" and
Import single custom text trace [select "Create Links to workspace" and Imported trace appear in Traces Folder and the Trace
3.3 (link to workspace) 4) press Finish Type Tmf Generic is set. Make sure trace can be opened| SWTBot Pass
Imported trace appear in Traces Folder and the Trace
Import Single custom XML trace Type "Custom XML log" is set. Make sure that trace can
3.4 (link to workspace) redo 3.1-3.3 but this time select ExampleCustomXml.xml be opened SWTBot Pass
Imported trace appear in Traces Folder and the Trace
Import LTTng Kernel CTF trace redo 3.1-3.3 but this time select directory kernel-overlap- Type "LTTng Kernel" is set. Make sure that trace can be
3.5 (link to workspace) testing/ opened SWTBot Pass
redo 3.3, 3.4, 3.5. However, Unselect "Create Links to
workspace" Traces are imported with new name that has a suffix (2)
at the end. Make sure that imported traces are copied
3.6 Rename + copy import When dialog box appear select Rename to the project. SWTBot Pass
redo 3.3, 3.4, 3.5. However, Unselect "Create Links to
workspace" Existing traces are deleted and new traces are
imported. Make sure that imported traces are copied to
3.7 Overwrite + copy import When dialog box appear select Overwrite the project and can be opened SWTBot Pass
redo 3.3, 3.4, 3.5. However, Unselect "Create Links to
workspace"
3.8 Skip When dialog box appear select Skip Make sure that no new trace is imported SWTBot Pass
Make sure that no dialog box appears (for renaming,
redo 3.3, 3.4, 3.5. However, Unselect "Create Links to overwriting, skipping) and existing traces are
3.9 Default overwrite workspace" and select "Overwrite existing without warning" |overwritten). Make sure trace can be opened SWTBot Pass
1) Open Import wizard (see 3.1-3.2)
2) Browse to directory ${local}/traces/import
3) Select trace unrecognized.log
4) Keep <Auto Detection>, Select "Import unrecognized
traces", unselect "Overwrite existing without warning” and |unrecognized.log is imported with trace type unknown.
select "Create Links to workspace" and The default text file icon is displayed. The trace, when
3.10 Import unrecognized 5) press Finish opened, is displayed in the text editor. SWTBot Pass
redo 3.10, however unselect "Import unrecognized traces"
3.11 Import unrecognized (ignore) unrecognized.log is not imported SWTBot Pass
Delete all traces in project - Right mouse click on Traces
Preparation folder and select "Clear" SWTBot Pass

Comment
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Import CTF trace by selection

Redo 3.5, However only select metadata file instead of

Imported trace appear in Traces Folder and the Trace
Type "LTTng Kernel" is set. Make sure that trace can be

3.12 metadata file only directory trace opened SWTBot
Preparation Delete all traces in project
1) Open Import wizard (see 3.1-3.2)
2) Browse to directory ${local}/traces/import
3) select directory import
4) Keep <Auto Detection>, Select "Import unrecognized All Traces are imported with respective trace type set.
traces", unselect "Overwrite existing without warning”, select Traces with name clashes are imported with suffix (2). 1
"Create Links to workspace" and unselect "Preserve Folder |trace (unrecognized.log) is imported with trace type
Structure” unknown. Make sure that traces can be opened which
Recursive import with auto- 5) press Finish have a trace type set. The unknown trace type should
3.13 detection (Rename All) 6) When dialog appears select "Rename All" open with the text editor. SWTBot
Preparation Delete all traces in project
1) Open Import wizard (see 3.1-3.2)
2) Browse to directory ${local}/traces/import/
3) select directory import
4) Keep <Auto Detection>, Select "Import unrecognized All Traces are imported with respective trace type set.
traces", unselect "Overwrite existing without warning”, select Traces with name clashes are overwritten . 1 trace
"Create Links to workspace" and unselect "Preserve Folder |(unrecognized.log) is imported with trace type
Structure" unknown. Make sure that traces can be opened which
Recursive import with auto- 5) press Finish have a trace type set. The unknown trace type should
3.14 detection (Overwrite All) 6) When dialog appears select Overwrite All" open with the text editor. SWTBot
Preparation Delete all traces in project
1) Open Import wizard (see 3.1-3.2)
2) Browse to directory ${local}/traces/import/
3) select directory import
4) Keep <Auto Detection>, Select "Import unrecognized
traces”, unselect "Overwrite existing without warning" and  |All Traces are imported with respective trace type set.
select "Create Links to workspace" and uncheck "preserve Traces with name clashes are not imported. 1 trace
folder structure" (unrecognized.log) is imported with trace type
Recursive import with auto- 5) press Finish unknown. The unknown trace type should open with
3.15 detection (Skip All) 6) When dialog appears select Skip All" the text editor. SWTBot
Preparation Delete all traces in project
1) Open Import wizard (see 3.1-3.2)
2) Browse to directory ${local}/traces/import/
3) select directory import
4) Keep <Auto Detection>, Select "Import unrecognized
traces", unselect "Overwrite existing without warning", selec|
"Create Links to workspace" and unselect "Preserve Folder |All Traces are imported with respective trace type set.
Structure" Traces with name clashes are either renamed,
5) press Finish overwritten or skipped as per dialog action. Make sure
Recursive import with auto- 6) When dialog appears select "Rename" that traces can be opened which have trace type set.
detection (test rename, overwrite|7) When dialog appears select "Overwrite" The unknown trace type should open with the text
3.16 and skip) 8) When dialog appears select "Skip" editor. SWTBot
Preparation Delete all traces in project
1) Open Import wizard
2) Browse to directory ${local}/traces/import/
3) select directory import
4) Select trace type "Generic CTF Trace", Select "Import
unrecognized traces", unselect "Overwrite existing without |After selecting trace type, verify that button "Import
warning", select "Create Links to workspace" and unselect unrecognized traces" is disabled.
"Preserve Folder Structure"and
Recursive import with specific 5) press Finish 4 CTF traces are imported with trace type "Generic CTF
3.17 trace type 1 (Skip All) 6) When dialog appears select Skip All" Trace" . Make sure that these traces can be opened SWTBot
Preparation Delete all traces in project
1) Open Import wizard (see 3.1-3.2)
2) Browse to directory ${local}/traces/import/
3) select directory import
4) Select trace type "LTTng Kernel Trace", Select "Import After selecting trace type, verify that button "Import
unrecognized traces", unselect "Overwrite existing without |unrecognized traces" is disabled.
warning", select "Create Links to workspace" and unselect
"Preserve Folder Structure" One LTTng Kernel trace is imported with trace type
Recursive import with specific 5) press Finish "LTTng Kernel Trace". Make sure that this trace can be
3.18 trace type 2 (Skip All) 6) When dialog appears select Skip All" opened. SWTBot

Preparation

Delete all traces in project
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Recursive import with specific

1) Open Import wizard

2) Browse to directory ${local}/traces/import/

3) select directory import

4) Select trace type "LTTng UST Trace", Select "Import
unrecognized traces", unselect "Overwrite existing without
warning", select "Create Links to workspace" and unselect
"Preserve Folder Structure"

5) press Finish

After selecting trace type, verify that button "Import
unrecognized traces" is disabled.

3 LTTng UST traces are imported with trace type
"LTTng UST Trace". Make sure that these traces can be

3.19 trace type 3 (Skip All) 6) When dialog appears select Skip All" opened. SWTBot
Preparation Delete all traces in project
1) Open Import wizard (see 3.1-3.2)
2) Browse to directory ${local}/traces/import/
3) select directory import
4) Select trace type "Tmf Generic", Select "Import All text files in directories are imported as trace and
unrecognized traces", unselect "Overwrite existing without |trace type "Tmf Generic" is set. Note that trace type
warning", select "Create Links to workspace" and unselect validation only checks for file exists and that File is not 4
"Preserve Folder Structure" directory. Make sure that these traces can be opened.
Recursive import with specific 5) press Finish However traces with wrong trace type won't show any
3.20 trace type 4 (Skip All) 6) When dialog appears select Skip All" events in the table. SWTBot
Preparation Delete all traces in project
1) Delete project "Tracing”
2) Import a trace using import wizard (File > Import... > TracingMake sure the project with name Tracing is created and
3.21 Import to default project > Trace Import) trace is imported to that project. Manual
Verify that "Into Folder" points to project
Import wizard with no project Tracing/Traces. Also make sure that project Tracing was|
3.22 selected Open import wizard while not having a project seleted created Manual
Preparation Delete all traces in project
D&D a few LTTng traces from another Tracing project's Selected traces are added to the Traces folder with
3.23 Drag and Drop from other Tracing|Traces folder proper icon. Trace can be opened. Manual
Selected traces are added to the Traces folder with
3.24 Drag and Drop from non-Tracing |D&D a few files from a non-Tracing project default icon. Files can be opened wit the default editor] Manual
Selected traces are added to the Traces folder with
default icon. For actual traces Trace type is detected
automatically. Trace can be opened, For non traces the
files are added with default icon and they can be
3.25 Drag and Drop from external D&D a few files from an external file manager opened with the default editor. Manual
1) D&D a trace with name of an existing trace into traces
Drag and Drop of trace with folder Verify that trace is added into the traces folder with the
3.26 existing name 2) Confirm the renaming of traces trace name of the orignal trace plus a suffix 2 Manual
Drag and Drop of trace with Redo test 3.26 with the same trace and same destination Verify that trace is added into the traces folder with the|
3.27 existing name (2nd time) folder trace name of the orignal trace plus a suffix 3 Manual
3.28 Import destination Open Import wizard Verify that "Into Folder" text box cannot be updated Manual
Preparation Delete all traces in project \
1) Open Import wizard (see 3.1-3.2)
2) Browse to directory ${local}/traces/import/
3) select directory import
4) Select trace type "Tmf Generic", unselect "Overwrite
existing without warning", select "Create Links to workspace"|All Traces are imported with respective trace type set.
and select "Preserve Folder Structure" The folder "clashes" is imported with its traces inside.
Recursive import with preserved |5) press Finish Make sure that traces can be opened which have a trace|
3.29 folder structure type set. Manual
1) Open Import wizard (see 3.1-3.2)
2) Browse to directory ${local}/traces/import/
3) select directory import
4) Select trace type "Tmf Generic", unselect "Overwrite
existing without warning", select "Create Links to workspace"
and select "Preserve Folder Structure” The wizard should finish quickly as no trace will be
Recursive import with preserved |5) press Finish imported. Make sure that traces can be opened which
3.30 folder structure (Skip All) 6) When dialog appears select "Skip All" have a trace type set. Manual
1) Open Import wizard (see 3.1-3.2)
2) Browse to directory ${local}/traces/import/
3) select directory import
4) Select trace type "Tmf Generic", unselect "Overwrite
existing without warning", select "Create Links to workspace"|All Traces are imported with respective trace type set
and select "Preserve Folder Structure" with suffix (2). The folder "clashes" is imported with its
Recursive import with preserved |5) press Finish traces inside. Make sure that traces can be opened
3.31 folder structure (Rename All) 6) When dialog appears select "Rename All" which have a trace type set. Manual

Delete key doesn't work to delete projects but context menu does.

Preparation

Delete all traces in project
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Delete with mixed selection of
traces and folders

1) Create a trace folder under the "Traces" folder

2) Import 2 traces under the folder

3) Open one of the traces.

4) Select the trace folder and both traces in the Project
Explorer view

A dialog should ask the user to confirm deletion of the
selected elements. Clicking OK should remove all that
was selected. The editor should be closed

no clashes: https://bugs.eclipse.org/bugs/show_bug.cgi?id=494689

Numpad-enter doesn't work

3.32 5) Right-click, Delete. Click OK. automatically. Manual
1) Create 2 trace folders under the "Traces" folder
2) Import a trace in each folder A dialog should ask the user to confirm deletion of the
Delete multiple folders 3) Select both trace folders folders. Clicking OK should remove all that was
3.33 4) Right-click delete selected. Manual
A dialog should ask the user to confirm the clear of the
Clear single Traces folder 1) Add a few folders and traces under the Traces folder folder. Clicking OK should everything under all that was|
3.34 2) Right-click on the Traces folder, Clear. Click OK. selected. Manual
1) Create 2 trace projects, both containing a few traces. A dialog should ask the user to confirm the clear of the
Clear multiple Traces folder 2) Select both Traces folder folders. Clicking OK should everything under all that
3.35 3) Right-click on one of the trace folders, Clear. Click OK. was selected. Manual
Preparation Delete all traces in project
1) Open Import wizard (see 3.1-3.2)
2) Select archive file: traces.zip
3) select directory the root directory
4) Select trace type "Automatic", unselect "Overwrite existing|
Import from archive, preserve without warning" and select "Preserve Folder Structure" All the files get imported under their respective folders.
folder structure 5) press Finish The CTF traces can be opened (kernel-overlap-testing,
3.36 simple_server...) SWTBot
Preparation Delete all traces in project
1) Open Import wizard (see 3.1-3.2)
2) Select archive file: traces.zip
3) select directory the root directory All the files get imported. The CTF traces can be
4) Select trace type "Automatic", unselect "Overwrite existingopened (kernel-overlap-testing, simple_server...). The
Import from archive, no preserve |without warning" and unselect "Preserve Folder Structure” |traces with name clashes are added with the trace name
folder structure 5) press Finish of the orignal trace plus a suffix 2 (ExampleCustom*,
3.37 6) Select Rename All when dialog comes up. kernel-overlap-testing, simple_server...). SWTBot
Preparation DO NOT delete all traces in project
1) Open Import wizard (see 3.1-3.2)
2) Select archive file: traces.zip
3) select directory the root directory
4) Select trace type "Automatic”, unselect "Overwrite existing|
without warning" and unselect "Preserve Folder Structure" |All the files get imported. The CTF traces can be
5) press Finish opened (kernel-overlap-testing, simple_server...). The
Import from archive, rename all  |6) Select Rename All when dialog comes up. traces with name clashed are added with the trace
3.38 name of the orignal trace plus a suffix 2 or 3 or 4. Manual
4 Trace
4.1 Trace menu Select an LTTng trace and open its context menu Correct menu opens (Open, Copy, Rename, ...) SWTBot
4.2 Open trace Select the Open menu Trace is opened and views are populated SWTBot
4.3 Copy trace Select the Copy menu and provide a new name. Open. Trace is replicated under the new name SWTBot
4.4 Rename trace Select the Rename menu and provide a new name. Reopen. |Trace is renamed. The trace editor is closed. SWTBot
4.5 Delete trace Select the Delete menu and confirm deletion Trace is deleted. The trace editor is closed. SWTBot
4.6 Open Trace (Accelerator) Select trace and press Enter Trace is opened SWTBot
4.7 Delete Trace (Accelerator) Select trace and press Delete and confirm deletion Trace is deleted. The trace editor is closed. SWTBot
4.8 Open Trace (double click) Double-click a trace Trace is opened SWTBot
4.9 Open Trace (already open) Open two traces. Open the Ffirst trace again. The First trace editor is simply brought to front. SWTBot
5 Experiments Folder
Correct menu opens (New, Import XML Analysis,
5.1 Experiments menu Select the Experiments folder and open it context menu Refresh) Manual
5.2 Create experiment Select the New menu and provide experiment name Experiment appears under folder, no traces yet Manual
6 Experiment
6.1 Experiment menu Select an experiment and open its context menu Correct menu opens (Select, Open, Copy, Rename, ...) | Manual
6.2 Select Traces dialog Select the Select Traces menu Select Traces dialog is open and populated w/ traces Manual
6.3 Select traces Select a few LTTng traces and finish Selected traces are imported in the experiment Manual
6.4 Open experiment Select the Open menu Experiment is opened and views are populated Manual
6.5 Copy experiment Select the Copy menu and provide a new name. Open. Experiment is replicated under the new name Manual

Failed in 3.0, 3.1, 3.2, TC 0.1, 2.0 When copying a renamed experiment the orignal named experiment i

recreated. https://bugs.eclipse.org/bugs/show_bug.cgi?id=436888
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Numpad-enter doesn't work

N/A

New feature ... not implemented yet

6.6 Rename experiment Select the Rename menu and provide a new name. Open. Experiment is renamed Manual
6.7 Delete experiment Select the Delete menu and confirm deletion Experiment is deleted Manual
6.8 Open Experiment (Accelerator) [Select an Experiment and press Enter Experiment is opened Manual
6.9 Delete Experiment (Accelerator) |[Select an Experiment and press Delete and confirm deletion |Experiment is deleted Manual
Delete Experiment (open Open an experiment, select expereiment and press Delete an:
6.10 experiment) confirm deletion Experiment is closed and deleted Manual
Select Traces while Experiment is Experiment is closed and selected traces is imported to
6.11 open Open an experiment and select an additional trace (see 6.3) |the experiment Manual
7 Experiment Traces
7.1 Trace menu Select an LTTng trace and open its context menu Correct menu opens w/ Copy disabled + Remove Manual
7.2 Open trace Select the Open menu Trace is opened and views are populated Manual
Open Experiment, select the Remove menu and confirm
7.3 Remove trace removal Experiment is closed, trace is removed from experiment Manual
Selected traces are added to the experiment with
74 Drag and Drop from Traces D&D a few LTTng traces from the Traces directory proper icon. Experiment can be opened. Manual
D&D a few LTTng traces from another Tracing project's Selected traces are added to the experiment + Traces
7.5 Drag and Drop from other Tracing|Traces folder with proper icon. Experiment can be opened. Manual
Selected traces are added to the experiment + Traces
7.6 Drag and Drop from non-Tracing [D&D a few traces from a non-Tracing project with proper icon. Experiment can be opened. Manual
Selected traces are added to the experiment + Traces
7.7 Drag and Drop from external D&D a few traces from an external file manager with proper icon. Experiment can be opened. Manual
Selected traces are added to the experiment + Traces
Drag and Drop from external with proper icon (system icon). Experiment cannot be
7.8 (non-traces) D&D a few files (non-traces) from an external file manager  |opened. Manual
1) D&D a trace with name of an existing trace into experiment| Verify that trace is added into the traces folder and
Drag and Drop of trace with folder experiment folder with the trace name of the orignal
7.9 existing name 2) Confirm the renaming of traces trace plus a suffix 2 Manual
Verify that trace is added into the traces folder and
Drag and Drop of trace with experiemnt folder with the trace name of the orignal
7.10 existing name (2nd time) Redo test 7.8 with the same trace and same destination folderftrace plus a suffix 3 Manual
Drag and Drop of trace while Open an experiment and D&D a trace from the Traces Experiment is closed and selected traces is imported to
7.11 Experiment is open directory (see 7.4) the experiment Manual
8 Propagation
8.1 Preparation Copy experiment Selected experiment is replicated Manual
8.2 Rename propagation In Traces folder, rename a trace showing in both experiments |[New name is propagated to both experiments Manual
8.3 Delete propagation In Traces folder, delete a trace showing in both experiments |Selected trace is removed from both experiments Manual
8.4 Propagate trace type 1 Add a trace to 2 experiments. Change its type from Traces All occurences of that trace are updated Manual
Add a trace to 2 experiments. Change its type from one of the|
8.5 Propagate trace type 2 experiments All occurences of that trace are updated Manual
9 Properties View Synchronization
The Properties view is updated with the selected trace'y
"Resource properties" Property and Value. The "Info >
Select a trace under a Traces folder in Project Explorer view. |type" property shows the selected trace category and
9.1 Trace synchronization Repeat with trace under an Experiment. trace type name. Manual
The Properties view is updated with the selected item's
Other trace nodes Select a Traces folder, Experiments folder, or an experiment |Property and Value. For Experiment verify the "type"
9.2 synchronization in Project Explorer view. property is set. Manual
Open an LTTng kernel trace, click on the trace, check the new
9.3 Check trace properties properties view. The "Trace properties” should be populated Manual
Check trace properties - Open an experiment which contains LTTng kernel traces, click| The "Trace properties" should be populated for every
9.4 experiment on the experiment, check the new properties view. subtrace Manual
10 Trace Type Selection
Imported trace appear in Traces with default icon. File ig
Import an file with unrecognized trace type (${local} can be opened by default Editor (either Eclipse text or
10.1 Preparation /traces/import/unrecognized.log) system editor depending on plug-ins installed) Manual
10.2 Trace properties Select the trace and open the Properties View Selected trace type is blank Manual
10.3 Trace filtering Select an experiment and open Select Traces dialog Untyped trace does not appear in list Manual
11 Supplementary Files
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1) In Project Explorer remove filter for hidden resources
(Coolbar menu > Customize View... > unselect '.* resources)

11.1 Preparation 2) Create Experiment with 2 LTTng CTF traces in it Verify that .tracing directory is shown under the project| Manual
Create Supplementary File (State Verify that StateHistory.ht is created under .
11.2 History File) from trace Open a LTTng CTF trace and wait for indexing to finish tracing/<trace name>/. Manual
a) Select trace under Folder Traces and click right mouse
button
b) Redo test: Select trace under Experiment Folder Verify that menu item 'Delete Supplementary Files..." is
113 Trace Context sensitive menu ) Redo test: Select Experiment shown in the context-sensitve menu Manual
Delete Supplementary Files 1) Select trace and click right mouse button Verify that confirmation dialog box is opend and <trace
11.4 Action 2) Select 'Delete Supplementary Files...' name>/StateHistory.ht is listed Manual
Select and delete State History Make sure that file .tracing/<trace name>/StateHistory.

11.5 File Select <trace name>/StateHistory.ht file and click on 'Ok’ ht is deleted from the project explorer view Manual
Verify that two StateHistory.ht files are created under .
tracing/<trace1 name>/ and ./tracing/<trace2 name>/

Create Supplementary File (State respectively. Also verify, that supplementatry folder for]

11.6 History File) from experiment Open Experiment with 2 LTTng CTF traces the experiment ./tracing/<exp name>_exp is created. Manual
Verify that confirmation dialog box is opend and shows
3 root entries:

Delete Supplementary Files 1) Select Experiment and click right mouse button <exp name>, <trace1 name> and <trace2 name>, with
11.7 Action 2) Select 'Delete Supplementary Files...' their respective supplementary files below Manual
Make sure that the selected file .tracing/<trace
Select and delete State History  |Select one history file (<trace name>/StateHistory.ht) and name>/StateHistory.ht is deleted from the project
11.8 File click on 'Ok’ explorer view Manual
1) Redo 11.2 and 11.6 Make sure that both history files are deleted under .
Select and delete multiple State |2) Select both history files and click on 'Ok’ tracing/<trace1 name>/ and .tracing/<trace2 name>/
11.9 History Ffiles respectively Manual
a) Redo 11.2 to create Supplementary File Verify that supplementary directory .tracing/<trace

11.10 Delete Trace b) Delete trace name>/is deleted. Manual
Verify that supplementary File StateHistory.ht .
tracing/<trace1 name>/ and ./tracing/<trace2 name>/
are NOT deleted. Also verify that the supplementary

3) redo 11.6 to create experiment and Supplementary File folder for the experiment ./tracing/exp_name_exp is
11.11 Delete Experiment b) delete Experiment deleted. Manual
Verify that supplementary File StateHistory.ht .

a) redo 11.6 to create experiment and Supplementary File tracing/<trace1 name>/ and ./tracing/<trace2 name>/

11.12 Delete Experiment Trace b) remove traces under Experiment are NOT deleted Manual
Delete Supplementary Files Verify that trace is closed and supplementary files are
11.13 Action while trace is open Open trace and then redo 11.4 deleted Manual
12 Link With Editor

1) In Project Explorer make sure that "Link with Editor" buttor

is selected

12.1 Preparation 2) Open multiple traces and experiments Manual

Verify that after each selection the corresponding trace|
Select trace/experiment in Editors| Select several traces and experiments one after each other in |or experiment element is selected in the Project
12.2 area Editors area Explorer Manual
Select opened
traces/experiments in Project Select several open traces and experiments one after each | Verify that after each selection the corresponding trace|
12.3 Explorer other in Project Explorer or experiment is brought to the top in the Editors area | Manual
1) In Project Explorer make sure that "Link with Editor" buttor)
is not selected
12.4 Preparation 2) Open multiple traces and experiments (if not open) Manual
Select trace/experiment in Editors|Select several traces and experiments one after each other in
12.5 area Editors area Verify that selection in Project Explorer doesn't change| Manual
Select opened
traces/experiments in Project Select several open traces and experiments one after each
12.6 Explorer other in Project Explorer Verify that Editor in focus is not changed Manual
13 Trace Package Export Wizard
1) Import 2 traces that generate supplementay files (trace2,
kernel_vm)
2) Open both traces, wait for the indexing to finish
13.1 Preparation 2) Add bookmarks in the two traces
Open the trace package export  |Click on “File”, “Export...", “Tracing”, “Trace Package Export” |A wizard should appear with a list of projects and

13.2 wizard and click Next traces to select. Next button should be disabled. Manual

Next should be become enabled when the first trace is
On the left side, select the project in which the traces were |selected. If all traces are unselected, the Next button is
13.3 Select Traces imported. Then on the right side, selected both traces. disabled. Manual

1"
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With traces selected, press the Deselect All button. Then

Next should become disabled after Deselect All,

13.4 Deselect/Select All press on the Select All button. Click Next. enabled after Select All. Manual
All elements in the trace tree are unselected, the
Approximate uncompressed size field changes to a
13.5 Trace element selection Unselect the trace2 element lower number. Manual
All elements in the trace tree are unselected, the
Approximate uncompressed size field changes to 0. The|
13.6 Trace sub-element selection Unselect the kernel_vm > Trace element Next button is disabled. Manual
When Select Allis clicked, all the tree elements are
selected, the approximate size increases. When
With nothing selected, click Select All. Then click Deselect All.|Deselect Allis clicked, all the tree elements are
13.7 Select/Deselect All Then click Select All again. deselected and the approximate size decreases. Manual
1) Click on the Browse button. A file chooser dialog comes up. When the destination
2) Select a location on the filesystem file is entered, the “To archive file” is filed with export.
13.8 Archive file selection 3) Enter the file name export.tar tar.gz. The Finish button should be enabled. Manual
Change export options, change
13.9 compression Unselect the “Compress” checkbox. The name of the archive file changes to export.tar Manual
Change export options, change
13.10 format Change to Zip format The name of the archive file changes to export.zip Manual
Change export options, change
13.11 format and compression Change to Tar format then select the Compress checkbox. | The name of the archive file changes to export.tar.gz Manual
A progress bar should appear at the bottom the the
dialog and it should disappear upon completion. The
13.12 Finish the wizard Click Finish export.tar.gz file should be created on the file system. | Manual
The Archive file name should be remembered and
already filled. A dialog should prompt the user to
overwrite. Answering No should keep the wizard
Open the wizard again and select the traces (step 13.2, 13.3). |opened. Answering Yes should re-export the archive
13.13 Overwrite Click Finish. and close the wizard. Manual
Open the wizard again and select the traces (step 13.2, 13.3).
13.14 Verify formats This time, choose Zip format. Click Finish. The export.zip file should be created on the file system | Manual
In both archives, verify that it contains:
1) A trace folder for each trace containing all the trace
files (excluding supplementary files)
2) A .tracing folder containing all the supplementary
files
3) An export-manifest.xml file listing the trace files,
13.15 Verify content Open the tar.gz and the zip files in an archive manager. supplementary files and bookmarks Manual
Verify that the exported archive contains:
In both archives, verify that it contains:
1) A Traces folder containing all the trace files
(excluding supplementary files)
Open the wizard again and select the traces (step 13.2, 13.3). |2) No .tracing folder
This time, unselect both Supplementary files subtrees. Click |3) An export-manifest.xml file listing the trace files and
13.16 Partial selection Finish. bookmarks Manual
14 Trace Package Import Wizard
Create an empty tracing project. Make sure you have export.
tar.gz available from the Trace Package Export Wizard (13)
test case, which should include everything including trace fileg
14.1 Preparation supplementary files and export-manifest.xml.
Open the trace package import | Click on “File”, “Import...", “Tracing”, “Trace Package Import” |The first page of the wizard should appear (Choose
14.2 wizard and click Next content to import) Manual
Click the Select button. Choose the previously created The Into project field gets filled with the selected
14.3 Project Selection project. project name. Manual
Finish should be become enabled when the first trace is
1) Click on the Browse button. selected. If all traces are unselected, the Next button is
14.4 Archive file selection 2) Browse for export.tar.gz on the file system disabled. Manual
With traces selected, press the Deselect All button. Then Finish should become disabled after Deselect All,
14.5 Deselect/Select All press on the Select All button. enabled after Select All. Manual
14.6 Trace element selection Unselect the trace2 element All elements in the trace tree are unselected. Manual
14.7 Trace sub-element selection Unselect the kernel_vm > Trace element All elements in the trace tree are unselected. Manual
When Select Allis clicked, all the tree elements are
With nothing selected, click Select All. Then click Deselect All. |selected. When Deselect All is clicked, all the tree
14.8 Select/Deselect All Then click Select All again. elements are deselected.. Manual
A progress bar should appear at the bottom the the
dialog and it should disappear upon completion. The
two traces should appear under the project in Project
14.9 Finish the wizard Click Finish Explorer Manual
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Delete Supplementary files appears in the content

Column width of calculated offset is very small in GTK3

14.10 Supplementary Files Right-click on trace2 in Project Explorer menu Manual
14.11 Bookmarks Open the Bookmarks view Bookmarks appear in the list for the imported traces Manual
The corresponding trace opens at the bookmarked
14.12 Open from bookmark Double click on one of the bookmarks event. Bookmarks are displayed in the event table. Manual
A dialog should prompt the user to overwrite for each
Open the wizard again (step 13.2) and select the archive file |trace. Answering Yes to All should overwrite without
14.13 Overwrite (step 13.4). Click Finish. prompting again. Manual
15 Time Offsetting
Open Project Explorer view and Properties view. Create an
empty tracing project. Import two different traces to the
project. Open the traces and note their start time. Close the
15.1 Preparation traces.
The Apply time offset dialog opens in Basic mode. The
Apply time offset dialog - trace  |Select both trace elements in the Project Explorer view. Trace name show both traces and the Offset in seconds
15.2 selection Right-click and select Apply Time Offset... is blank. SWTBot
The Apply time offset dialog opens in Basic mode. The
Apply time offset dialog - folder |Select the Traces folder element in the Project Explorer view. | Trace name show both traces and the Offset in seconds
15.3 selection Right-click and select Apply Time Offset... is blank. SWTBot
Create an experiment with both traces. Select the experiment The Apply time offset dialog opens in Basic mode. The
Apply time offset dialog - element in the Project Explorer view. Right-click and select  |Trace name show both traces and the Offset in seconds
15.4 experiment selection Apply Time Offset... is blank. SWTBot
Select a trace element in the Project Explorer view. Right-clic
and select Apply Time Offset... In the Offset in seconds The timestamps in the trace are all offset by the
Apply time offset dialog - Basic  |column, enter a time with seconds and decimals. Click OK. entered value. The Properties view shows the 'time
15.5 mode Open the trace. offset' with the entered value. SWTBot
Select the same trace element in the Project Explorer view. |The timestamps in the trace are all offset by the
Right-click and select Apply Time Offset... In the Offset in cumulative sum of the previous and current entered
Apply time offset dialog - seconds column, enter a time with seconds and decimals. value. The Properties view shows the 'time offset' with
15.6 cumulative offset Click OK. Open the trace. the cumulative value. SWTBot
Select the trace element in the Project Explorer view. Right- | The timestamps in the trace are back to their original
click and select Clear time offset. Click OK to confirm. Open |values. The Properties view shows the 'time offset' as
15.7 Clear time offset the trace. blank. SWTBot
The Apply time offset dialog opens and is switched to
Open one trace and close the other trace. Select both trace |Advanced mode. The Trace name show both traces and
Apply time offset dialog - elements in the Project Explorer view. Right-click and select |the Offset in seconds is blank. The Reference time for
15.8 Advanced mode Apply Time Offset... Choose the Advanced radio button. the opened trace is set to its start time. Manual
Both traces are open. Selecting an event updates the
Reference time for the selected trace, and updates the
Target time for all traces. Pressing the button compute:
the Offset in seconds as the difference between Target|
time and Reference time for that row. The trace which
Double-click the second trace to open it. Select an event in its|has a computed offset is closed when the OK button is
Apply time offset dialog - trace editor. Select the first trace editor. Select an event in its|pressed. After reopening, the two previously selected
Advanced mode - compute from |trace editor. Click the button in the dialog row of the second |events now have the same timestamp. The Properties
15.9 selection trace. Click OK. Open both traces. view shows the 'time offset' with the computed value. | Manual
The trace is opened. The Reference time is set to the
Select the first trace element in the Project Explorer view. trace start time. The Reference time and Target time
Right-click and select Apply Time Offset... Choose the can be copied, pasted, and edited. Pressing the button
Advanced radio button. Double-click the trace name to open |computes the Offset based on the current time values.
it. Select the Reference time cell and copy the start time. The trace is closed with the OK button is pressed. After
Apply time offset dialog - Select the Target time and paste the value. Edit both values tgreopening, the timestamps in the trace are offset
Advanced mode - compute from |different times. Click the button in the trace row. Click OK.  |according to the computed value. The Properties view
15.10 entered values Open the trace. shows the 'time offset' with the computed value. Manual
The opened traces are closed when the OK button is
Open both traces. Select both trace elements in the Project |pressed. After reopening, the timestamps in the traces
Clear time offset with opened Explorer view. Right-click and select Clear time offset. Click |are back to their original values. The Properties view
15.11 traces OK to confirm. Open the traces. shows the 'time offset' as blank. Manual
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e 0 P o Do 0
TMF - Histogram View 50 2 0 8
Target: |Ubuntu 14.10 64 bit
Step Test Case Action Verification Comment
1 Preparation
1.1 Step 1 Open and reset LTTng Kernel perspective LTTng Kernel perspective opens with correct views SWTBot Pass
1.2 Step 2 Open an LTTng trace Views are populated SWTBot Pass
2 Manage View
2.1 Close view Close the Histogram View Histogram View is removed from perspective Manual Pass
2.2 Open view Window > Show View > Tracing > Histogram Histogram View is displayed and re-populated Manual Pass
2.3 Resize Resize the Histogram View width-wise Histograms are compressed/decompressed without loss | Manual Pass
3 Full Trace Histogram
3.1 Single selection Select timestamp with left-click Selection Start/End + blue bars are updated Manual Pass
Select time range with shift-left-click, shift-left-drag or left-
3.2 Range selection drag Selection Start/End + blue bars are updated Manual Pass
Drag the zoom window left/right with ctrl-left-drag or
33 Drag zoom window middle-drag Zoom window is dragged, won't go beyond full range Manual Pass
Zoom window is centered on click, won't go beyond full
34 Move zoom window Move the zoom window with ctrl-left-click or middle-click range Manual Pass
Zoom window is set, Window Span is updated, won't go
3.5 Set zoom window Set a new zoom window with right-drag beyond histogram range Manual Pass
Zoom window is updated, Window Span is updated,
3.6 Zoom in/out Zoom in/out with mouse wheel up/down won't go below 2 ns, won't exceed full trace range Manual Pass
Selection (blue bar) moves to the previous/next non-
3.7 Arrow keys Move the current event using left/right arrow keys empty bucket Manual Pass
Selection Start/End moves to beginning/end of trace (i.e.
3.8 Home/End keys Press Home/End key start time of last bucket is selected) Manual Pass
With a trace containing lost events, click the "Hide lost events|'
39 Lost events toolbar icon. Click it again. The lost events (red bars) are toggled on and off. Manual Pass
Zoom window is updated, Window Span is updated,
3.10 |Zoom in/out (key) Zoom infout with +/- key won't go below 2 ns, won't exceed full trace range Manual Pass
4 Time Range Histogram
4.1 Single selection Select timestamp with left-click Selection Start/End + blue bars are updated Manual Pass
Select time range with shift-left-click, shift-left-drag or left-
4.2 Range selection drag Selection Start/End + blue bars are updated Manual Pass
Drag the zoom window left/right with ctrl-left-drag or
4.3 Drag zoom window middle-drag Zoom window is dragged, won't go beyond full range Manual Pass
Zoom window is updated, Window Span is updated,
4.4 Zoom in/out Zoom in/out with mouse wheel up/down won't go below 2 ns, won't exceed full trace range Manual Pass
Selection (blue bar) moves to the previous/next non-
4.5 |Arrow keys Move the current event using left/right arrow keys empty bucket Manual Pass
Selection Start/End moves to beginning/end of time
4.6 Home/End keys Press Home/End key range (i.e. start time of last bucket is selected) Manual Pass
With a trace containing lost events, click the "Hide lost events|'
4.7 Lost events toolbar icon. Click it again. The lost events (red bars) are toggled on and off. Manual Pass
Zoom window is updated, Window Span is updated,
3.10 |Zoom in/out (key) Zoom in/out with +/- key won't go below 2 ns, won't exceed full trace range Manual Pass
5 Selection Start/End
5.1 |Set selection start |Enter a TS within the full range in Selection Start widget |Selection Start + blue bars are updated ‘ Manual Pass  selection range
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5.2 Set selection end Enter a TS within the full range in Selection End widget Selection End + blue bars are updated Manual
Select the link icon. Enter a TS within the full range in
53 Set selection (linked) Selection Start widget Selection Start/End + blue bars are updated Manual
5.4 Set invalid selection start |Enter a TS before the full range start in Selection Start widget Selection Start + blue bar set to first event Manual
5.5 Set invalid selection end |Enter a TS after the full range end in Selection End widget Selection End + blue bar set to last event Manual
6 Window Span
6.1 Set window span Enter a span in Window Span widget Both Histograms are updated accordingly Manual
6.2 Set large window span Enter an invalid span (too large) in Window Span widget Span set to full range Manual
Enter an invalid span (too small, negative, not a number) in
6.3 Set invalid window span |Window Span widget Span set to previous value Manual
Selected Timestamp
7 Synchronization
Time Range mouse Click on the time range histogram. The time of the bucket at
7.1 synchronization the mouse position is selected. Other views are synchronized to the selected time Manual
Full Trace mouse Click on the full trace histogram. The time of the bucket at
7.2 |synchronization the mouse position is selected. Other views are synchronized to the selected time Manual
Selection synchronization |Select the link icon. Enter a time within the full range in
7.3 (linked) Selection Start widget Other views are synchronized to the selected time Manual
In any other view that supports time synchronization, select a|Selection Start/End + blue bars in both histograms are
7.4 External synchronization |time. updated to the selected time Manual
Selected Time Range
8 Synchronization
Time Range mouse Select a time range in the small histogram (shift-left click, left{Verify that the selected time range shows in both
8.1 synchronization drag or shift-left drag). histograms, and in other views. Manual
Full Trace mouse Select a time range in the full histogram (shift-left click, left- |Verify that the selected time range shows in both
8.2 synchronization drag, shift-left drag). histograms, and in other views. Manual
Selection Start/End Enter a time within the full range in Selection Start/End
8.3 synchronization widget Other views are synchronized to the selected time range| Manual
In any other view that supports time range synchronization, |Selection Start/End + blue bars in both histograms are
8.4 External synchronization |select a time range. updated to the selected time range Manual
Zoom Window
9 synchronization
Time Range mouse Select a zoom window in the small histogram (ctrl-left drag,
9.1 synchronization middle-drag, right-drag, mouse wheel up/down). Other views are synchronized to the new range Manual
Full Trace mouse Select a zoom window in the full histogram (ctrl-left drag,
9.2 synchronization middle-click, middle-drag, right-drag, mouse wheel up/down).| Other views are synchronized to the new range Manual
Wwindow Span
9.3 synchronization Enter a new span in Window Span widget Other views are synchronized to the new range Manual
In any other view that supports range synchronization, select {Window Span and both histograms are updated to the
9.4 External synchronization [new zoom window. new range Manual
Multiple Trace
10 Synchronization

Preparation

1) Download traces.zip (if necessary) and unzip into a local
directory ${local}

2) Import kernel trace ${local}/traces/import/kernel-
overlap-testing

3) Import UST ${local}/traces/import/trace ust-overlap-
testing

4) Create experiment with trace of 2) in it
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Pass

What is to small? 1ns seems to work

Zoom Window is moved if selection is outside the current zoom
window and a time graph window is open (e.g. CFV). Otherwise
zoom window stays.

Zoom Window is moved if selection is outside the current zoom
window and a time graph window is open (e.g. CFV). Otherwise
zoom window stays.




2.1.0-TraceCompassTestCases - HistogramView

Open multiple traces (no

10.1  |overlap) Open multiple traces that don't overlap in time View shows the last opened trace Manual
Change selected time and Selection Start/End, Window Span and both histograms
10.2 |range (no overlap) Select a time and new range are updated to selected time and new range. Manual
Open multiple traces
10.3 |(overlap) Open multiple traces that overlap in time View shows the last opened trace Manual
Change selected time and Selection Start/End, Window Span and both histograms
10.4 |range (overlap) Select a time and new range are updated to selected time and new range. Manual
View is updated to show selected trace. Selection
Select other trace Start/End, Window Span and both histograms are set to
10.5 |(overlap) Select different trace by clicking its editor tab the newly selected time and range. Manual
The colors in both Histograms and toggled on and off.
With an experiment containing multiple traces opened, click |When it is toggled off, the legend disappears at the
10.6 |Trace coloring the "Activate trace coloring" toolbar icon. Click it again. bottom and only one color is used for non-lost events. Manual
10.7 |Close all traces Close all trace editor tabs View is cleared. Manual

16




2.1.0-TraceCompassTestCases - EventsEditor

e 0 P » o Do 0
TMF - EventsEditor 23 10 0 7
Target:
Step Test Case Action Verification Comment
1 Preparation
1.1 Preparation step 1 Open and reset LTTng Kernel perspective LTTng Kernel perspective opens with correct views. SWTBot Pass
2 Trace bookmarks Moved to sheet "BookmarksView"
3 Experiment bookmarks Moved to sheet "BookmarksView"
4 Filter
Only events matching regex are displayed. Top and
bottom filter status rows update while filtering is
ongoing. When filtering is done, status rows show
4.1 Filter In the header row, enter some regex and press Ctrl+Enter number of matching events. SWTBot Pass
onl t tchi displ d. Stat Bruno : If | start the filter with Ctrl + Enter, then the escape key
nly some ever? S matching regex a,re Isplaye . atus won't work, like if it lost focus. If | use the mouse and the button on
In the header row, enter some regex and press Ctrl+Enter, rows show partial number of matching events, with the screen the escape key works great (Linux only). Patrick: Bug
4.2 Cancel filter then quickly press ESC before filtering is done different 'stop" icon. Manual Pass 494589 opened. JC: Works for me
All events are displayed. Selected event remains
43 Un-filter In the header bar, click the icon to delete a filter selected and visible. Status rows are removed. SWTBot Pass
4.4 Filter & Search In the filter bar, enter some regex; likewise in the search bar |Events are filtered and highlighted accordingly SWTBot Pass
4.5 Search & Filter In the search bar, enter some regex; likewise in the filter bar |Events are filtered and highlighted accordingly SWTBot Pass
5 Time Synchronization
Other views are synchronized to the selected event's
5.1 Mouse synchronization |Select any event in the table with the mouse button time Manual Pass
Select any event in the table using Up, Down, PageUp, Other views are synchronized to the selected event's
5.2 Key synchronization PageDown, Home, End time Manual Pass
In the search bar, enter some regex, then search again with  |Other views are synchronized to the selected event's
5.3 Search synchronization  |Enter/Shift-Enter time Manual Pass
In any other view that supports time synchronization, select a| The first event at or following the selected time is
5.4 External synchronization |time. selected and visible. Manual Pass
Select an event with left button, press shift key and click select |Range of events are highlighted. Selection range is
5.5 Range selection another event updated in other views that support range selection Manual Pass
6 Event Synchronization
Verify that an editor is opened showing LTTng Kernel
6.1 Open trace Open an LTTng CTF Kernel trace specific columns. Views are updated with the new trace] SWTBot Pass
The Properties view is updated with the selected
event's Property and Value. Timestamp and Content arg
6.2 Mouse synchronization |Select any event in the table with the mouse button expandable. Manual Pass
The Properties view is updated with the selected
Select any event in the table using Up, Down, PageUp, event's Property and Value. Timestamp and Content arg
6.3 Key synchronization PageDown, Home, End expandable. Manual Pass
The Properties view is updated with the selected
In the search bar, enter some regex, then search again with  |event's Property and Value. Timestamp and Content arg
6.4 Search synchronization  |Enter/Shift-Enter expandable. Manual Pass
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In any other view that supports time synchronization, select a
time. The selected event in the editor is updated. Then give

The Properties view is updated with the selected
event's Property and Value. Timestamp and Content arg

Bruno : When trying to import the trace | get an initializing error. A
token mismatched exception. We can parse the trace using
Babeltrace, but maybe the parser used in trace compass has an
error.

JC: Failed to open the trace but it seems normal. The support for C1

JC: The support for CTF callsite was removed

JC: The support for CTF callsite was removed

JC:Export worked with a pcap trace. But there were no progress mo

6.5 External synchronization |focus back to the editor. expandable. Manual
Source Code / Model
7 Lookup
1) Download traces.zip (if necessary) and unzip into a local
directory ${local}
2) Unzip traces/c_project_callsite.zip and traces/callsite.zip
to your local disk.
3) Import demo C project to the Eclipse workspace of zip
file c_project_callsite.zip
4) Import the test trace of zip File callsite.zip to a tracing
project.
71 Preparation Select trace type "Generic CTF Trace" and open the trace
1) select event in table
2) click right mouse button Verify that correct source code file and line number is
7.2 Open call site 3) select "Open Source Code" menu item opened Manual
1) Close source code project
2) select event in table Since the source code is not available the no source
Open call site (no source |3) click right mouse button code file is opened. Instead a error dialog is opened
7.3 |code) 4) select "Open Source Code" menu item (with title "FileNotFoundException") Manual
1) select event in table (e.g. 1st event) Since the model is not available the model element is
2) click right mouse button not shown. Instead a error dialog is opened (with title
7.4 |Open model URI 3) select "Open Model Element" menu item "FileNotFoundException") Manual
8 Export to text
Make sure that a progress monitor dialog is opened
1) Open a CTF trace (e.g. LTTng Kernel) during the export. After finishing make sure that the
2) Click right mouse button text file exists and it contains the events stored in the
3) Select "Export To Text" menu item file. Verify that the columns are printed as shown in the
4) Enter a file name and location events table and that they are separated by tab
8.1 Export CTF trace 5) Press OK character. Manual
Make sure that a progress monitor dialog is opened
1) Open a trace other than CTF trace during the export. After finishing make sure that the
2) Click right mouse button text file exists and it contains the events stored in the
3) Select "Export To Text" menu item file. Verify that the columns are printed as shown in the
4) Enter a file name and location events table and that they are separated by tab
8.2 Export Other Trace 5) Press OK character. Manual
1) Open a CTF trace (e.g. LTTng Kernel)
2) Click right mouse button
3) Select "Copy to Clipboard" menu item Verify that the columns are printed as shown in the
4) Paste it in a text file events table and that they are separated by tab
8.3 Copy to clipboard character. SWTBot
Swap Columns and
9 Change Fonts
1) Open a trace
2) Drag a column
Swap columns in events
9.1 table Covered by SWTBot tests SWTBot
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1) Open the preferences
2) select new font for trace types

3) press apply
4) verify that the font changed

Covered by SWTBot tests

SWTBot

8.2 Change fonts
1) Open the preferences
2) Reset the font settings
3) Press apply
4) verify that the font changed
8.3 Reset fonts Covered by SWTBot tests SWTBot
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TMF - BookmarksView

2.1.0-TraceCompassTestCases - BookmarksView

17

Target: |Ubuntu 14.10 64 bit
Test Case Action Verification
1 Preparation
1.1 Preparation step 1 Open and reset LTTng Kernel perspective LTTng Kernel perspective opens with correct views. SWTBot
2 Trace bookmarks
2.1 Show Bookmarks View Select Bookmarks view (bottom folder) Bookmaks view is shown Manual
Views are populated. Verify that a Kernel events editor is openjed
22 Open trace Open an LTTng CTF Kernel trace showing LTTng Kernel specific columns SWTBot
Add a bookmark, by
a) double-clicking on the left margin next to an event
b) right-clicking the margin and select Add bookmark.... Make sure that bookmark icon is shown on left site of the even|
¢) using the Edit > Add bookmark... menu. row and is added to the Bookmarks view with relevant
2.3 Add Trace Bookmark Enter the bookmark description in dialog box information (i.e. Description entered and correct trace resource) Manual
Scroll within event table so that bookmark is not visible anymore and |thtake sure that event with bookmark is selected and visible in
24 Open Trace Bookmark (1)  |double-click on bookmark in Bookmarks View event table Manual
Open another trace #2 and then double-click on bookmark in Make sure that correct trace #1 is brought to top and correct
2.5 Open Trace Bookmark (2) |Bookmarks view event with bookmark is selected in events table Manual
Close the trace #1 and then double-click on bookmark in Bookmarks |Make sure that correct trace #1 is opened and correct event with
2.6 Open Trace Bookmark (3)  |view bookmark is selected in events table Manual
Select bookmarks icon in event table right-click on icon and select ~|Make sure that bookmark icon is removed from event table and
2.7 Delete Bookmark (from table)"Remove Bookmark" corresponding bookmark is removed from the Bookmarks view Manual
Make sure that bookmark icon is removed from event table and
2.8 Delete Bookmark (from table)Double-clicking bookmarks icon in event table. corresponding bookmark is removed from the Bookmarks viey Manual
Delete Bookmark (from Add a bookmark (see 2.4), then select bookmark in Bookmarks view,|Make sure that bookmark icon is removed from event table ant
2.9 Bookmarks view) right mouse click and select "Delete". Confirm the deletion. corresponding Bookmark is removed from the Bookmarks view Manual
3 Experiment bookmarks
Create Experiment with 2 LTTng CTF Kernel traces in it and open | Verify that an Events editor is opened showing LTTng Kernel
3.1 Create and open experiment |experiment specific columns Manual
Add a bookmark, by
a) double-clicking on the left margin next to an event Make sure that bookmark icon is shown on left site of the even|
b) right-clicking the margin and select Add bookmark.... row and is added to the Bookmarks view with relevant
c) using the Edit > Add bookmark... menu. information (i.e. Description entered and correct experiment
32 Add Experiment Bookmark |Enter the bookmark description in dialog box resource) Manual
Open Experiment Bookmark | Scroll within event table so that bookmark is not visible anymore and [fhtake sure that event with bookmark is selected and visible in
33 (€8] double-click on bookmark in Bookmarks View event table Manual
Open Experiment Bookmark |Open another trace #2 and then double-click on bookmark in Make sure that correct experiment #1 is brought to top and
34 2) Bookmarks view correct event with bookmark is selected in events table Manual
Open Experiment Bookmark | Close the experiment #1 and then double-click on bookmark in Make sure that correct experiment #1 is opened and correct evgnt
3.5 3) Bookmarks view with bookmark is selected in events table Manual
Select bookmarks icon in Events view, right-click on icon and select |Make sure that bookmark icon is removed from event table and
3.6 Delete Bookmark (from table)"Remove Bookmark" corresponding bookmark is removed from the Bookmarks viey Manual
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No Edit menu in Trace Compass RCP




2.1.0-TraceCompassTestCases - BookmarksView

3.7

Delete Bookmark (from
Bookmarks view)

Add a bookmark (see 6.4), then select bookmark in Bookmarks view,
right mouse click and select "Delete". Confirm the deletion.

Make sure that bookmark icon is removed from event table and

corresponding Bookmark is removed from the Bookmarks vie

Manual
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0 Pa a o Do 0
TMF - Filters View 12 12 0 1
Target: |Ubuntu 14.10 64 bit

Step Test Case Action Verification

Open a trace to be

1 filtered Trace is opened SWTBot SWTBot Pass

2 Open filter view Filter view is opened SWTBot SWTBot Pass
Create a filter on event  |The Ffilterview contains a filter on the event type and the

3 type and timestamp timestamp SWTBot SWTBot Pass

3.1 Apply that filter A subset of the events pass SWTBot SWTBot Pass

Create a filter on the
timestamp oring field

4 values Create the filter SWTBot SWTBot Pass
4.1 Apply that filter A subset of the events pass SWTBot SWTBot Pass
Create a filter with equals
5 node Create the filter SWTBot SWTBot Pass
5.1 Apply that filter A subset of the events pass SWTBot SWTBot Pass
Create a filter with
6 matches node Create the filter SWTBot SWTBot Pass
6.1 Apply that filter A subset of the events pass SWTBot SWTBot Pass
Create a filter with
7 contains node Create the filter SWTBot SWTBot Pass
7.1 Apply that filter A subset of the events pass SWTBot SWTBot Pass

22



2.1.0-TraceCompassTestCases - ColorsView

0 Pa a o Do 0
TMF - Colors View 6 6 0 0
Target: |Ubuntu 14.10 64 bit

Step Test Case Action Verification Comment

1 Open a test trace a trace is visible in the events editor SWTBot SWTBot Pass

2 Open the colors view the view is visible SWTBot SWTBot Pass
Select a color and a filter, the matching events should update

3 Select a color and a filter |their colors (background and foreground) to the new ones SWTBot SWTBot Pass

4 Add multiple colors Click on add 4 times, four colors should be displayed SWTBot SWTBot Pass
Change the color By clicking on up and down, the order of the displayed colors

5 priorities should change SWTBot SWTBot Pass

6 Delete all the colors The color filters should disappear. SWTBot SWTBot Pass
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37

Target: |Ubuntu 14.04 64 bit
Test Case Action Verification
1 Preparation
1) Download traces.zip (if necessary) and unzip into a local
directory ${local}
2 )Use traces simple-server-thread1 and simple-server-
thread2 under traces/import/ For test cases below
LTTng Kernel perspective opens with correct views:
Project Explorer, Control, Control Flow, Resources,
1.1 Open perspective Open and reset LTTng Kernel perspective Statistics, Histogram, Properties, Bookmarks SWTBot
Open TMF Sequence Use menu Window— Show View — Other ... — Tracing —
1.2 Diagram View Sequence Diagram Verify that 'Sequence Diagram' view is shown SWTBot
1) Create Tracing Project
2) Create Experiment (SeqExp)
3) Import 2 traces simple-server-thread1 and simple-server-
thread2 Verify that sequence diagram was loaded. The
4) Select trace type "Generic CTF Trace" interaction show the signal numbers (Note that trace
Create and open 5) Add these 2 traces to experiment doesn't contain strings for the interactions. A special
experiment with 6) Open (double-click on) the experiment parser would be necessary to map signal number to
1.3 sequence diagram data trace) Manual
2 Manage View
2.1 Close view Close Sequence Diagram view Sequence Diagram View is removed from perspective Manual
Open view when 1) Close 'Sequence Diagram' View
experiment/traces is 2) load sequence diagram experiment Verify that sequence diagram was loaded. Verify that al
2.2 already loaded 3) Open Sequence Diagram view 17 pages are loaded. Manual
3 Tooltip
1) Goto to first page (no selection of any interaction or Verify that tooltip appears with content with interactiol
3.1 Hover over interaction lifeline) 2) Hover over first interaction (arrow or number) name and time stamp (10000 14:58:00.740995147) Manual
Verify that tooltip appears with content with interactio
1) Goto to first page names and time stamp delta between selected
Hover over interaction 2) select first interaction interaction and interaction that was hovered over
3.2 after selection 3) Hover over 3rd interaction (10001 — 10000 delta: 000.000 157 023) Manual
Verify that tooltip appears with delta and graph to sho
Hover over time Hover over first element in time compression bar on the left |where delta is in relation to current configured min max
33 compression bar of the view values. (delta: 000.000 3 480) Manual
4 View Synchronization
Verify that interaction is highlighted in 'Sequence
Diagram' view. Verify that in the events table the
corresponding event is selected. Verify that time stampp
4.1 Selection of interaction |Select an interaction in the 'Sequence Diagram' matches Manual
Selection of event in Select an sequence diagram event in the events table (type |Verify that corresponding interaction is selected in the
4.2 events table SEND or RECEIVE) 'Sequence Diagram' view Manual
Verify that the content of the 'Sequence diagram'
Selection of new time changes and the interactions are part of the new
4.3 range Change time range in 'Histogram View'. window range Manual
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Note: Ul tests are not SWTBot, but JUnit tests. Tests
are triggered programmatically right below the dialogs
level

Tooltip backgound is very dark and text is hard to read
on Ubuntu 13.10, 14.10 with default theme
https://bugs.eclipse.org/bugs/show_bug.cgi?id=45552]

It's a bit unclear to me what this is supposed to do. |
think it means when the start of the range changes, it
should update the events shown in the sequence
diagram

Bernd: | updated the description to clarify for the next
release.
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It should have a string status in the search that specify
that the nothing was found. In the test 34, if the user
search for "10.*03" the find dialog will show "String
not found". It should be shown for this test too.

It reaches the right pages but the selection does not
highlight anything when the find box is still opened. It
only highlight the lifeline when we close the find
dialog.

Bernd: It supposed to highlight the lifeline on the
correct page. So, test is successful.

5 View Actions
Verify that different time ranges are selected when
changing page by looking at Histogram View. Histogram
Use buttons and menu items 'Go to next page', 'Go to View window will show the start of the page. Note that
previous page’, 'Go to last page' and 'Go to first page' to there are 10000 interactions per page. In this traces
navigate through trace. Use also menu item 'Pages...' to jump |there are in total 160032 interactions. Verify that last
5.1 Test page navigation to specific page page has 32 interactions between 2 lifelines. Manual
Verify that a dialog box will show. Verify that for this
trace it shows 'Total: 17 pages is shown” and the
1) Select menu item 'Pages...' current page is displayed in the text box. After step 3)
2) In text box type “9” verify that page where changed to page 9. For this trace
5.2 Test menu item 'Pages..." |3) Click on 'OK’ page 9 is the page with 3 lifelines. Manual
Goto to page 1 —
1) Use button and menu item “Find”
2) select Interactions and deselect lifeline
3) type regular expression 10.*00 After 4) verify that interaction 10000 (playert— master)
4) press find is selected. After 5) verify that interaction 10100
5) press find (master — player1) is selected. After 6) verify that
6) press find 10000 (player2 — master) is selected. After 7) verify
7) press find that interaction 10100 (master— player2). After 8
53 Find of interaction 8) press find nothing else will be found Manual
Goto to page 1 —
1) Use button and menu item “Find”
2) select lifeline and deselect interaction
3) type player2 After 4) verify that lifeline with name player2 is selected
4) press find (page 9 with 3 lifelines). After 5) player2 is selected on
5.4 Find of lifeline 5) press find page 10 Manual
1) Restart eclipse
5.5 Find criteria persistence |2) open find dialog Verify that previous used find criteria are still in the list | Manual
1) Select 'Sequence Diagram' view
5.6 Find short-cut 2) pres CTRL+F Verify that find dialog opens Manual
Goto to page 1 —
1) Use menu item 'Hide Patterns...'
2) Press Add
3.1) select Interactions and deselect Lifeline
3.2) type regular expression 10.*03
4) Press 'Create’ After 5) verify that Interactions with name 10003 and
5.7 Filter of interactions 5) Press 'Ok’ 10103 are not shown Manual
Goto to page 9 —
1) Use menu item 'Hide Patterns...'
2) Press Add
3.1) select Lifelines and deselect Interactions
3.2) type regular player2
4) Press 'Create’
5.8  |Filter of lifelines 5) Press 'Ok’ After 5) verify that player2 is not shown Manual
1) Apply one filter
2) Use menu item 'Hide Patterns..."
3) deselect filter
5.9 Deselect filter 4) click 'Ok’ Verify that all lifelines and interactions are shown Manual
1) Restart eclipse
5.10 [Filter criteria persistence |2) open hide dialog Verify that previous used hide criteria are still in the list| Manual
1) Use button and menu item for zoom-in to activate zooming
in Verify that 'Sequence Diagram' view zooms in. Note thaf
5.11 |Zoom-in 2) click into sequence diagram view no selection is possible. Manual
1) Click on button and menu item 'Select' to go back to
selection mode
5.12 |Selection after zooming |2) select an interaction Verify that selection is possible. Manual
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1) Use button and menu item for zoom-out to activate
zooming out

Verify that 'Sequence Diagram' view zoom out. Note

The shortcut is not working when the mouse is
hovering the interaction

The shortcut is not working when the mouse is
hovering the interaction

Key combination on Ubuntu 12.04 is used for
something else. This can be disabled using the
combiz-settings-manager (http://askubuntu.
com/questions/171489/how-to-unbind-shift-alt-up-
shortkey-in-12-04)

After disabling this combination this test case
passes

On Ubuntu 14.04, 14.10, this is not an issue, by
default the keys are not mapped.

5.13 |Zoom-out 2) click into sequence diagram view that no selection is possible. Manual
1) Use button and menu item for 'Reset zoom factor' to reset |Verify that 'Sequence Diagram' view goes back to
5.14 |Reset zoom the zoom level default zoom Manual
1) Select menu item 'Configure Min Max' After 1) verify that a dialog box shows with default
2) Change min to 100 and max to 2000 (keep scale and values. After 3) verify that time compression bar
precision) changes some colors. It will show more deeper red
5.15 |Configure min/max 3) press 'Ok’ because the max value is lower. Manual
After step 2) the default values are shown. After step 3
After changing min and max the time compression bar will change colors. Note that
Configure min/max 1) select menu 'Configure Min Max' the default values are computed based on all deltas of 2
5.16 |(default) 2) press 'Default’ 3) press 'Ok’ consecutive interactions. Manual
Goto to page 1 —
1) Resize view so that the arrow of the interaction is not
shown
2) select on interaction Verify that end lifeline of the interaction (the arrow) is
5.17 |Show node end 3) Use menu item Navigation— Show node end shown Manual
Goto to page 1 —
1) Resize view so that the beginning of the interactions are
not shown
2) select on interaction
5.18 [Show node start 3) Use menu item Navigation— Show node start Verify that start lifeline of the interaction is shown Manual
Goto to page 1 —
1) Resize view so that the arrow of the interaction is not
shown
2) select on interaction Verify that end lifeline of the interaction (the arrow) is
5.19 |Show node end short-cut |3) Press SHIFT+ALT+END shown Manual
Goto to page 1 —
1) Resize view so that the arrow of the interaction is not
shown
Show node start short-  |2) select on interaction
5.20 |cut 3) Press SHIFT+ALT+HOME Verify that start lifeline of the interaction is shown Manual
Verify that within a page the display scrolls down per
5.21 |Scroll down short cut Press SHIFT+ALT+ARROW_DOWN view size Manual
Verify that within a page the display scrolls up per view
5.22  |Scroll up short cut Press SHIFT+ALT+ARROW_UP size Manual
Goto page 9 — Keep pressing + icon at the lowest right Verify that it's possible to navigate through a page of
5.23 |Overview feature corner of the view and drag down, up, left or right the sequence diagram view Manual

On Ubuntu, the movement is hectic and the overview
box is very narrow.

On Mac OS X 10.8, the button is not visible but there is
a visible empty space that is clickable in its place.
Clicking on it brings up the overview box which has a
reasonable size but movement is still hectic.

Bug 436442
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Select 'Sequence Diagram' view and press printer icon in the
Eclipse's tool bar (or use CTRL+P). Select one pager page to

Getting printer data on my Ubuntu 14.04 hangs
(Printer.getDefaultPrinterData() in SDPrintDialogUl)

The dialog is confusing on Ubuntu. The "from pages"
option do not update directly the values you enter

Works on windows (including CTRL+P)

5.24  |Print print Verify that it is possible to print Manual
1) Create 1filter if necessary (see 5.8)
2) Open Error Log view if necessary
3) Open filter dialog box and remove all filters
Remove filter (Bug 4) Press 'Ok’ Verify that no exceptions occurred and after 5) no filter
5.25 [391714) 5) Open filter dialog box again are listed Manual
1) Open trace without any sequence diagram information
2) Open SD view if necessary
3) Open Error Log view if necessary
Time Sync. without 4) change time range in Histogram view
5.27 |interactions (Bug 391716)|5) Change time current selected time in Histogram View Make sure that no exceptions occurred Manual
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2.1.0-TraceCompassTestCases - StatisticsView

18

Target: |Ubuntu 14.04 64 bit
Test Case Action Verification
1 Preparation
Download traces simple-server-thread1 and simple-server-
Preparation thread1 from traces/import/
1.1 Open Perspective Open and reset LTTng Kernel perspective LTTng Kernel perspective opens with correct views SWTBot
Use menu Window— Show View — Other ... — Tracing —
1.2 Open TMF Statistics View |Statistics Verify that 'Statistics' view is shown SWTBot
1) Create Tracing Project
2) Create Experiment (SeqExp)
3) Import 2 traces simple-server-thread1 and simple-server- |Verify that statistics are shown per trace and per event
thread2 type. Each trace has 80021 events. Verify that event
4) Select trace type "Generic CTF Trace" types
5) Add these 2 traces to experiment ENTER/RETURN/SEND/RECEIVE/INFO/after_fork_child
1.3 Open experiment are counted. Manual
2 Manage View
2.1 Delete view Close the 'Statistics' View Statistics' view is removed from perspective Manual
2.2 Open view Use menu Window— Show View — Tracing — Statistics Statistics' view View is displayed and re-populated Manual
Verify that statistics are shown per trace and per event
type. Each trace has 80021 events. Verify that event
Open view when types
experiment/trace is 1) Close 'Statistics View' 2) load trace above trace 3) Open ENTER/RETURN/SEND/RECEIVE/INFO/after_Ffork_child
2.3 already loaded 'Statistics' view are counted Manual
3 Other
Verify that 'Statistics' view is populated gradually durin
3.1 Build of statistic index Open trace indexation Manual
Verify that when opening the trace the x-times (x > 1),
Open same trace multiple times after indexing of trace was |that the statistics appear right away without parsing the
3.2 Persistence of statistics |finished the first time trace again Manual
4 Range Synchronization
External synchronization |In any other view that supports range synchronization, select |[Events in 'Events in selection' is updated and equals
4.1 (Full) the full range of the trace. 'Events total' values Manual
External synchronization |In any other view that supports range synchronization, select |Events in 'Events in selection' is updated according to
4.2 (range) anew range. new range Manual
Multiple Trace
5 Synchronization
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Path is actually Window -> Show view -> Tracing -> Statistics

Randomly, the number of events in a trace stays at zero|
when the statistics view is opened. However, | can't
reproduce the problem at will. Bug 436416

France : | have tried many times to open the view when
the trace is already loaded and was not able to redo the
problem

Bruno : In the event table the statistics view is only
modified if you select events from top to bottom
(select an event and shift click an event that is under in|
the table). Patrick: Bug 494767 opened. Also doesn't
update for a selection that is out-of-range of a trace in
an experiment. View doesn't update if the selection is
updated from the events table after using the vertical
slider. Bug 494810 opened. JC: I don't have any of
these issues.
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1) Download traces.zip (if necessary) and unzip into a local
directory ${local}

2) Import kernel trace ${local}/traces/import/kernel-
overlap-testing

3) Import UST ${local}/traces/import/trace ust-overlap-
testing

4) Create experiment with trace of 2) in it

Manual

Open multiple traces (no

Patrick: The pie chart doesn't know from which trace
the event comes from. Maybe we could skip events in
the tree that have zero count though?

5.1 overlap) Open multiple traces that don't overlap in time View shows the last opened trace Manual
Change selected time and|In any other view that supports range synchronization, select [Events in 'Events in selection' is updated according to
5.2 range (no overlap) anew range new range Manual
View is updated to show selected trace. 'Events in
Select other trace (no selection' is updated according to the selected trace's
5.3 overlap) Select different trace by clicking its Events editor tab previously selected range. Manual
Open multiple traces
5.4 (overlap) Open multiple traces that overlap in time View shows the last opened trace Manual
Change selected time and|In any other view that supports range synchronization, select
5.5 range (overlap) anew range Events in selection' is updated according to new range | Manual
View is updated to show selected trace. 'Events in
Select other trace selection' is updated according to the newly selected
5.6 |(overlap) Select different trace by clicking its Events editor tab time and range. Manual
5.7 |Close all traces Close all Events editor tabs View is cleared. Manual
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TMF - Time Chart View 26 1 0 2
Target: |Ubuntu 14.04 64 bit
Step Test Case Action Verification Type Comment
1 Preparation
1.1 Preparation step 1 Open and reset LTTng Kernel perspective LTTng Kernel perspective opens with correct views. SWTBot Pass
1.2 |Preparation step 2 Show Time Chart View Time Chart view is shown Manual Pass
2 Trace handling
Trace #1 entry added to Time Chart view. Trace #1 is
2.1 Open trace Open an LTTng CTF Kernel trace #1 selected entry. Range of view is full trace range. Manual Pass
Trace #2 entry added to Time Chart view. Trace #2 is
selected entry. Range of view is union of full trace
2.2 Open other trace Open an LTTng CTF Kernel trace #2 ranges. Manual Pass
Experiment entry added to Time Chart view. Experimen
is selected entry. Range of view is union of full trace
2.3 Open experiment Open an experiment ranges. Manual Pass
Trace #1 is selected entry. View range does not change.
2.4 Select other trace Select trace #1 by clicking its trace entry in Time Chart view |Trace #1 editor tab is brought to top. Manual Pass
Select other trace
2.5 (external) Select trace #2 by clicking its editor tab Trace #2 is selected entry. View range does not change,| Manual Pass
2.6 Close view Close the Time Chart view Time Chart view is removed from perspective Manual Pass
Bruno : It is re-populated, but there is no status bar of any kind, so if
tak hile bef Il th ts (if you have |
Time Chart view is displayed and re-populated with {P:cye:)e a while before you see all the events (if you have large
2.7 Open view Show Time Chart view opened traces data Manual Pass
Trace entry is removed from Time Chart view. Range is
2.8 Close trace/experiment |Close trace #2 editor tab. Repeat with experiment editor tab.|view is union of remaining full trace ranges. Manual Pass
2.9 Close last trace Close trace #1 editor tab View is cleared. Manual Pass
3 Time Synchronization
Other views are synchronized to the selected time.
Mouse synchronization Event at or following the selected time is selected in
3.1 (single time) Left-click on the time chart. The selected time line is updated.|the event table. Manual Pass
Other views are synchronized to the selected range.
Mouse synchronization  |Shift-left-click or left-drag on the time chart. The selected Event at or following the selected time is selected in
3.2 (time range) time range is updated. the event table. Manual Pass
External synchronization Selected time line is updated to the event time. If
33 (single time) In event table, select an event. necessary, range is updated to show selected time. Manual Pass
External synchronization
3.4 (time range) In event table, select an event range with shift-left-click. Selected time line is updated to the time range. Manual Pass
Zoom Range
4 Synchronization
Bruno : Not sure if this is a bug, but if | have an event selected in th:
event table, and | zoom in on an other section of the time chart (tha
does not include the selected event) the event table won't
Mouse wheel synchronize to the new range. Patrick: Synchronization of event
4.1 synchronization Zoom in/out with mouse wheel while holding Ctrl. Other views are synchronized to the new range Manual Pass  table is only based on selection range.
Mouse drag zoom
4.2 synchronization Drag zoom with right-button on time chart. Other views are synchronized to the new range Manual Pass
Mouse drag move
4.3 synchronization Drag move with ctrl-left or middle button on time chart. Other views are synchronized to the new range Manual Pass
Mouse full range
4.4  |synchronization Double-click with left button on time chart's time scale. Other views are synchronized to the full range Manual Pass
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In any other view that supports range synchronization, select

4.5 External synchronization |new zoom range. View range is updated to the new range |
Event Table

5 Synchronization

5.1 Search synchronization  |Enter a search regex in event table Matching events are marked in time chart Manual

5.2 Search cleared Clear the search regex in event table Marks are removed in time chart Manual

53 Filter synchronization Enter a filter regex in event table Non-matching events are removed from time chart Manual

5.4  |Filter cleared Clear the filter regex in event table All events are shown in time chart Manual
Bookmark

5.5 synchronization Add a bookmark in event table Bookmarked event is marked in time chart Manual

5.6 |Bookmark cleared Remove the bookmark in event table Mark is removed in time chart Manual
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2.1.0-TraceCompassTestCases - Custom Parsers

28

Target:

Linux 64

Verification

Comment

Test Case

Action

0 Prerequisites
Find text and XML parser definitions in
Traces.zip/traces/customParsers and logs
0.1 |Get custom parser definition and logs |in /import
1 View management
Open and reset Tracing perspective, and
1.1 |Open perspective open Time Chart view Time Chart view opens. Manual Pass
Create a tracing project, open Manage
Custom Parsers dialog and import text  |Custom parsers imported (TmfGeneric,
1.2 |Import custom parser definitions and XML custom parser definitions Custom XML Log) Manual Pass
Traces imported in Traces folder of project
(ExampleCustomTxt.log,
Create a tracing project and import a text |ExampleCustomXml.xml) and have their trace
1.3 |Import custom traces and XML custom trace type auto-selected. Manual Pass
2 Custom parser management
Open Manage Custom Parsers dialog in
2.1 |Open Manage Custom Parsers dialog | Traces folder context menu Dialog opens. SWTBot Pass
Select "Text" radio button, click New...
button, enter Trace type, change stuff, clig
2.2 |New (text) Next, click Finish Custom parser appears in list. SWTBot Pass
Select custom parser, click Edit..., changg Previously entered data appears, can be
2.3 |Edit (text) stuff, click Next, click Finish edited. SWTBot Pass
Select custom parser, click Export, enter
2.4 |Export (text) name, click Save Exported custom parser stored in file system.| Manual Pass
2.5 |Delete (text) Select custom parser, click Delete Custom parser is deleted. SWTBot Pass
Click Import, find custom parser definition
2.6 |Import (text) click Open Imported custom parser appears in list. Manual Pass
Select "XML" radio button, click New...
button, enter Log Type, write an xml log in
the input,
<a><b><c>1</c><d>1</d></b><b><c>2<
c><d>1</d></b></a> then click on feeling
lucky. Set b to log entry, set c to
timestamp logged and d to message
logged, set timestamp format to ss in both
2.7 |New (XML) text boxes, click Next, click Finish Custom parser appears in list. Manual Pass
Select custom parser, click Edit..., changgPreviously entered data appears, can be
2.8 |Edit (XML) stuff, click Next, click Finish edited. Manual Pass
. If you export to an existing .xml that is not an XML
Select custom parser, click Export, enter custom parser file, the export is ignored without
2.9 |Export (XML) name, click Save Exported custom parser stored in file system.| Manual Pass warning to the user. Patrick: Bug 49054 opened.
2.10 |Delete (XML) Select custom parser, click Delete Custom parser is deleted. SWTBot Pass
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Click Import, find custom parser definition

selection in raw view is hard to see

2.11  |Import (XML) click Open Imported custom parser appears in list.
3 Custom parser trace handling
Select test file in Traces folder, right-click,
select "Select Trace Type > Custom Text | Trace type is assigned (re-open Select Trace
3.1 |Select trace type (text) > (parser name)" Type sub-menu to verify) Manual
Editor opens with events table, Time Chart
3.2 |Open trace (text) Double-click on test file in Traces folder |view is populated. Manual
3.3 |Raw view (text) Right-click in editor, click Show Raw Editor is split with raw view on right pane. Manual
Click in Time Chart view, select event in
3.4 |Time synchronization (text) editor table, select event in raw view All three widgets synchronize to selected timg. Manual
Select test file in Traces folder, right-click,
select "Select Trace Type > Custom XML |Trace type is assigned (re-open Select Trace
3.5 |Select trace type (XML) > (parser name)" Type sub-menu to verify) Manual
Editor opens with events table, Time Chart
3.6 |Open trace (XML) Double-click on test file in Traces folder |view is populated. Manual
3.7 |Raw view (XML) Right-click in editor, click Show Raw Editor is split with raw view on right pane. Manual
Click in Time Chart view, select event in
3.8 |Time synchronization (XML) editor table, select event in raw view All three widgets synchronize to selected timg. Manual
4  Rawviewer
1) Open Custom text trace
2) Right-click in table and select "Show
4.1  |Show Raw Viewer Raw" Raw viewer is shown beside the events table| Manual
Right-click in table and select "Hide Events table is hidden and only raw viewer is
4.2 |Hide Table Table" shown Manual
Right-click in raw viewer and select "Show
4.3 |Show Table Table" Events table is shown beside raw viewer Manual
Correct event is select in table, timestamp is
propagated to other TMF views and
Properties view shows content of selected
4.4 |Select Event (Bug 457852) Select event in raw viewer event Manual
Correct event is select in table, timestamp is
1) select event in raw viewer with mouse |propagated to other TMF views and
Select Event using arrow keys 2) use arrow key down and up several Properties view shows content of selected
45 |(457852) times event Manual
Raw viewer is hidden and only events table i
4.6 |Hide Raw viewer Right-click in table and select "Hide Raw"|shown Manual
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0 o P o Do 0
TMEF - State System Explorer 14 0 0
Target: |Ubuntu 14.04 64 bit

Test Case Action Verification Comment

1 Preparation

Open TMF State System Explorer [Use menu Window — Show View — Tracing — State System
1.1 View Explorer Verify that 'State System Explorer' view is shown Manual | Pass

2 Manage View
2.1 Delete view Close the State System Explorer' View 'State System Explorer' view is removed from perspective Manual | Pass

Use menu Window — Show View — Tracing — State System
2.2 |Open view Explorer 'State System Explorer' view is displayed and re-populated Manual | Pass

Verify that view is populated with kernel state system (o.e.t.analysis.os.linux.kegnel)
2.3 |Open Trace Open an LTTng Kernel Trace and statistics state systems (o.e.l.tmf statistics.*) of opened trace Manual | Pass | Some state systems ID's should be renamed for Trace Compass

1) Close State System Explorer View
Open view when trace is already 2) Load LTTng trace
24  |loaded 3) Open 'State System Explorer' view Verify that view is populated with state systems from trace Manual | Pass | (if the state system were already built)

The values are only available for time ranges where the trace
exists. Only after we've "visited" other timestamps, then the
attributes show up and print "Out of range". http://eclip.

se/443653
. . . . . Bruno : I find the separation weird, and sincce I never used this
Verify that view is populated with all kernel state system and statistics state systems view i'd like someone else to test this item. (Only the items in the
2.5 |Open Experiment Open Experiment with 2 or more LTTng traces of opened experiment (separated by trace) Manual | Pass | second trace are expendable)

View is updated to show selected trace. State values, start time and end time are

2.7 |Select other trace Select different trace by clicking its Events editor tab updated according to the selected trace's previously selected range. Manual | Pass
2.6 |Restart Restart Eclipse Verify that view is populated with state systems from trace Manual | Pass
2.7 |Close all traces Close traces and experiment one by one from the editor tab Verify that state system explorer view is cleared after closing the last trace Manual | Pass

3 Timestamp / Time Range Selection

Select time in another view (e.g Histogram view) that supports time
3.1 Select timestamp synchronization Verify that state values are updated Manual | Pass

Bruno : I'd like someone else to test this item, selecting time
range in the histogram view with positive values does not show
anything in the state system view, but with negative time interval
the view is not update..., not sure if this is the correct behavior.

. . . . . . . . . . . Patrick: Histogram view does not currently support negative
Select a time range in another view that supports time Verify that only the start of the range is taken in consideration (changing the end time selection so the state system explorer always synchronized on
3.2 |Select time range synchronization of the range should not affect the displayed values) Manual | Pass | the earliest time in the Histogram view selection. See bug 470057

4 Displaying of Changed Values

Attributes whose value changed in the last timestamp selection should be highlighted

4.1 |Highlighting of changed values Select many different timestamps one after the other in yellow. Manual | Pass
“Only Display Changes at Selected
Timestamp” option with event Enable the “Only Display Changes at Selected Timestamp” optiqn

4.2 |selection with the toolbar button. Select different Events from the Event TaWlerify that only the state values that changed because of that event are displayed. Manual | Pass

Enable the “Only Display Changes at Selected Timestamp” optiqn.
“Only Display Changes at Selected |Select *timestamps* corresponding to state changes (for examplg,
Timestamp” with timestamp selectiofusing the previous/next buttons in the Control Flow View). Verify that only the state values that changed at that timestamp are displayed. Manual | Pass
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TMEF - Call Stack View 24 10 0 7
Target: | Windows 7 64 bit
ep 0
0 Download the test resources Download this
1 Preparation
Use menu Window — Show View — Other ... — Tracing — Cadll
1.1 |Open TMF Call Stack View Stack Verify that 'Call Stack' view is shown SWTBot | Pass  Path is actually Window -> Show view -> Tracing -> Call stack
Import a trace that does not have any call stack information, like pVerify that nothing is shown in the view, except “Stack info not available
1.2 |Import generic trace standard kernel trace (<tracename>)” Manual | Pass
1.3 |Import cyg-profile trace Import the trace in the "trace" directory of the downloaded zip | Verify that the Callstack View is populated with some callstack information. SWTBot | Pass
1.4 |Import cyg-profile-fast trace Import a trace in the "trace-fast" directory of the downloaded zip| Verify that the Callstack View is populated with some callstack information. SWTBot | Pass
| |
2 Manage View
2.1 Delete view Close the Call stack view' View 'Call Stack' view is removed from perspective Manual | Pass
Use menu Window — Show View — Other ... — Tracing — Cadll
2.2 |Open view Stack 'Call Stack' view is displayed and re-populated Manual | Pass  See comment 1.1. about the path
2.3 |Open Trace Open "trace(-fast)" trace Verify that view is populated with call stack information Manual | Pass
1) Close 'Call Stack' view
2) Open "glxgears-cyg-profile(-fast)" trace located in the git in ctf
test
2.4 |Open view when trace is already loaded 3) Open 'Call Stack' view Verify that view is populated with call stack information Manual | Pass
Open Experiment with 2 or more Call Stack traces.
2.5 |Open Experiment (You can use both traces) Verify that view is populated with all call stack information (separated by trace)] Manual | Pass
2.7 |Select other trace Select different trace by clicking its Events editor tab View is updated to show selected trace. Manual | Pass
2.6  |Restart Restart Eclipse with Call Stack trace opened Verify that view is populated with call stack from trace Manual | Pass
2.7 |Close all traces Close traces and experiment one by one from the editor tab Verify that Call Stack view is cleared after closing the last trace Manual | Pass
3 Navigation
Selected time line is updated. Table is updated to show the full stack information at
3.1 |Select time Click on random time in the time graph pane the selected time. Selected time is updated in other views. SWTBot | Pass
Previous or next call stack change is selected and corresponding active function pnd
stack depth is selected. Table is updated to show the full stack information at the
3.2 |Select Previous/Next Event Click Previous/Next Event button selected time. Selected time is updated in other views. SWTBot | Pass
3.3 |Zoom to function (table) Double-click on a function in the table pane Time range is updated to the full duration of the selected function SWTBot | Pass
3.4 |Zoom to function (time graph) Double-click on a function (interval) in the time graph pane Time range is updated to the full duration of the selected function SWTBot | Pass
3.5 |Go to first event in trace Go to events editor, press home the call stack view is updated Manual | Pass  Fixed in https:/git.cclipse.org/r/#/c/80177/1
4 Synchronization
Selected time line is updated. Table is updated to show the full stack information at The vertical scroll bar is not l}pdalcd(Sgnia: only when you
" . N R . N select a rendom time in the histogram view).If you select an
the selected time. If selected time is outside current range, time range is updated|to event (in another view)before the start of the calls, the vertical
4.1  |Time synchronization Select a random time in another view include it. SWTBot | Pass | scroll bar goes down.
Select a call stack-impacting event (function entry/exit) in events|In addition to updating the selected time, the active function at the event time is
4.2 |Event synchronization table selected. Vertical scroll bar is updated if necessary. SWTBot | Pass
4.3 |Time range synchronization Select a new time range in Histogram view. Time range is updated. SWTBot | Pass
5 Function name import - Text file
Open 'trace' from Fibonacci.zip. Click the "Import a textfile..."
button in the view. Select a random file that does not contain any
5.1 |Invalid text file import debugging info. The function addresses do not change. Manual | Pass
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The view now displays function names instead of function addresses (both in thg

The symbol mapping is applied on view level. If multiple traces
are opened, or if an experiment with multiple traces is opened,
they cannot each have their own mapping. Bug 459909.

France : I am not sure what to do here Sonia : The bug is
resolved , you can specify a mapping file for each trace if you

5.2 |Valid text file import Import a file "fibonacci.symbols" timegraph and the call stack areas). Manual have a multiple traces in one experiment.
6 Function name import - CDT
Sonia :you have to specify the binary file for each trace.The view|
. " . " . . . won't display the function names for the both traces if we select
Click the "Import Binary..." button in the view, select the fibonadci the fibonacci executable for a trace in an experiment with multipl|
6.1  |Binary import executable (fibonacci) The view now displays the function names for both traces Manual traces.
6.2 |Binary import lttng 2.8+ Open an lttng 2.8+ trace with the executable present The view now displays the function names for the trace Manual
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O P o Do 0
TMF - Remote Fetching 52 15 0 9
Target: |Ubuntu 14.04 64 bit
Test Case Action Verification Comment
1 Preparation
1.1 |Step 1 \Open Trace Compass and reset Lttng perspective |Lttng perspective opens with correct views
2 Opening
. . Bruno : Not this test, but the Fetch Remotes
Right-click on Traces Folder -> Fetch Remote Traces ... -> Traces dialog, has a help button that does
2.1 Open Profile Editor 1 Manage Profiles The Profile Editor of preference page opens SWTBot Pass nothing. Patrick: See Bug 440238.
2.2 Open Profile Editor 2 Wwindow -> Preferences-> Tracing -> Remote Profiles The Profile Editor of preference page opens SWTBot Pass
3 Edit Profile - Add/Delete
Open Profile Editor > Click on 'Add" > Enter profile name,
3.1 Create Profile remote information, root path and trace pattern New Profile is created and template is provided SWTBot Pass
Select Profile node > right mouse click > select 'New New Connection Node is create under the profile and
3.2 Add Node Connection Node' template is provided SWTBot Pass
Select node node > righ mouse click > select 'New Trace New Trace Group is created under the node and template
3.3 Add trace group Group' is provided SWTBot Pass
New Trace is created under Trace Group and template is
3.4 Add trace Select trace group > right mouse click > select 'New Trace' |provided SWTBot Pass
3.5 Delete Trace Select trace > right mouse click > select Delete Trace is deleted SWTBot Pass
3.6 Delete Trace Group Select Trace Group> right mouse click > select Delete Trace Group is deleted Manual Pass
3.7 Delete Connection Node Select Connection Node > right mouse click > select Delete |Connection Node is deleted Manual Pass
3.8 Remove Profile Select Profile > click on 'Remove' button Profile is deleted SWTBot Pass
4 Edit Profile - Reorder
Create at 2-3 profiles > select 2nd profile and press buttons
4.1 Move profile up/down 'Move Up'/'Move Down' Profiles are moved up and down Manual Pass
Move connection node Make sure that there are 2 or 3 connection nodes > select 1
4.2 up/down connection node > click buttons 'Move Up'/'Move Down' Connection Nodes are moved up and down within a profile Manual Pass
Make sure that there are 2 or 3 trace gropus > select 1 trace |Trace Groups are moved up and down within a connection
4.3 Move Trace Group up/down |group > click buttons 'Move Up'/'Move Down' node Manual Pass
Make sure that there are 2 or 3 trace groups > select 1 traces
4.4 Move Trace up/down > click buttons 'Move Up'/'Move Down' Traces are moved up and down within a Trace Group SWTBot Pass
Edit Profile - Copy, Cut,
5 Paste
Select Profile > click right mouse button on a profile > Select
Copy -> click right mouse button on other profile > Select
5.1 Copy/Paste Profile Paste Profile is pasted under the selected profile Manual Pass
5.2 Copy/Paste Profile (Keys) Redo 5.1 with CTRL+C and CTRL+V keys Profile is pasted under the selected profile Manual Pass
Select Profile > click right mouse button on a Connection
Node > Select Copy -> click right mouse button on other
5.3 Copy/Paste Connection Node |Connection Node > Select Paste Profile is pasted under the selected Connection Node Manual Pass
Copy/Paste Connection Node
5.4 (Keys) Redo 5.3 with CTRL+C and CTRL+V keys Profile is pasted under the selected Connection Node Manual Pass
Select Profile > click right mouse button on a Trace Group >
Select Copy -> click right mouse button on other Trace
5.5 Copy/Paste Trace Group Group > Select Paste Profile is pasted under the selected Trace Group Manual Pass
Copy/Paste Trace Group
5.6 (Keys) Redo 5.5 with CTRL+C and CTRL+V keys Profile is pasted under the selected Trace Group Manual Pass
Select Profile > click right mouse button on a Trace > Select
Copy -> click right mouse button on other Trace > Select
5.7 Copy/Paste Trace Paste Profile is pasted under the selected Trace SWTBot Pass
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Trace (5.7) is done with SWTBot

Local connection is used in SWTBot

Local connection is used in SWTBot

5.8 Copy/Paste Trace (Key) Redo 5.5 with CTRL+C and CTRL+V keys Profile is pasted under the selected Trace Manual
5.9 Cut/Paste Redo 5.1 - 5.8 with cut and paste Successful cut and paste Manual
6 Edit Profile - Adverserial
6.1 Error empty profile name Clear profile name Error message "Profile must not be empty" Manual
6.2 Duplicate profile name Add profile with name of existing profile Error message "<name>: Duplicate profile name" Manual
Error empty Connection node
6.3 name Clear Connection node name Error message "Node name must not be empty" Manual
Duplicate Connection node Within a profile, add Connection node with name of existing
6.4 name node Error message "Duplicate node names" Manual
6.5 Missing username in URI remove user name of a Connection Node Error message "URI must include user information" Manual
Error message "URI must include valid host and port
6.6 Invalid URI add invalid URI number" or "Unsupported URI scheme" Manual
6.7 Error empty Trace Group Delete Trace Group root path Error message "Root path must not be empty" Manual
6.8 Error empty Trace Delete File Pattern Error message "File pattern must not be empty" Manual
6.9 Invalid File pattern Add trace with invalid regular expression Error message "Invalid file pattern” Manual
5 Export/Import Profile
Select multipe profiles > Click Export Button > Select Folder
7.1 Export Profile and enter file name > OK Only selected profiles are exported SWTBot
7.2 Import Profile Click on Import Button > select profile XML file > OK Profiles are imported SWTBot
after second import an error message appears "Duplicate
7.3 Import Profile Redo 7.2 profile names" Manual
8 Remote Fetch Wizard
1) Import Test Profiles (test-profiles.xml) from test spec.
template directory
2) Edit profiles in Fetch Remote Traces > Manage profiles
3) Change 'user' and '127.0.0.1" for all connection nodes if
necessary
3) Extract traces.zip from test spec. template directory in
/emp
4) Load custom text parsers located in traces.zip
8.1 Preparation (traces/customParsers)
1) Create traces in /tmp/traces/syslog and
/tmp/traces/generated/synthetic-trace
2) Create Profile with Local connection, 1 trace group (root
Jtmp/traces/) and 2 traces (.*syslog.* and .*synthetic.*) in thig
group
3) Select profile in Fetch Remote Traces wizard (Remote
Create and run Profile "new  |Profile page)
Profile" (syslog + synthetic 4) Click on 'Next' button Verify that all test traces are imported with correct trace
8.2 CTF trace in sub-directory) 5) Click on 'Finish' types assigned. Verify that folder structure is preserved. SWTBot
Clear traces Delete all traces from Traces directory All traces deleted
1) Create traces in /tmp/traces/syslog and
/tmp/traces/generated/synthetic-trace
2) Create Profile with Local connection, 1 trace group (root
Jtmp/traces/) and 2 traces (.*syslog.* and .*synthetic.*) in thig
group
3) Select profile in Fetch Remote Traces wizard (Remote
Create and run Profile "new |Profile page)
Profile" (syslog + synthetic 4) Click on 'Next' button Verify that only the selected traces are imported with
CTF trace in sub-directory), 5) deslect the synthetic CTF trace correct trace types assigned. Verify that folder structure is|
8.3 only 1 trace selected 5) Click on 'Finish' preserved. SWTBot
Clear traces Delete all traces from Traces directory All traces deleted
1) Select profile "TestAllRecursive" in Fetch Remote Traces |Verify that all test traces are imported with correct trace
wizard (Remote Profile page) types assigned (LTTng kernel, LTTng UST, custom text,
2) Click on 'Next' button (enter password if needed) custom XML). The file unrecognized.log is importeds with
3) Click on 'Finish' unrecognized trace type. Make sure that directory
8.4 Run Profile "TestAllRecursive" structure is preserved. Manual
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Re-run Profile

1) Select profile "TestAllRecursive" in Fetch Remote Traces
wizard (Remote Profile page)

2) Click on 'Next' button (enter password if needed)

3) Click on 'Finish'

4) In dialog box select 'Rename’ for the first trace and

Verify that all test traces are imported with new name and
correct trace types assigned (LTTng kernel, LTTng UST,
custom text, custom XML). The file unrecognized.log is
importeds with unrecognized trace type. Make sure that

8.5 "TestAllRecursive" (Rename) |'Rename ALL' for the second traces directory structure is preserved. Manual
1) Select profile "TestAllRecursive" in Fetch Remote Traces
wizard (Remote Profile page) Verify that all test traces are imported with correct trace
2) Click on 'Next' button (enter password if needed) types assigned where old traces are overwritten. (LTTng
3) Click on 'Finish' kernel, LTTng UST, custom text, custom XML). The file
Re-run Profile 4) In dialog box select 'Overwrite' for the first trace and unrecognized.log is importeds with unrecognized trace
8.6 "TestAllRecursive" (Overwrite)'Overwrite ALL' for the second traces type. Make sure that directory structure is preserved. Manual
1) Select profile "TestAllRecursive" in Fetch Remote Traces
wizard (Remote Profile page)
2) Click on 'Next' button (enter password if needed)
3) Click on 'Finish'
Re-run Profile 4) In dialog box select 'Skip' For the First trace and "Skip ALL' |Verify that all test traces are skipped and no trace is
8.7 "TestAllRecursive" (Skip) for the second traces imported Manual
Verify that all test traces are imported with correct trace
1) Select profile "TestAllRecursive" in Fetch Remote Traces |types assigned where old traces are overwritten (no dialog
wizard (Remote Profile page) box opens). (LTTng kernel, LTTng UST, custom text,
Re-run Profile 2) Select checkbox 'Overwrite traces without warning' custom XML). The file unrecognized.log is importeds with
"TestAllRecursive" (Overwrite|3) Click on 'Next' button (enter password if needed) unrecognized trace type. Make sure that directory
8.8 2) 4) Click on 'Finish’ structure is preserved. Manual
Clear traces Delete all traces from Traces directory All traces deleted
Verify that all test traces are imported with correct trace
types assigned. The second page is omitted. (LTTng kernel
1) Select profile "TestAllRecursive" in Fetch Remote Traces |LTTng UST, custom text, custom XML). The file
Re-run Profile wizard (Remote Profile page) unrecognized.log is importeds with unrecognized trace
8.9 "TestAllRecursive" (2) 2) Click on 'Finish' (enter password if needed) type. Make sure that directory structure is preserved. Manual
Clear traces Delete all traces from Traces directory All traces deleted
1) Select profile "TestAllNonRecursive" in Fetch Remote
Traces wizard (Remote Profile page) Verify that only traces from root path are imported (LTTng
2) Click on 'Next' button (enter password if needed) kernel, LTTng UST, custom text, custom XML). The file
Run Profile 3) Click on 'Finish' unrecognized.log is importeds with unrecognized trace
8.10 "TestAllNonRecursive" type. Make sure that directory structure is preserved. Manual
Clear traces Delete all traces from Traces directory All traces deleted
1) Select profile "TestSpecificRecursive" in Fetch Remote
Traces wizard (Remote Profile page) ) \ ) ,
2) Click on 'Next' button (enter password if needed) Verify that only kernel and custom text/XML logs are E;%fg?r;‘;;_:;adczstyfﬁu???;:i,ﬁ;gég;ﬁgﬁ:
Run Profile 3) Click on 'Finish' imported from root and subdirectory. Make sure that Looks intentional, see
8.11 "TestSpecificRecursive" directory structure is preserved. Manual RemoteGenerateManifestOperation:186.
Clear traces Delete all traces from Traces directory All traces deleted
1) Select profile "TestSpecificNonRecursive" in Fetch Remote ) . ) .
Traces wizard (Remote Profile page) fmf"‘? has:ffe t’,’f.e G?("e”c ICTTF Tfage tb.“:(_
2) Click on 'Next' button (enter password if needed) Verify that only kernel and custom text/XML logs are e T ool sou fremel frace. Fatrick:
Run Profile 3) Click on 'Finish' imported from root directory only. Make sure that RemoteGenerateManifestOperation:186.
8.12 "TestSpecificNonRecursive" directory structure is preserved. Manual
Clear traces Delete all traces from Traces directory All traces deleted
1) Select profile "TestSpecificMultiGroupRecursive" in Fetch
Remote Traces wizard (Remote Profile page) Profile has trace type 'Generic CTF Trace' but
Run Profile 2) Click on 'Next' button (enter password if needed) Verify that only traces from root path are imported (LTTng trg::;Ei!msznrez:icis){l?;ux?:r:‘; race Patriok:
"TestSpecificMutliGroupRecur |3) Click on 'Finish' kernel, LTTng UST, custom text, custom XML). Make sure Looks intentional, see
8.13 sive" that directory structure is preserved. Manual RemoteGenerateManifestOperation:186.
Clear traces Delete all traces from Traces directory All traces deleted
1) Select profile "TestAllRecursive" in Fetch Remote Traces
wizard (Remote Profile page)
2) Click on 'Next' button (enter password if needed)
3) Click on 'Finish'
8.14 Cancel Import 4) Cancel import (red square or Cancel button) Verify that import operation is cancelled Manual
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Clear traces

Delete all traces from Traces directory

All traces deleted

1) Select profile "TestMultiNodes" in Fetch Remote Traces
wizard (Remote Profile page)
2) Click on 'Next' button (enter password if needed)

Verify that only traces from root path are imported (LTTng
kernel, LTTng UST, custom text, custom XML). The file

unrecognized.log is importeds with unrecognized trace
type. Make sure that directory structure is preserved. 2

8.15 Run Profile "TestMultiNodes" |3) Click on 'Finish’ nodes directories are created with the above traces stored Manual
9 Connection Handling
Error cannot connect to
remote host (node doesn't Create profile with IP address that cannot be connected to |Operation to connect to remote node fails and error dialog
9.1 exist) and run profile is shown with detailed information (after time-out) Manual
Bruno : Not really a bug, but you have to fail your
p?ssword 5 times before having the first error
Error cannot connect to i ) Operation to connect to remote node fails with time-out g::%%fggﬁ;e%wng‘;:::;:ferg‘e‘z;gt;"g::g
remote host (wrong Create profile valid IP address. When asked for password and error dialog is shown with detailed information. Note This is the Remote Systems implementation with
9.2 password) enter invalid password time-out is as per remote development preferences Manual retries.
10 Other Remote Backends
Clear traces Delete all traces from Traces directory All traces deleted
Verify that all test traces are imported with correct trace
types assigned (LTTng kernel, LTTng UST, custom text,
custom XML). The file unrecognized.log is importeds with
Create profile (see 7.3) with URI scheme file (instead of ssh) |unrecognized trace type. Make sure that directory
10.2 Remote Fetch using Local and node name Local and redo test 7.3 structure is preserved. SWTBot See tests 7.2/7.3
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2.1.0-TraceCompassTestCases - LTTng 2.0 - ControlFlowView

54

Target:

Windows

Test Case

Verification

Comment

0 Prerequisites
0.1 Import traces Import LTTng Kernel traces in Tracing projec
Create an experiment with LTTng Kernel
0.2 Create experiment traces
1 View management
1.1 Open perspective Open and reset LTTng Kernel Perspective |Control Flow view opens. SWTBot Pass
Control Flow view is populated with
processes, sorted by Trace then TID. Child
processes appear under their parent, sorted
by birth time. Range is set to initial offset.
1.2 Open trace Open LTTng Kernel trace in Project Explorer|Arrows are drawn between states of a CPU. Manual Pass
Control Flow view is populated with
processes, sorted by Trace then TID. Child
processes appear under their parent, sorted
Open experiment with LTTng Kernel traces inby birth time. Range is set to initial offset.
1.2 Open experiment Project Explorer Arrows are drawn between states of a CPU. Manual Pass Could be nice to have the trace as root and not only in a colurr
1.3 Close view Close the Control Flow view View is closed. Manual Pass
Control Flow view is opened and populated
1.4 Open view Open the Control Flow view with processes. Manual Pass
2 View selection
21 Select process in table Select a process in the table Same process is highlighted in time graph. Manual Pass
Same process is highlighted in table. Selecteq
Select a process in the time graph (empty  [time line is updated. Other views are
2.2 Select process in time graph region) synchronized to selected time. Manual Pass
Same process is highlighted in table. State is
highlighted in time graph. Selected time line ig
updated. Other views are synchronized to
23 Select state in time graph Select a state in the time graph selected time. Manual Pass
3 Mouse handling
Time range is dragged. When mouse button is
Ctrl-Drag move time graph left and right with |released, states are updated and new time
3.1 Drag move time range middle button range is propagated to other views. Manual Pass what is called 'time range' here should actually be called 'winc
Time range is zoomed in and out, relative to
mouse cursor. When mouse wheel is stopped
Zoom with mouse wheel up and down, cursoffor a short time, states are updated and new
3.2 Zoom time range (mouse wheel) |inside time graph while holding the Ctl button|time range is propagated to other views. Manual Pass
Time range is zoomed in and out. When
mouse button is released, states are updated
Drag in time graph scale left and right with lefand new time range is propagated to other
3.3 Zoom time range (mouse drag) button views. Manual Pass
Table and time graph scroll up and down and
Scroll with mouse wheel up and down, cursofremain aligned. Selected process does not
3.4 Mouse vertical scroll outside time graph change. Vertical scroll bar updated. Manual Pass
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Table and time graph scroll up and down and
remain aligned. Selected process does not

Tested in Windows

3.5 Vertical scroll bar Click and drag vertical scroll bar change. Manual
Selection highlighted. When mouse button is
released, time range is zoomed to selection,
states are updated and new time range is
3.6 Drag select time range Drag select time graph with right button propagated to other views. Manual
Time range is reset to full range, states are
updated and new time range is propagated to
3.7 Double-click reset time range Double-click left button on time scale other views. Manual
3.8 Mouse hover (empty region) Hover mouse in time graph over empty regionTool tip shows process name only. Manual
Tool tip shows process name, state name,
date, start time, end time, duration. For
USERMODE state, CPU is shown. For
SYSCALL state, CPU and System Call is
shown. For INTERRUPTED state, CPU is
3.9 Mouse hover (state) Hover mouse in time graph over state shown. Manual
Selection highlighted. Status bar of Eclipse is
updated with time information: T, T1, T2 and
delta, where T is the time of the mouse
position, T1 the first selected time, T2 the
second (draggged) selected time and delta
the time difference between T2-T1 (can be
3.10 |Drag mouse selection Drag select time graph with left button negative) Manual
Selection highlighted. Status bar of Eclipse is
updated with time information: T, T1, T2 and
delta, where T is the time of the mouse
position, T1 the first selected time, T2 the
Click select with left button (begin time), pres|second (draggged) selected time and delta
shift key and click select another time (end |the time difference between T2-T1 (can be
3.1 Shift key selection time) negative) Manual
4 Keyboard handling
Selected process is changed. Time graph
Keyboard navigation in table With focus on table, use UP, DOWN, HOME |selection is updated. Vertical scroll bar
4.1 (process selection) END keys updated. Manual
With focus on table, For parent process, tree is expanded or
in Windows use LEFT, RIGHT keys while collapsed. Time graph item expansion is
parent or child process is selected updated. Vertical scroll bar updated. For child
process, left changes selection to parent, time
Keyboard navigation in table (tree |in Linux use SHIFT LEFT, RIGHT keys while|graph selection is updated. Vertical scroll bar
4.2 expansion) parent or child process is selected updated. Manual
Keyboard navigation in time graph |With focus on time graph, use UP, DOWN, |Selected process is changed. Table selection
4.3 (process selection) HOME, END keys is updated. Vertical scroll bar updated. Manual
Keyboard navigation in time graph |With focus on time graph, use LEFT, RIGHT |Previous or next state is selected. Selected
4.4 (state selection) keys time is updated in other views. SWTBot
5 Tool bar handling
The legend dialog is opened and can be
5.1 Show Legend Click Show Legend button closed. Manual
Time range is reset to full range, states are
updated and new time range is propagated to
5.2 Reset Time Scale Click Reset Time Scale button other views. Manual
Previous or next state is selected. Selected
5.3 Select Previous/Next Event Click Previous/Next Event button time is updated in other views. SWTBot
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Selected process is changed in table and timg

Pro tip: "Uncheck selected" and "Uncheck subtree" do the san

see bug 476148. Fixed in this release

5.4 Select Previous/Next Process Click Previous/Next Process button graph. Vertical scroll bar updated. Manual
Time range is zoomed in and out, relative to
center of selection or window. States are
updated and new time range is propagated to
5.5 Zoom In/Out Click Zoom In/Out button other views. Manual
5.6 Filter Dialog Open Filter Dialog Verify that all buttons are working correctly Manual
1) Open Filter Dialog
2) Deselect several processes Verify that only selected processes are
5.7 Filter Processes 3) Press Ok displayed in the view Manual
Verify that arrows are not drawn in the time
5.8 Hide Arrows Click Hide Arrows button graph Manual
Time graph is updated to show the next state
With focus on time graph, click Follow CPU |for this cpu following the arrow, the event is
5.9 Follow CPU Forward Forward button selected in the Events editor. SWTBot
Time graph is updated to show the previous
With focus on time graph, click Follow CPU |state for this cpu following the arrow, the event
5.10 Follow CPU Backward Backward button is selected in the Events editor. SWTBot
5.11 Optimize Click on the optimize button verify that the processes are closer together. Manual
verify that the processes did not move, the
5.12  |Re-Optimize Click on the optimize button a few more timesgoptimization is stable Manual
Select a thread and click on go to next event|Verify in the events table that the selected
5.13 Go to next event of selected threadof selected thread thread is the same as the previous event Manual
Go to previous event of selected |Select a thread and click on go to next event|Verify in the events table that the selected
5.14 |thread of selected thread thread is the same as the previous event Manual
6 Synchronization
Selected time line is updated. If selected time
is outside current range, time range is update:
6.1 Time synchronization Select a random time in another view to include it. Manual
Select a state-impacting event In addition to updating the selected time, the
(sched_switch, syscall, ...) in events table or | process containing the state change is
Resources view using Select Previous/Next |selected and revealed. Vertical scroll bar is
6.2 Event synchronization event. updated if necessary. Manual
Select a new window range in Resources
6.3 Window range synchronization view or in Histogram view. Window range is updated. Manual
Selection is highlighted. If the left time (T1) of
selected time range is outside the current
In any other view that supports selection range, then window range is updated to
6.4 Selection range synchronization [range synchronization, select a new range. |include it Manual
7 Multiple Trace Synchronization

Preparation

1) Download traces.zip (if necessary) and
unzip into a local directory ${local}

2) Import kernel trace ${local}
[traces/import/kernel-overlap-testing

3) Import UST ${local}
Jtraces/import/trace ust-overlap-testing
4) Create experiment with trace of 2) in it
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Open multiple traces that don't overlap in

71 Open multiple traces (no overlap) |time View shows the last opened trace Manual
Change selected time and range Selected time line and time range is updated
7.2 (no overlap) Select a time and new range to selected time and new range. Manual
View is updated to show selected trace.
Selected time line and time range are
Select different trace by clicking its Events |restored to the selected trace's previously
7.3 Select other trace (no overlap) |editor tab selected time and range. Manual
7.4 Open multiple traces (overlap) |Open multiple traces that overlap in time |View shows the last opened trace Manual
Change selected time and range Selected time line and time range is updated
7.5 (overlap) Select a time and new range to selected time and new range. Manual
View is updated to show selected trace.
Select different trace by clicking its Events [Selected time line and time range are set to
7.6 Select other trace (overlap) editor tab the newly selected time and range. Manual
7.7 Close all traces Close all Events editor tabs View is cleared. Manual
8.1 Filtering
Preparation Open 2 LTTng Kernel Traces
1) Open filter dialog
2) Create filter Make sure that only selected processes of
8.1 Apply filter (1st trace) 3) Click on OK filter dialog are shown Manual
1) Switch to 2nd trace (keep 1st open)
2) Open filter dialog
3) Create filter Make sure that only selected processes of
8.2 Apply filter (2nd trace) 4) Click on OK filter dialog are shown Manual
Make sure that previously set filter are still
8.3 Persitent filter Switch between both open traces available Manual
9 Miscellaneous
1) Open LTTng Kernel Trace
2) Select Control Flow View
9.1 Restart (Bug 409345) 3) Restart Eclipse Verify that Control Flow View is populated Manual
1) Open LTTng UST trace while CFV is open|Verify that current window range stays doesn"
9.2 Select single time (Bug 477009) |2) Select event in events table change Manual
1) Open Control Flow view, Resources view
and a kernel trace. Initial window range is
range 1'.
2) Go "right one page" on Control Flow view
by pressing right arrow in scroll bar.
3) Go "left one page" on Resources view by
Window range synchronization pressing left arrow in scroll bar. Verify that after each step the initial window
9.3 (Bug 477012) 4) Go "right one page" on Control Flow view.|range doesn't change Manual
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Target:

Windows 7

Test Case

Verification

Comment

0 Prerequisites
0.1 Import traces Import LTTng Kernel traces in Tracing projec
Create an experiment with LTTng Kernel
0.2 Create experiment traces
1 View management
Open and reset LTTng Kernel Perspective,
1.1 Open perspective and select Resources view Resource view opens. SWTBot Pass
Resource view is populated with traces
(sorted by name) and their resources as tree
children (sorted by resource type then
1.2 Open trace Open LTTng Kernel trace in Project Explorer|numerically) Range is set to initial offset. SWTBot Pass
Resource view is populated with traces
(sorted by name) and their resources as tree
Open experiment with LTTng Kernel traces inchildren (sorted by resource type then Traces are now sorted by name. (maybe the 2 experiments |
1.2 Open experiment Project Explorer numerically) Range is set to initial offset. Manual Pass tested though)
1.3 Close view Close the Resources view View is closed. Manual Pass
Resources view is opened and populated with
1.4 Open view Open the Resources view processes. SWTBot Pass
2 View selection
Resource is highlighted. Selected time line is
Select a resource in the time graph (empty |updated. Other views are synchronized to
2.2 Select resource in time graph region) selected time. Manual Pass
State is highlighted in time graph. Selected
time line is updated. Other views are
2.3 Select state in time graph Select a state in the time graph synchronized to selected time. Manual Pass
3 Mouse handling
Time range is dragged. When mouse button i
Drag move time graph left and right with released, states are updated and new time
3.1 Drag move time range middle button range is propagated to other views. Pass it should be: "new window range is propagated”
Time range is zoomed in and out, relative to
mouse cursor. When mouse wheel is stopped
Zoom with mouse wheel up and down on for a short time, states are updated and new
3.2 Zoom time range (mouse wheel) |header or Ctrl+mousewheel in the time graphtime range is propagated to other views. Manual Pass
Time range is zoomed in and out. When
mouse button is released, states are updated
Drag in time graph scale left and right with lefland new time range is propagated to other
3.3 Zoom time range (mouse drag)  |button views. Manual Pass
Time graph scrolls up and down. Selected
Scroll with mouse wheel up and down, cursorprocess does not change. Vertical scroll bar
3.4 Mouse vertical scroll outside time graph (in name space) updated. Manual Pass
Time graph scroll up and down and remain
3.5 Vertical scroll bar Click and drag vertical scroll bar aligned. Selected process does not change. Manual Pass
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3.6

Drag select time range

Drag select time graph with right button

Selection highlighted. When mouse button is
released, time range is zoomed to selection,
states are updated and new time range is
propagated to other views.

Manual

3.7

Double-click reset time range

Double-click left button on time scale

Time range is reset to full range, states are
updated and new time range is propagated to
other views.

Manual

3.8

Mouse hover (empty region)

Hover mouse in time graph over empty regio

hTool tip shows resource name only.

Manual

3.9

Mouse hover (state)

Hover mouse in time graph over state

Tool tip shows resource name, state name,
date, start time, end time, duration. For IRQ
state, IRQ number is shown. For
IRQ_ACTIVE/SOFT_IRQ_ACTIVE state, CPU
is shown.On usermode and syscall tool tip
shows also shows hover time, tid and process
name.

Manual

When not zoomed enough, tool tip does not show CPU for

IRQ_ACTIVE/SOFT_IRQ_ACTIVE state.

3.10

Drag mouse selection

Drag select time graph with left button

Selection highlighted. Status bar of Eclipse is
updated with time information: T, T1, T2 and
delta, where T is the time of the mouse
position, T1 the first selected time, T2 the
second (dragged) selected time and delta the
time difference between T2-T1 (can be
negative)

Manual

3.1

4.1

Shift key selection
Keyboard handling

Keyboard navigation in time graph
(process selection)

Click select with left button (begin time), pres|
shift key and click select another time (end
time)

With focus on time graph, use UP, DOWN,
HOME, END keys

Selection highlighted. Status bar of Eclipse is
updated with time information: T, T1, T2 and
delta, where T is the time of the mouse
position, T1 the first selected time, T2 the
second (dragged) selected time and delta the
time difference between T2-T1 (can be
negative)

Selected process is changed. Vertical scroll
bar updated.

Manual

Manual

4.2

5.1

Keyboard navigation in time graph
(state selection)

Tool bar handling

Show Legend

With focus on time graph, use LEFT, RIGHT
keys

Click Show Legend button

Previous or next state is selected. Selected
time is updated in other views.

The legend dialog is opened and can be
closed.

Manual

Manual

5.2

Reset Time Scale

Click Reset Time Scale button

Time range is reset to full range, states are
updated and new time range is propagated to
other views.

Manual

5.3

Select Previous/Next Event

Click Previous/Next State button

Previous or next state is selected. Selected
time is updated in other views.

Manual

5.4

Select Previous/Next Process

Click Previous/Next Process button

Selected process is changed in time graph.
Vertical scroll bar updated.

Manual

5.5

Zoom In/Out

Click Zoom In/Out button

Time range is zoomed in and out, relative to
center of selection or window. States are
updated and new time range is propagated to
other views.

Manual

5.6

Filter Dialog
Synchronization

Open Filter Dialog

Verify that all buttons are working correctly
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Selected time line is updated. If selected time
is outside current range, time range is update:

6.1 Time synchronization Select a random time in another view to include it. Manual
Select a new time range in Control Flow view
6.2 Time range synchronization or in Histogram view. Time range is updated. Manual
Selection is highlighted. If begin time (T1) of
Time range selection In any other view that supports range selected time range is outside the current
6.3 synchronisation synchronization, select a new range. range, then time range is updated to include it Manual Status bar of Eclipse is updated only for timegraph views
7 Multiple Trace Synchronization
1) Download traces.zip (if necessary) and
unzip into a local directory ${local}
2) Import kernel trace ${local}
[traces/import/kernel-overlap-testing
3) Import UST ${local}
[traces/import/trace ust-overlap-testing
4) Create experiment with trace of 2) in it
Preparation
Open multiple traces that don't overlap in
71 Open multiple traces (no overlap) |time View shows the last opened trace Manual
Change selected time and range Selected time line and time range is updated
7.2 (no overlap) Select a time and new range to selected time and new range. Manual
View is updated to show selected trace.
Selected time line and time range are
Select different trace by clicking its Events |restored to the selected trace's previously
7.3 Select other trace (no overlap) |editor tab selected time and range. Manual
7.4 Open multiple traces (overlap) |Open multiple traces that overlap in time |View shows the last opened trace Manual
Change selected time and range Selected time line and time range is updated
7.5 (overlap) Select a time and new range to selected time and new range. Manual
View is updated to show selected trace.
Select different trace by clicking its Events [Selected time line and time range are set to
7.6 Select other trace (overlap) editor tab the newly selected time and range. Manual
7.7 Close all traces Close all Events editor tabs View is cleared. Manual
8.1 Filtering
Preparation Open 2 LTTng Kernel Traces
1) Open filter dialog
2) Create filter Make sure that only selected processes of
8.1 Apply filter (1st trace) 3) Click on OK filter dialog are shown Manual
1) Switch to 2nd trace (keep 1st open)
2) Open filter dialog
3) Create filter Make sure that only selected processes of
8.2 Apply filter (2nd trace) 4) Click on OK filter dialog are shown Manual
Make sure that previously set filter are still
8.3 Persistent filter Switch between both open traces available Manual
9 Miscellaneous
1) Open LTTng Kernel Trace
2) Select Resource View
9.1 Restart (Bug 409345) 3) Restart Eclipse Verify that Resources View is populated

47




LTTng 2.0 - Control
View

Target:

Ubuntu 14.04 64 bit

2.1.0-TraceCompassTestCases - LTTng 2.0 - Control

LTTng Tools 2.8.0, Built-in SSH / Local

Test Case

Verification

Comment

0 Prerequisites
For the tests below a Ubuntu machine with LTTng 2.0 installed
(with Ittng tools 2.5.x or later) is required. Make sure that the ropt
session daemon is running (sudo Ittng list -k) and have one UST
process running (e.g. from Ittng-tools git repository under
tests/hello.cxx) LTTng Tracer Control User Guide: http://wiki.eclipse.org/
a) Window — Preferences — General — Network Connections|

0.1 Set Proxy b) Set “Active Provider” to “Direct”

1 General

LTTng Kernel perspective opens with correct Control vie

1.1 Open perspective Open and reset LTTng Kernel Perspective on the left bottom corner SWTBot

2 Manage View

2.1 Close view Close Control View Control view is removed from perspective Manual
Use menu Window — Show View — Other ... — Lttng —

2.2 Open Control view Control Verify that Control view is shown SWTBot

3 Connection Handling

Make sure that after 4) the new connection is shown in th

1) Click Button 'New Connection...! tree. Verify that the new host is shown in the Control vie:
2) Select Tree item "Built-in SSH" and click on Create (with 'Connection Name'. After Ssh connection has been
3) Enter Connection Name (e.g. MyHost), enter Host Name (a |established, make sure that Provider and Session nodes
DNS name or IP address), username and password are created in the Control view underneath the host. Veri
4) Click 'Finish' that all active Providers (Kernel and UST providers) are

3.1 Create Host Connection |5) In Tree select the newly create connection and click on 'Ok’ |shown under the 'Provider' node. Manual
a) Select host to disconnect and click Button 'Disconnect’ Verify that icon for the corresponding node changes to th

3.2 Disconnect b) Redo test with context sensitive menu item 'Disconnect' disconnect icon and all sub-nodes are removed. Manual
Verify that icon for the corresponding node changes to th
connected icon and after successful SSH connection all

a) Select host to connect and click Button ‘Connect’ data is retrieved form the remote host (Providers,
3.3 Connect b) Redo test with context sensitive menu item 'Connect’ sessions etc). Manual
1) Restart Eclipse
2) Click Button 'New Connection..."
3) Select the host previously created Make sure that SSH connection is established and all
4) Select 'Ok'. (Afterwards enter user ID and Password if data is retrieved from the remote host ( (Providers,

3.4 Select Host Connection [necessary) sessions etc). Manual
Verify that menu items are shown and enabled/disabled
depending on state:

'Connect’ (disabled)
Disconnect (enabled)
Node contexts sensitive |1) Connect to remote host Refresh (enabled)

3.5 menu (host connected) |2) select connected node and click right mouse button Delete (disabled) Manual
Verify enable state of view buttons:

‘New Connection...' (enabled)
'Connect’ (disabled)

‘Disconnect’ (enabled)
'‘Refresh’ (enabled)
‘Delete’ (disabled)
'Start’ (disabled)
'Stop' (disabled)
'‘Destroy Session...' (disabled)

View button enable state| 1) Connect to remote host (if necessary) '‘Record Snapshot' (disabled)

3.6 (host connected) 2) select connected node 'Import..." (disabled) Manual
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Node contexts sensitive
menu (host

1) Disconnect from node

Verify that menu items are shown and enabled/disabled
depending on state:

'‘Connect' (enabled)

‘Disconnect' (disabled)

'Refresh’ (disabled)

3.7 disconnected) 2) select disconnnected node and click right mouse button 'Delete’ (enabled) Manual
Verify enable state of view buttons:
‘New Connection...' (enabled)
'Connect' (enabled)
‘Disconnect' (disabled)
'Refresh’ (disabled)
'Delete’ (enabled)
‘Start' (disabled)
'Stop' (disabled)
'Destroy Session..." (disabled)
View button enable state| 1) Disconnect to remote host (if necessary) 'Record Snapshot' (disabled)
3.8 (host connected) 2) select disconnected node if necessary 'Import..." (disabled) Manual
a) Select node to delete (state disconnected) and click on button
‘Delete’
b) Redo test with context sensitive menu item 'Delete’
3.9 Delete Verify that host is removed from the control view. Manual
Create Host Connection |re-do 3.1 but this time specify a port number other than default | The connection should fail (unless remote is configured for
3.10  |with ssh port SSH port 22 the specified port) Manual
4 Session Handling
4.1 Preparation 1) Connect to remote host -
Verify that menu items are shown and enabled: 'Refresh’
Sessions Context ‘Create Session...", Load..." and 'Execute Command
4.2 Sensitive Menu Select 'Sessions' in tree and click right mouse button Script ... Manual
Verify that new session is added under the Session tree
node. Verify properties in Properties view (by selecting
1) Click right mouse button on 'Sessions' the session in the Control view):
2) Select 'Create Session..." in the context sensitive menu 'Session name' (=MySession)
Create Session (default |3) Enter session name 'MySession', keep 'Session Path' empty|'Session Path' (=/home/<user>/traces/MySession_<date
4.3 location) 4) Select 'Ok’ and time>) and 'State' (<INACTIVE) SWTBot
1) Click right mouse button on 'Sessions' Verify that new session is added under the Session tree
2) Select 'Create Session..." in the context sensitive menu node. Verify properties in Properties view (by selecting
3) Enter session name 'MyOtherSession' the session in the Control view):
Create Session (custom |4) enter custom path (/tmp/myTraces) for 'Session Path' 'Session name' (=MyOtherSession)
4.4 location) 5) Select 'Ok’ 'Session Path' (=/tmp/myTraces) and 'State' (SINACTIVE) Manual
Create Session — 1) Click right mouse button on 'Sessions' Make sure that an error message appears in the
session already exists in|2) Select 'Create Session..." in the context sensitive menu message area of the dialog box with information that
4.5 GUI 3) Enter session name 'MySession', keep 'Session Path' empty|session 'MySession' already exists in the tree. Manual
1) login to the remote host using a command shell
2) type Ittng create newSession and press enter. This will create
a session which is not know by the Control view.
3) Click right mouse button on 'Sessions' Verify that an error dialog box will show with information
Create Session — 4) Select 'Create Session..." in the context sensitive menu that command to create a session failed. session already|
session already exists |5) Enter session name 'newSession', keep 'Session Path' emptjexists on the node. Select 'Details": Verify that the
4.6 on node 6) Select 'Ok’ command error detail is shown (with return value (28)) Manual
Verify context sensitive menu items:
'Refresh’ (enabled)
‘Start' (enabled)
'Stop' (disabled)
'Destroy Session...' (enabled)
‘Import..." (enabled)
'Save...' (enabled)
Session Context 'Enable Channel..." (enabled)
Sensitive menu (session ‘Enable Event (default channel)...' (enabled)
4.7 inactive) Select newly created session and click right mouse button 'Record Snapshot' (disabled) Manual
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View button enable state|

Verify enable state of view buttons:
‘New Connection..." (enabled)
'Connect' (disabled)

‘Disconnect’ (disabled)

'Refresh’ (enabled)

‘Delete’ (disabled)

'Start' (enabled)

'Stop' (disabled)

'‘Destroy Session..." (enabled)
‘Import..." (enabled)

4.8 (session inactive) Select newly created session (enable an event before) 'Record Snapshot' (disabled) Manual
a) Enable an event
b) Select session and click on button 'Start' Verify that Session icon changes to 'ACTIVE' icon. Verify
4.9 Start Session c) Redo test with context sensitive menu item 'Start' that property view shows 'ACTIVE' for the session state | SWTBot
Verify context sensitive menu items:
'‘Refresh’ (enabled)
'Start’ (disabled)
'Stop' (enabled)
‘Destroy Session...' (disabled)
Session Context ‘Import..." (disabled)
Sensitive menu (session ‘Enable Channel...' (disabled)
4.10 |active) Select started session and click right mouse button ‘Enable Event (default channel)..." (disabled) Manual
Verify enable state of view buttons:
‘New Connection...' (enabled)
'Connect’ (disabled)
‘Disconnect' (disabled)
‘Refresh’ (enabled)
‘Delete’ (disabled)
'Start’ (disabled)
'Stop' (enabled)
View button enable state| '‘Destroy Session..." (disabled)
4.11 (session active) Select started session 'Import..." (disabled) Manual
1) In the Control view select session 'MyOtherSession'
2) Click right mouse button
3) select 'Destroy Session..." in the context sensitive menu
4.12 Destroy Session 4) Select 'OK' in the confirmation dialog box Verify that session is removed from the control view. SWTBot
Kernel Channel
5 Handling
1) Connect to remote host
5.1 Preparation 2) Create new Session 'MyOtherSession’ -
1) Select session and right mouse click
2) Select menu item 'Enable Channel...!
3) Enter Channel name (e.g. myChannel) and keep default Verify that domain 'Kernel' is created under session and
Enable Channel on values channel is added under the domain. Verify that default
session level (default  |4) Select Kernel values for the channel are displayed in the Properties vief
5.2 values) 5) Click on 'Ok’ after selecting the channel in the tree. Manual
1) Select domain 'Kernel' and right mouse click
2) Select menu item 'Enable Channel...'
Enable Channel on 3) Enter Channel name (e.g. MyOtherChannel) Verify that channel is added under the domain. Verify thal
domain level (changed |4) Change values correct values for the channel are displayed in the
5.3 values) 5) Click on 'Ok’ Properties view after selecting the channel in the tree. Manual
1) Select domain 'Kernel' and right mouse click
2) Select menu item 'Enable Channel'
3) Enter Channel name (e.g. MyOtherChannel) and keep default
Enable Channel — values Verify that error dialog box is opened notifying that
54 channel already exists |4) Click on 'Ok’ channel already exists. Manual
Verify context sensitive menu items:
'Refresh’ (enabled)
'Enable Channel..." (enabled)
Domain Context ‘Enable Event (default channel)...' (enabled)
55 Sensitive menu Select domain 'Kernel' and click right mouse button 'Add Context...” (enabled) Manual
Verify context sensitive menu items:
'Refresh' (enabled)
‘Enable Channel' (disabled)
'‘Disable Channel' (enabled)
Channel Context 'Enable Event (default channel)...' (enabled)
5.6 Sensitive menu Select channel 'MyChannel' and click right mouse button 'Add Context...” (enabled) Manual
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1) Select channel 'MyChannel' and click right mouse button

Verify that channel is disabled (disabled channel icon
shown, state DISABLED shown in Properties view, menu|
item 'Disable' is disabled and menu item 'Enable’ is

Command to change state of events failed
Command failed! Command: Ittng --mi xml enable
Error Output:

Error: Event MyEvent: Enable kernel event failed (
Return Value: 43

<?xml version="1.0" encoding="UTF-8"?>
<command xmins="http:/lttng.org/xml/ns/Ittng-mi"

Command to change state of events failed
Command failed! Command: Ittng --mi xml enable
Error Ouptut:

Error: Event bob: Non-default channel exists withil
Return Value: 83

<?xml version="1.0" encoding="UTF-8"?>

nd><r 1ame><outpu

comr

Note: Disable and Enable menu item is only enabled for
events of the same type, all tracepoints or all sys calls.
For function and dynamic probe the user has to enable
each separately.

Note: Disable and Enable menu item is only enabled for
events of the same type, all tracepoints or all sys calls.
For function and dynamic probe the user has to enable
each separately.

5.7 Disable Channel 2) Select 'Disable’ menu item enabled Manual
Verify that channel is enabled (enabled channel icon
shown, state ENABLED shown in Properties view, menu
1) Select channel 'MyChannel' and click right mouse button 2) |item 'Disable' is enabled and menu item 'Enable’ is
5.8 Enable Channel Select 'Enable’ menu item disabled Manual
UST Channel
6 Handling
1) Select session and right mouse click
2) Select menu item 'Enable Channel...!
3) Enter Channel name 'MyChannel' Verify that domain 'UST global' is created under session
Enable Channel on 4) Select UST and channel is added under the domain. Verify that defaylt
session level (default  |5) Click on Button 'Default’ values for the channel are displayed in the Properties viefv
6.1 values) 5) Click on 'Ok’ after selecting the channel in the tree. SWTBot
6.2 Enable/Disable Channel |Redo tests 5.7 and 5.8 with UST channel See 5.7/5.8 Manual
7 Kernel Event Handling
1) Select session and click right mouse button
2) Select menu item 'Enable Events (default channel)...' Verify that default channel (channel0) is create under
3) Select 'Kernel' domain 'Kernel' and that all tracepoint events are added
4) Select Radio button for "Tracepoint Events' under the channel with state ENABLED. Verify propertieq
Enable Event on session 5) Select top level tree node 'All' view show correct values when selecting a event in the
71 level (all tracepoints) 6) Click on Ok tree (Event Type=TRACEPOINT, State=ENABLED) SWTBot
1) Select domain Kernel and click right mouse button Verify that event with name syscalls is added under the
2) Select menu item 'Enable Events (default channel)...! default channel (channel0) with state ENABLED. Verify
3) Select 'Kernel' properties view show correct values when selecting a
Enable Event on domain|4) Select Radio button for 'All Syscalls' event in the tree (Event Type=SYSCALL,
7.2 level (syscalls) 5) Click on Ok State=ENABLED) SWTBot
1) Select a channel (e.g. channel0) and click right mouse buttol
2) Select menu item 'Enable Events...'
3) Select Radio button for 'Dynamic Probe’ Verify that event with name 'MyEvent' is added under the|
4) Enter Event Name 'MyEvent' and Probe (e.g. 0xc0101280, |respective channel with state ENABLED. Verify
Enable Event on see file /boot/System.map<kernel version>, valid symbols have| properties view show correct values when selecting a
Channel level (Dynamic |T or t as type, | used 'backtrace_stack' for example) event in the tree (Event Type=Probe, State=ENABLED,
7.3 Probe) 5) Click on Ok Address=0xc0101280, Event Name=MyEvent) Manual
1) Select a channel (e.g. channel0) and click right mouse butto
2) Select menu item 'Enable Events...'
3) Select Radio button for 'Dynamic Function Entry/Return Verify that event with name 'MyOtherEvent' is added under
Probe' the respective channel with state ENABLED. Verify
4) Enter Event Name 'MyOtherEvent' and Probe (e.g. properties view show correct values when selecting a
Enable Event on create_dev, see file /proc/kallsyms or /boot/System.map<kerne|event in the tree (Event Type=Function, State=ENABLED,
Channel level (Dynamic |version>) Symbol=create_dev, Offset=0x0, Event
7.4 Function Probe) 5) Click on Ok Name=MyOtherEvent) Manual
Verify that all selected events are disabled (disabled
1) Select multiple events (tracepoint events) under a channel (rjevent icon is shown, state DISABLED is shown in
syscalls) and click right mouse button Properties view, menu item 'Disable’ is disabled and
75 Disable Event 2) Select 'Disable' menu item menu item 'Enable’ is enabled Manual
Verify that selected events are enabled (enabled event
icon is shown, state ENABLED is shown in Properties
Enable Event (tracepoint| 1) Select multiple disabled events and click right mouse button |view, menu item 'Disable’ is enabled and menu item
7.6 events) 2) Select 'Enable’ menu item ‘Enable’ is disabled Manual
Verify that selected events are enabled (enabled event
1) Select a probe event (function or dynamic probe) disabled |icon is shown, state ENABLED is shown in Properties
Enable Event (probe events and click right mouse button view, menu item 'Disable’ is enabled and menu item
7.7 events) 2) Select 'Enable' menu item 'Enable' is disabled Manual
1) Create Session
2) Select session, right-mouse click and select 'Enable Events
(default channel)'
Enable Tracepoint Event 3) Enter a filter (e.g. sched) for the tracepoint tree and then
using filter in tree (Bug |select All Verify that only the selected tracepoints (filtered) are
7.8 450526) 4) Click on Ok enabled and not all kernel tracepoionts Manual
8 UST Event Handling
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Select session and click right mouse button

Select menu item 'Enable Events (default channel)...'
Select 'UST'

Select Radio button for 'Tracepoint Events'

Select top level tree node 'All'

Verify that default channel (channel0) is create under
domain 'UST global' and that a wildcard event “*” is creatf
under the channel with state ENABLED. Verify properties
view show correct values when selecting a event in the

8.1 level (all tracepoints) Click on Ok tree (Event Type=TRACEPOINT, State=ENABLED) Manual
Select domain 'UST global' and click right mouse button Verify that event with wildcarded name (e.g ust*) is adde
Select menu item 'Enable Events (default channel)...' under the default channel (channel0) with state ENABLE
Select Radio button for 'Wildcard' Verify properties view show correct values when selecting
Enable Event on domain|4) Enter a wildcard (e.g. ust*) a event in the tree (Event Type=TRACEPOINT,
8.2 level (wildcards) Click on Ok State=ENABLED) Manual
1) Select a channel (create if necessary) and click right mouse
button
2) Select menu item 'Enable Events...' Verify that event with name 'MyEvent' is added under the|
3) Select Radio button for 'Log Level' respective channel with state ENABLED. Verify
4) Enter Event Name 'MyEvent' properties view show correct values when selecting a Note: In LTTng backend v2.4 and later provide
5) Select log level TRACE_ERR event in the tree (Event Type=TRACEPOINT, information if a loglevel is for a range (e.g. <=
Enable Event on 6) Select radio button for loglevel State=ENABLED, Log Level=<=TRACE_ERR, Event TRACE_ERR) This will be displayed by the properties
8.3 Channel level (log level) |7) Click on Ok Name=MyEvent) SWTBot view now
1) Select a channel (create if necessary) and click right mouse
button Verify that event with name 'MyOtherEvent' is added under
2) Select menu item 'Enable Events...' the respective channel with state ENABLED. Verify
3) Select Radio button for 'Log Level' properties view show correct values when selecting a
4) Enter Event Name 'MyOtherEvent' event in the tree (Event Type=TRACEPOINT, Note: In LTTng backend v2.4 and later provide
Enable Event on 5) Select log level TRACE_INFO State=ENABLED, Log Level= ==TRACE_INFO, Event information if a loglevel is for a single level (e.g. ==
Channel level (log level |6) Select radio button for loglevel-olny Name=MyOtherEvent). TRACE_INFO) This will be displayed by the properties
8.4 oly) 7) Click on Ok Manual view now
Enable/Disable Event
8.5 (tracepoint events) Redo tests 7.5 and 7.6 with UST tracepoint events See 7.5/7.6 Manual
Enable/Disable Event DisablingEnabling of loglevel/loglevel_only events causes
8.6 (tracepoint events) Redo tests 7.5 and 7.6 with UST (loglevel/loglevel-only) events|See 7.5/7.6 Manual tracepoints events (see Bug 486658)
1) Create Session
2) Select session, right-mouse click and select 'Enable Events
Enable Tracepoint Event|(default channel)'
using filter in tree (Bug |3) Enter filter for the tracepoint tree and then select All Verify that only the selected trace points (filtered) are
8.7 450526) 4) Click on Ok enabled and not all UST trace poionts Manual
1) Create Session
2) Select session, right-mouse click and select 'Enable Events
(default channel)'
3) Select Tracepoints
4) En_'ef list of names (comma-separated) in text box Verify that events entered in the comma-separated list are added to
8.8 Enable Event by name 5) Click on Ok the tree SWTBot
9 Contexts Handling
1) Select kernel channel and click right mouse button
2) Select menu item 'Add Contexts..."
3) Expand tree and select some contexts (e.g prio, procname, |Verify that command is successful (no error).
pid) NOTE: There is no way to retrieve added contexts from
9.1 Add Context (to channel]4) Click on 'Ok’ the trace. Therefore GUI cannot display this information. | Manual
1) Select UST channel and click right mouse button Verify that command is successful (no error).
2) Select menu item 'Add Contexts..." NOTE 1: There is no way to retrieve added contexts from|
3) Expand tree and select contexts procname, pthread_id, vpid|the trace. Therefore GUI cannot display this information.
and vtid NOTE2: For UST only contexts procname, pthread_id,
9.2 Add Context (to channel}]4) Click on 'Ok’ vpid and vtid are supported Manual Will be fixed with https:/bugs.eclipse.org/bugs/show_bug.cgi?id=491933
1) Select 1 Kernel tracepoint event and click right mouse buttor]
2) Select menu item 'Add Contexts..."
3) Expand tree and select some contexts (e.g prio, procname,
pid)
4) Click on 'Ok’ Verify that command is successful (no error).
Note: only when using LTTng Tools 2.0.x - 2.1.x. For v2.2 or lat®OTE: There is no way to retrieve added contexts from Per event adding of context is not supported by LTTng
9.3 Add Context (to event) |this menu item has to be disabled the trace. Therefore GUI cannot display this information. | Manual N/A  |Tools anymore (starting from LTTng 2.2)
Enable Events (from
10 Provider)
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1) Create a new session

2) Select multiple Kernel Tracepoint events under Providers —
Kernel

3) click right mouse button

4) select menu item 'Enable Event...'

5) Select newly created session
6)

Verify that domain 'Kernel' is created under the new
session. Verify that default channel 'channel0' is created
under the domain. Verify that selected events are added

10.1 Enable Kernel Events Select 'OK' under the channel and are ENABLED. Manual
1) Make sure that UST application is running on remote host
(see step 0)
2) Create a new session
3) Create a channel under domain 'UST global'
4) Select multiple UST Tracepoint events under Providers ->
<UST Process>
5) click right mouse button
6) select menu item 'Enable Event..."
7) Select newly created session
8) Select newly created channel Verify that selected events are added under the selected
10.2 Enable UST Events 9) Select 'Ok’ channel and are ENABLED. Manual
1 Importing to Project
1) Create new session
2) Enable all Kernel Tracepoint events
3) Enable all Kernel sycalls
4) Enable all UST events
5) Start Tracing
6) Stop Tracing after a few seconds
11.1 Preparation 7) Create new Tracing Project
After 2 verify that all traces are selected by default and
also that the tracing project with name 'Remote’ is
selected.
Verify that during import a progress dialog is opened to
show the progress of the import operation.
Verify that traces are imported to the project wiith name
Remote and its Traces folder. Verify that for the kernel
trace the trace type "LTTng Kernel Trace" is set and for
the UST traces the trace type "LTTng UST Trace" is set.
1) Select session from 11.1 and click right mouse button Create Experiment, select all traces and open
2) Select 'Import..." Experiment. Make sure that all view are populated
11.2  |Import to project 3) Select Ok correctly in the LTTng Kernel Perspective. Manual
1) Repeat step 1 — 3 of test case 11.2
Import to project 2) In dialog box select 'Overwrite' (kernel trace)
(Override) 3) In dialog box select 'Overwrite' (UST trace, re-do if more thafVerify that traces are imported and existing traces are
11.3 1 UST trace) overwritten Manual
1) Repeat step 1 — 3 of test case 11.2
Import to project 2) In dialog box select 'Overwrite All' Confirmation dialog only shows once. Verify that traces
11.4 (Overwrite All) are imported and existing traces are overwritten Manual
1) Repeat step 1 — 3 of test case 11.2
2) In dialog box select 'Rename’ (kernel trace)
Import to project 3) In dialog box select 'Rename' (UST trace, re-do if more thary
11.5 |(Rename) 1 UST trace) Verify that traces are imported with a different name Manual
1) Repeat step 1 — 3 of test case 11.2
Import to project 2) In dialog box select 'Rename All' Confirmation dialog only shows once. Verify that all traces
11.6  |(Rename All) are imported with a different name Manual
1) Repeat step 1 — 3 of test case 11.2
2) In dialog box select 'Skip' (kernel trace)
3) In dialog box select 'Skip' (UST trace, re-do if more than 1
11.7  |Import to project (Skip) |UST trace) Verify that each skipped trace is not imported Manual
1) Repeat step 1 — 3 of test case 11.2
Import to project (Skip  [2) In dialog box select 'Skip All' Confirmation dialog only shows once. Verify that all traces
11.8  |All) are skipped Manual
12 Refresh
Press refresh button and context sensitive menu item for
12.1 Refresh different selections Verify that the Control View is refreshed. Manual
13 Calibration
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4)-Create-new-sessien
2)-Enable-altKernel Fracepoint-events
3)-Enable-altKernel-sycalls
4)Enable-al-USTevents
143+ |Preparation -
-
» Start Fracing , . e n
23) S; eot Doma Ee; et-and-eliek-right mouse-butto
4)Rede-step-2-3-with-demain~USTglebal' Verify-that-Calibrat ted-witheut-error: Calibrate was removed since not fully implemented in
134 |Calibrate- 5)-Stop-tracing See-also-calibrat low-fora-Use-Gaseoff M | N/A  [LTTng runtime
Event Filtering (LTTng
14 2.1)
For the tests below a Ubuntu machine with LTTng 2.1 installed
(with Ittng tools 2.1.x) is required. Either create a VM machine
yourself (e.g. on Virtualbox) or install it locally on your native
Ubuntu (if correct version). Make sure that the root session
daemon is running (sudo Ittng list -k) and have one UST process
14.1 running (e.g. from Ittng-tools git repository under tests/hello.cxx|
1) Connect to remote host
14.2 Preparation 2) Create new Session 'FilterSession'
Verify that default channel (channel0) is create under
1) Select session and click right mouse button domain 'UST global' and that the corresponding event is
2) Select menu item 'Enable Events (default channel)...' created under the channel with state ENABLED.
3) Select 'UST'
4) Select Radio button for 'Tracepoint Events' Verify that Properties view shows correct values for this
5) Select one tracepoint event (Event Type=TRACEPOINT, State=ENABLED,
Enable UST Eventon  |6) Enter filter expression on a event field Filter=with filter, Filter=the actual expression in LTTng 2.
14.3 |session level 7) Click on 'Ok’ +) Manual
1) Execute 14.3
2) Select one UST Tracepoint event under Providers -> <UST | Verify that selected event is added under the selected
Process> channel.
3) click right mouse button
4) select menu item 'Enable Event..." Verify that Properties view shows correct values for this
5) Select newly create session and channel event (Event Type=TRACEPOINT, State=ENABLED,
Enable UST Event from |6) Enter filter expression on a event field Filter=with filter, Filter=the actual expression in LTTng 2.
14.4 provider 7) Click on 'Ok’ +) Manual
1) Start Tracing
2) Stop Tracing after a view seconds
3) Import Trace to Project
4) Open Trace Make sure that only events are shown in the events table|
14.5 |Create trace 5) Destroy Session that met the condition in the filter expressions Manual
Create Session With
Advanced Options
15 LTTng v2.1)
For the tests below a Ubuntu machine with LTTng 2.1 installed
(with Ittng tools 2.1.x) is required. Either create a VM machine
yourself (e.g. on Virtualbox) or install it locally on your native
Ubuntu (if correct version). Make sure that the root session
daemon is running (sudo Ittng list -k) and have one UST process
15.1 running (e.g. from Ittng-tools git repository under tests/hello.cxx|
After 2) verify that advanced options are shown (e.g.
Trace Path, Protocol, Address and Port)
1) Open Create Session Dialog box After 3) verify that advanced option are not shown and or|
Create Session Dialog - |2) Select "Advanced >>>" basic options are there (Session Name and Session
15.2  |Advanced Button 3) Select "<<< Basic" Path) Manual
After 2) verify that data Protocol and data Address is
enabled. Note that the ports cannot be configured for net
1) Open Create Session Dialog box and select "Advanced >>>'and net6 when this button is unchecked. -> port text field
Create Session Dialog - (2) Uncheck checkbox"Use same protocol and address for data|are disabled
Check box "Use same |and control"
protocol and address for|3) Check checkbox "Use same protocol and address for data |After 3) Verify that data Protocol and data Address are
15.3 |data and control" and control" disabled Manual
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Create Session Dialog -

1) Open Create Session Dialog box and select "Advanced >>>

Verify that the Control protocol dropdown menu shows ng

15.4  |Protocol list net6 and file Manual
1) Open Create Session Dialog box and select "Advanced >>>
2) Uncheck checkbox "Use same protocol and address for datd
Create Session Dialog - |and control" After 2) verify that the data protocol dropdown menu
15.5 Protocol list 2 shows net, net6, tcp and tcp6 Manual
After 2) verify that net6 is propagated to the data protocol
and and that the data and control port text fields are
1) Open Create Session Dialog box, select "Advanced >>>"  |enabled
Create Session Dialog - |2) Select net6 for Control Protocol After 3) verify that file is propagated to the data protocol
15.6  |Protocol propagation 3) Select file for Control Protocol and that the data and control port text fields are disabled| Manual
Create Session Dialog - | 1) Open Create Session Dialog box, select "Advanced >>>" | After 2) verify that the IP address is propagated to the
15.7  |Address propagation 2) Enter IP address in Control address data address field Manual
1) Open Create Session Dialog box and select "Advanced >>>
2) Uncheck checkbox "Use same protocol and address for datd
and control"
3) Select tcp for control protocol and tcp6 for data protocol
4) Check checkbox "Use same protocol and address for data
Create Session Dialog - |and control" After 4) make sure that both data and control protocol
15.8 Protocol propagation 2 show net Manual
Verify that the traces are stored on the remote host unde
/tmpltestTraces/kernel and
/tmpltestTraces/ust/<application(s)> repectively.
1) Open Create Session Dialog box and select "Advanced >>>
2) Enter session name, select file protocol and enter directory |After 2) make sure that the Session Path in the Property
JtmpltestTraces/ in address field and press ok View shows the URL with the configured parameters
3) Enable events, start tracing, wait for a few seconds, stop
tracing Verify that the remote import dialog box opens at step 4
Create trace with file 4) Import traces to a existing tracing project (as described in test cases 11.x) and it is possible to
15.9 |protocol 5) Destroy session transfer the traces to the tracing project. Manual
Verify that the traces are stored on the remote host unde
/tmpl/testTraces/newPath/kernel and
1) Open Create Session Dialog box and select "Advanced >>>'|/tmp/testTraces/newPath/ust/<application(s)> repectively
2) Enter session name, select file protocol and enter directory
Jtmp/tmpTraces/ in address field, enter /newPath in "Trace PattyAfter 3) make sure that the Session Path in the Property
text field and press ok View shows the URL with the configured parameters
3) Enable events, start tracing, wait for a few seconds, stop
tracing Verify that the remote import dialog box opens at step 4
Create trace with file 4) Import traces to a existing tracing project (as described in test cases 11.x) and it is possible to
15.10 |protocol and trace path |5) Destroy session transfer the traces to the tracing project. Manual
Verify that the traces are stored on the Eclipse local
machine under /home/<user name>/Ittng-traces/<remote
machine name>/<session name + date>/kernel and
/home/<user name>/lttng-traces/<remote machine
name>/<session name + date>/ust/<application(s)>
repectively.
1) Start relayd on Eclipse local machine (default settings: Ittng-
relayd) After 3) make sure that the Session Path in the Property
2) Open Create Session Dialog box and select "Advanced >>>'View shows the URL with the configured parameters
3) Enter session name, select net protocol and enter IP addres$
of Eclipse local machine in address field and press ok After 5) Verify that dialog box for selecting a tracing
4) Enable events, start tracing, wait for a few seconds, stop project is openend that after selecting a project and
tracing pressing next the default trace import wizard opens. Ther
Create trace with net 5) Import traces to a existing tracing project verify that it is possible to transfer the traces to the tracin
15.11 |protocol 6) Destroy session project. Manual
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Create trace with tcp

1) Uncheck checkbox "Use same protocol and address for datg
and control"

2 ) Start relayd on Eclipse local machine with specified ports
(Ittng-relayd -C tcp://0.0.0.0:1234 -D tcp://0.0.0.0:5678)

3) Open Create Session Dialog box and select "Advanced >>>'
4) Enter session name, select tcp protocol and enter IP address
of Eclipse local machine in address field, specify data and
control ports and press ok

5) Enable events, start tracing, wait for a few seconds, stop
tracing

6) Import traces to a existing tracing project

Verify that the traces are stored on the Eclipse local
machine under /home/<user name>/Ittng-traces/<remote
machine name>/<session name + date>/kernel and
/home/<user name>/lttng-traces/<remote machine
name>/<session name + date>/ust/<application(s)>
repectively.

After 4) make sure that the Session Path in the Property
sView shows the URL with the configured parameters

After 6) Verify that dialog box for selecting a tracing
project is openend that after selecting a project and
pressing next the default trace import wizard opens. Ther
verify that it is possible to transfer the traces to the tracin

15.12 |protocol and port 7) Destroy session project. Manual
1) Start relayd on Eclipse local machine (default settings: Ittng-
relayd)
2) Select Live Mode
3) Open Create Session Dialog box and select "Advanced >>>
4) Enter session name, select net protocol and enter IP address
of Eclipse local machine in address field, keep defaults for Live
Connection and Live Delay, and press ok
5) Enable UST events (per UID channel), start tracing, wait for gV/erify that session is created successfully. Verify that after
Live Streaming Session |few seconds, stop tracing 6) the trace appears in the Traces directory of Remoter
(UST) - Initial 6) Import traces to a existing tracing project project. Verify that relevants views are updated when ne:
15.13 |implementation 7) Destroy session data arrives Manual N/A ion disabled for 2.0
1) Start relayd on Eclipse local machine (default settings: Ittng-
relayd)
2) Select Live Mode
3) Open Create Session Dialog box and select "Advanced >>>
4) Enter session name, select net protocol and enter IP addres$
of Eclipse local machine in address field, keep defaults for Live
Connection and Live Delay, and press ok
5) Enable Kernel events, start tracing, wait for a few seconds, |Verify that session is created successfully. Verify that after
Live Streaming Session |stop tracing 6) the trace appears in the Traces directory of Remoter
(Kernel) - Inititial 6) Import traces to a existing tracing project project. Verify that relevants views are updated when ne:
15.14  |Implementation 7) Destroy session data arrives Manual N/A tation disabled for 2.0
16 Preferences
Verify that tracer control preferences exists and shows
Open Preferences (Menu -> Preferences -> Tracing -> LTTng |Tracing Group, Logging, Log File (always disabled),

16.1 Open Preference Dialog | Tracer Control Preferences) Append, Verbose Level (None, Level 1, Level2 Level 3) | Manual

16.2 Enable Logging In Tracer Control Prferences, check checkbox Logging Verbose Level radio buttons will be enabled Manual

16.3  |Disable Logging In Tracer Control Prferences, uncheck checkbox Logging Verbose Level radio buttons will be disabled Manual

Execute 16.2 and execute some commands (e.g. create Make sure that log file is created and contains the
16.4  |Test Logging level none |session, enable event) executed commands and command replies Manual
1) Execute 16.2 Make sure that log file contains the executed commands
Test Verbose Logging |2) select verbose level Level 1 with -v option (e.g. Ittng -v create session) and the
16.5 |(Level 1) 3) Execute some commands (e.g. create session, enable evenficommand replies come with debug information Manual This makes no difference for Ml starting with Lttng 2.6
1) Execute 16.2 Make sure that log file contains the executed commands
Test Verbose Logging |2) select verbose level Level 2 with -vv option (e.g. Ittng -vv create session) and the
16.6 (Level 2) 3) Execute some commands (e.g. create session, enable evenficommand replies come with debug information Manual This makes no difference for M starting with Lttng 2.6
1) Execute 16.2 Make sure that log file contains the executed commands
Test Verbose Logging |2) select verbose level Level 3 with -vvv option (e.g. Ittng -vvv create session) and the

16.7 (Level 3) 3) Execute some commands (e.g. create session, enable evenficommand replies come with debug information Manual This makes no difference for M starting with Lttng 2.6

Verify that tracer control preferences are persisted and
Check checkbox Append, restart Eclipse and open Tracer the log file is opened in append mode (old file is not
16.8  |Append Mode Control Preferences overwritten) Manual
Verify that Ittng command is executed with command line|
Change Tracing group (e.g. tracing2) and execute a command |option -g <group>. Ignore any command reply errors (if
16.9 |Change Tracing Group |(while logging enabled) any) Manual
Change execution After verify that values smaller than 5 and bigger than 60!

16.10 |timeout Go to Remote Connection Preferences, Change Timeout are rejected Manual
Verify: Group=tracing, Logging is deselected, Append is
deselected, Verbose Level=None), and Command Timout

16.11  |Reset Reset to defaults is 15 Manual
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Command is successful. However tracer doesn't create
metadata channel. Bug in LTTng http://bugs.lttng.
org/issues/994

advance features
17 (LTTng 2.2 features)
For the tests below a Ubuntu machine with LTTng 2.2 installed
(with Ittng tools 2.2.x) is required. Either create a VM machine
yourself (e.g. on Virtualbox) or install it locally on your native
Ubuntu (if correct version). Make sure that the root session
daemon is running (sudo Ittng list -k) and have one UST process
17.1 running (e.g. from Ittng-tools git repository under tests/hello.cxx)).
1) Create and select session and click right mouse button
2) Select menu item 'Enable Channel...! Verify after 3) that 'Channel Name' is set to metadata and
3) Select Checkbox 'Configure metadata channel' the correspondig textbox is disabled. Verify after 5) that
4) Update all text boxes metadata channel was created under the kernel domain.
Configure Metadata 5) Click on 'Ok’ Also verify in the properties view that all parameters are
17.2  |channel (kernel) set correctly when selecting the channel metadata. Manual
Verify after 3) that 'Channel Name' is set to metadata and
the correspondig textbox is disabled. Verify after 5) that
metadata channel was created under the domain UST
global. Also verify in the properties view that all
Configure Metadata parameters are set correctly when selecting the channel
17.3  [channel (UST) 1) Re-do 17.2 with a UST channel metadata. Manual
1) Create and select session and click right mouse button
2) Select menu item 'Enable Channel...!
3) Fill in channel name
4) Fill in 1048576 in 'Maximum size of trace files' and also 'Sub
Buffer Size'
5) Fill in 2 in 'Maximum number of trace files'
6) Click on 'Ok’
Configure File rotation |7) Enable all kernel events After 8) verify on the trace node that trace files are not
17.4 (kernel) 8) Start, wait and stop tracing. bigger than 1048576 bytes Manual
1) Create and select session and click right mouse button
2) Select menu item 'Enable Channel...!
3) Fill in channel name
4) Select UST
5) Fill in 262144 in 'Maximum size of trace files' and also 'Sub
Buffer Size'
6) Fill in 2 in 'Maximum number of trace filesfiles'
7) Click on 'Ok’
Configure File rotation |8) Enable all UST events After 9) verify on the trace node that trace files are not
17.5  |(ust) 9) Start, wait and stop tracing. bigger than 262144 bytes Manual
1) Create and select session and click right mouse button
2) Select menu item 'Enable Channel...! Verify after 2 and 4 that the radio buttons for the buffer
3) Select UST type is disabled and the buffer type "Global shared
4) Select Kernel buffers" is selected which is the value for the kernel tracer.
Buffer Type - toggle 5) Slect cancel Verify after 3) that the radio buttons are enabled an no
17.6 UST/kernel buffer type is selected Manual
1) Create and select session and click right mouse button
2) Select menu item 'Enable Channel...!
3) Select UST Verify after 5) that the default buffer type is configured fo
4) Enter Channel Name that channel (see properties view). Note for LTTng Tools
5) Select 'Ok’ 2.2 the default is per-PID and for LTTng Tools 2.3 and
17.7  |Default UST Buffer Type later it is per-UID Manual
Prequisite: Multiple UST Applications need to run
1) Create and select session and click right mouse button
2) Select menu item 'Enable Channel...!
3) Select UST
4) Select 'Per PID buffers'
5) Enter Channel Name
6) Select 'Ok’
8) Enable all ust events Verify after 6) that the per-pid buffer type is configured fol
9) Start, wait and stop tracing. that channel (see properties view). After 10) make sure
17.8 per PID UST Buffer Typg 10) Import trace that for each UST application one trace is created Manual
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Prequisite: Multiple UST Applications need to run

1) Create and select session and click right mouse button
2) Select menu item 'Enable Channel...!

3) Select UST

4) Select 'Per UID buffers'

5) Enter Channel Name
6)
8)
9)
10

Enable all ust events
Start, wait and stop tracing.

Verify after 6) that the per-pid buffer type is configured fo
that channel (see properties view). After 10) make sure
that only one trace is created even multiple UST

While doing this | found a few bugs but it ended up working. See
https://bugs.eclipse.org/bugs/show_bug.cgi?id=469425 and https:
//bugs.eclipse. 1ow_bug.cgi?id=: 24

17.9 per UID UST Buffer Typg10) Import trace applications are running. Manual
Snapshot Channel
18 (LTTng 2.3 features)
Preparation Connect to a node with LTTng 2.3 installed
Verify that new session is added under the Session tree
node. Verify properties in Properties view (by selecting
the session in the Control view):
'Session name' (=MySession)
'Snaphshot ID' (=1)
'Snapshot Name' (=snapshot-1)
1) Click right mouse button on 'Sessions' 'Session Path' (=/home/<user>/traces/MySession_<date
2) Select 'Create Session..." in the context sensitive menu and time>) and 'State' (<INACTIVE)
3) Enter session name 'MySession', keep 'Session Path' empty|
Create Snapshot 4) Select checkbox 'Snapshot Mode' Make sure that the button and menu item 'Record
18.1 Session 5) Select 'Ok’ Snapshot' is enabled Manual
18.2  |Enable Kernel Event Enable all Kernel Tracepoint and syscall events Verify that channel and events a successful enabled Manual
Verify that Session icon changes to 'ACTIVE' icon. Verify|
that property view shows 'ACTIVE' for the session state
Make sure that the button and menu item 'Record
a) Select session and click on button 'Start' Snapshot' is enabled. Also make sure that the Button and
18.3  |Start Session b) Redo test with context sensitive menu item 'Start' menu item 'Import’ is enabled. Manual
select session and record 2 snapshots: Once with button
‘Record Snapshot' and once with context-sensitive menu item
18.4 Record snapshot 'Record Snapshot' Commands succeed without error Manual
Create another snapshof
18.5 |[session session name ustSession (as described in 18.1) Make sure that snapshot session is created successfully | Manual
18.6 Enable UST Events Enable all UST events Verify that channel and events a successful enabled Manual
18.7  [Start UST session see 18.3 see 18.3 Manual
Record snapshot over |Select kernel and ust session (see 18.1 and 18.5) and click on
18.8 multiple sessions 'Record snapshot' button Command succeeds without error Manual
Verify that 4 snapshots are available (3 kernel and 1
UST). Verify that all snapshots are imported to the
18.9 Import traces Open Import dialog (see 11.2) selected tracing project Manual
Stop and destroy
18.10 |sessions Stop and destroy both sessions Verify that sessions are destroy successfully Manual
1) Start relayd on Eclipse local machine (default settings: Ittng-
relayd)
2) Open Create Session Dialog box, select 'Snapshot Mode'an:
select "Advanced >>>"
3) Enter session name, select net protocol and enter IP addres;
of Eclipse local machine in address field and press ok
4) Enable events (UST and Kernel), start tracing, and record a
few snapshots, stop tracing Make sure that all steps were successfull. Also, import the
Network snapshot 5) Import traces to a existing tracing project traces using the standard import instead of the remote
18.11 |session 6) Destroy session import Manual
Record snapshot when
18.12 |[session is inactive
19 Command Script
Create a command script to create a session with kernel and u{Make sure that each command of script is executed and
19.1 Execute command sript |events enabled. script execution is without errors Manual
20 Session Profiles
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1) Create Tracing session

2) Select session and click right mouse button
3) Select Menu item "Save..."
4)

Make sure that the session is saved under ~/.
Ittng/sessions on the remote

Make sure that session is availabe in the workspace by
opening Window->Preferences -> Tracing -> LTTng

20.1 Save session Select 'OK' Remote Profiles SWTBot
Make sure that the session is saved under ~/.
Ittng/sessions.
Make sure that session is availabe the user is prompted
20.2 |Save session (2) 1) Re-do 20.1 (use same session name) to skip or overwrite the profile in the workspace Manual
1) Re-do 20.1
20.3  |Save session (no force) | but deselect force button The save command will be rejected by LTTng Tools Manual
destroy all sessions
1) Select group "Sessions" and click right mouse button
2) Select Menu item "Load..."
3) Select a existing profile (from Local)
4) Select 'OK'
20.4 Load Session (local) Make sure that the session is created SWTBot
destroy all sessions
1) Select group "Sessions" and click right mouse button
2) Select Menu item "Load..."
3) Select "Remote”
4) Select a existing profile (from Remote)
5) Select 'OK'
20.5 |Load Session (remote) Make sure that the session is created Manual
1) Select group "Sessions" and click right mouse button
2) Select Menu item "Load..."
3) Select "Manage..." Make sure that the LTTng Remote Profile preference
20.6 Open preference (1) page opens Manual
Open Preferences (Menu -> Preferences -> Tracing -> LTTng |Make sure that the LTTng Remote Profile preference
20.7 Open preference (2) Remote Profiles page opens Manual
1) Open Preference page (see 20.7)
2) Select multiple profiles
3) Click on "Export..."
20.8 Export profile 3) Select destination directory and click on "OK" Make sure profile is exported to the destination directory | Manual
Make sure that user is prompted about to overwrite or
20.9 Export profile (red) Redo 20.8 skip existing profile Manual
1) Open Preference page (see 20.7)
2) Click on "Import..."
20.10 |Import profile 3) Select a profile on media and click on "OK" Make sure profile is imported and available in workspace| Manual
1) Redo 20.8 Make sure that user is prompted about to overwrite or
20.11  |Import profile (redo) skip existing profile Manual
1) Open Preference page (see 20.7)
2) Select multiple profiles
3) Click on "Delete..." Make sure profile(s) are delete from the workspace and
20.12 |Delete profile 3) Confirm deletion disk Manual
Kernel Event Filtering
21 (LTTng 2.6)
For the tests below a Ubuntu machine with LTTng 2.1 installed
(with Ittng tools 2.6.x) is required. Either create a VM machine
yourself (e.g. on Virtualbox) or install it locally on your native
Ubuntu (if correct version). Make sure that the root session
daemon is running (sudo Ittng list -k) and have one UST process
21.1 running (e.g. from Ittng-tools git repository under tests/hello.cxx|
1) Connect to remote host
21.2 Preparation 2) Create new Session 'FilterSession'
Verify that default channel (channel0) is create under
1) Select session and click right mouse button domain 'Kernel' and that the corresponding event is
2) Select menu item 'Enable Events (default channel)...' created under the channel with state ENABLED.
3) Select 'Kernel'
4) Select Radio button for ‘Tracepoint Events' Verify that Properties view shows correct values for this
5) Select one tracepoint event (Event Type=TRACEPOINT, State=ENABLED,
Enable Kernel Event on |6) Enter filter expression on a event field Filter=with filter, Filter=the actual expression in LTTng 2.
21.3 |session level 7) Click on 'Ok’ +) SwtBot
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Enable Kernel Event

Execute 14.3

Select one Kernel Tracepoint event under Provider "Kernel"
click right mouse button

select menu item 'Enable Event..."

Select newly create session and channel

Enter filter expression on a event field

Verify that selected event is added under the selected
channel.

Verify that Properties view shows correct values for this
event (Event Type=TRACEPOINT, State=ENABLED,
Filter=with filter, Filter=the actual expression in LTTng 2.

1)
2)
3)
4)
5)
6)
7)
1)
2)
3)
4)
5)

21.4  |from provider Click on 'Ok’ +) SwtBot
Start Tracing
Stop Tracing after a view seconds
Import Trace to Project
Open Trace Make sure that only events are shown in the events table|
21.5 |Create trace Destroy Session that met the condition in the filter expressions Manual
LTTng UST Exclude
22 events (LTTng 2.5)
For the tests below a Ubuntu machine with Ittng tools 2.5.x is
required. Either create a VM machine yourself (e.g. on
Virtualbox) or install it locally on your native Ubuntu (if correct
version). Make sure that the root session daemon is running
(sudo lttng list -k) and have one UST process running (e.g. fron|
22.1 Ittng-tools git repository under tests/hello.cxx)
1) Connect to remote host
22.2 Preparation 2) Create new Session 'FilterSession'
Verify that event is added under the UST Domain and
1) Open Enable Event Dialog, select UST relevant channel.
2) Use wildcards Verify that the Properties view shows the exclusion:
Enable events with 3) Enter a event name to exclude Exclusion=with Exclusion, for Exclusion the actual
22.3  |exclude expression in LTTng 2.8+ SWTBot
LTTng UST per
23 syscall (LTTng 2.6)
For the tests below a Ubuntu machine with Ittng tools 2.6.x is
required. Either create a VM machine yourself (e.g. on
Virtualbox) or install it locally on your native Ubuntu (if correct
version). Make sure that the root session daemon is running
(sudo lttng list -k) and have one UST process running (e.g. fron|
23.1 Ittng-tools git repository under tests/hello.cxx)
1) Connect to remote host
23.2 Preparation 2) Create new Session 'MySession'
1) Open Enable Event Dialog, select Kernel
2) Select syscalls Verify that the selectetd syscalls are added added under
3) In the tree, select selected syscalls the Kernel Domain and relevant channel.
23.3  |Enable selected syscalls|4) Select Ok SWTBot
destroy session
1) Open Enable Event Dialog, select Kernel
2) Select Syscalls
3) In the tree, select all syscalls Verify that the selectetd syscalls are added added under
4) Select Ok the Kernel Domain and relevant channel.
23.4 Enable all syscalls SWTBot
JUL, Log4J, Python
24 Logger
Configure JUL tracing  |Configure JUL tracing session
24.1 session (LTTng 2.6) using tree and event name verify that session is configured correctly SWTBot
Configure Log4J tracing |Configure Log4J tracing session
24.2 |session (LTTng 2.6) using tree and event name verify that session is configured correctly SWTBot
Configure Python tracing Configure Python tracing session
24.3 |session (LTTng 2.7) using tree and event name verify that session is configured correctly SWTBot
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O P pe o Do 0
GDB Tracing 26 0 0 0
Target: |Ubuntu 16.04 64 bit
GDB 7.11.1
Test Case Action Verification Comment
1 Preparation
1.1 Step 1 Open and reset the GDB Trace perspective GDB Trace perspective opens with correct views Manual Pass
1.2 |Step2 Open Navigator View (used for independent verification) Navigator View opens Manual Pass \
2 Project Creation
2.1 New Project Wizard Open New Tracing Project Wizard Tracing Project Wizard opens Manual Pass
2.2 Create project Specify a project name and finish Tracing project appears in Project Explorer Manual Pass
2.3 Project structure Close and open the new Tracing project Project contains the Traces folder Manual Pass \
3 Traces Folder
3.1 Traces Folder menu Select the Traces folder and open its context menu Correct menu opens (Open Trace, Import, New Folder, ...) Manual Pass
3.2 Trace Import Wizard Select Import Trace Trace Import Wizard appears Manual Pass
3.3 Import traces Select a GDB Trace from samples directory and finish Imported traces appear in Folders with propericon Manual Pass |
4 Trace Configuration
Verify that an Error Dialog opens that notfiies the user to select the
4.1 Project/executable selection |Double-click on an un-configured trace trace executable Manual Pass
1) Right mouse click on trace
2) Select menu item "Select Trace Executable"
4.2 Select Trace Executable 3) Fillin the proper values in dialog and finish Trace is configured (4.3 is successful, when 4.2 was successful) Manual Pass
4.3 Open configured trace Double-click on a configured trace Trace is opened, events table and views are populated Manual Pass \
5 Source Code Lookup
The corresponding source code location is selected in the source
5.1 Select event With mouse select an event in events table code file. Manual Pass
The corresponding source code location is selected in the source
5.2 |Select another event redo 5.1 code file. Manual Pass |
6 Events Table Navigation
Each keystroke modifies the selected event and the corresponding
6.1 Arrow keys Update the current event using up/down keys within window |source code location is selected in the source code file. Manual Pass
Table is refreshed to display new current event and the
corresponding source code location is selected in the source code
6.2 Scrolling Update the current event using up/down keys outside windowfile Manual Pass
6.3 PgUp/PgDn Update the current event using PgUp/PgDn keys Table is scrolled accordingly Manual Pass
Table jumps from first to last event and the corresponding source
6.4 Home/End Update the current event using Home/End keys code location is selected in the source code file Manual Pass
\
7 Events Searching & Filtering
7.1 Search In the search bar, enter some RE Events corresponding to the RE are highlighted Manual Pass
7.2 Navigation Navigate through highlighted events using Enter/Shift-Enter |Next/previous highlighted event selected accordingly Manual Pass
7.3 Un-search In the search bar, clear the RE Events are displayed normally Manual Pass
7.4 Filter In the Ffilter bar, enter some RE Only events matching RE are displayed Manual Pass
7.5 Un-filter Ithe filter bar, clear the RE Events are displayed normally Manual Pass
7.6 Filter & Search In the filter bar, enter some RE; likewise in the search bar Events are filtered and highlighted accordingly Manual Pass
7.7 Search & Filter In the search bar, enter some RE; likewise in the filter bar Events are filtered and highlighted accordingly Manual Pass \
8 Events Synchronization
8.1 Synch from Events View Click on an event in the Events View Trace Control View is updated; Debug View is updated Manual Pass
8.2 Synch from Trace Control Go up/down from the Trace Control View Events View is updated accordingly Manual Pass
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Tracing RCP 31 0 0 5
Target: |Ubuntu 16.04 64 bit
Step Test Case Verification Comment
0 Preparation
1. Download maven 3.3 or above
2. Use openJDK 1.8 or above
3. Use the commandmvn clean install -Dmaven.test.skip=true -x to compile the RCP without the tests (-X for the debug info)
4. You might need to use a proxy (adding a settings.xml file in the~/.m2 folder)
5. Once everything is compiled, you can find the version of RCP for your OS int racecompass-master/git/org.eclipse.tracecompass/rcp/org.eclipse.tracecompass.rcp.product/target/products/org.
eclipse.tracecompass.rcp/ folder
1 Start RCP
Bruno : Not with this test case : If | open n traces, the folder "Traces|
[n]" shows the number of traces opened. If i go in the Porperties
view with the folder the title of the Properties view is Traces [n], no
if | delete the n traces the title of the Properties view is still Traces
[n] instead of Traces [0]. Patrick: The Properties view updates itself
when the selection changes.
Bruno : Not with this test case but the delete key doesnt work on
Tracing project (we need to use the mouse right click). Bug 486505
1.1 Start Tracing RCP Open RCP from command line or file explorer Tracing RCP opens in default perspective Manual Pass | ***(the real test case 1.1 passed)***
Start Tracing RCP with text Open RCP from command line with --open <trace name with
1.2 trace absolute path> Trace will be opened with auto-detected trace type Manual Pass
Start Tracing RCP with Open RCP from command line with --open <trace name with |Verify that the same trace that was previously linked into the Traces
1.3 previously opened text trace |absolute path>. Use same trace than 1.2 folder is opened and not a new trace entry is created Manual Pass
) . . . . . - R . The kernel trace opens in an editor but the editor of the first trace
Start Tracing RCP with Kernel {Open RCP from command line with --open <kernel trace Tracing RCP is opened, the trace is linked to the Tracing project, the gets activated. Bug 443461.
1.4 CTF trace name with absolute path> kernel analysis trace type is selected and trace is opened. Manual Bruno : Same bug happens with UST traces
Start Tracing RCP with
previously opened Kernel CTF|Open RCP from command line with --open <kernel trace Verify that the same trace that was previously linked into the Traces
1.5 trace name with absolute path>. Use same trace than 1.4 folder is opened and not a new trace entry is created Manual Pass
Open RCP from command line with --open <trace name with |Verify that a new trace is linked to the Tracing project and trace is
Start Tracing RCP with new  |absolute path>, where the name of trace is the same than 1.2,/opened. Verify that the new trace name has a integer number a
1.6 trace with name conflict but the trace is located at a different location on disk suffix added. Manual Pass
Open RCP from command line with --open <kernel trace with |Verify that a kernel trace is linked to the Tracing project, the kerne
absolute path>, where name of trace is the same than 1.4, butjanalysis trace type is selected and trace is opened. Verify that the
1.7 Re-do 1.6 the trace is located at a different location on disk new trace name has a integer number a suffix added. Manual Pass
Start Tracing RCP with non-
1.8 trace file Open file that is not a trace Trace is imported (linked) however default icon (from Eclipse) is set| Manual Pass  should it open?
2 File menu
Use Menu "File -> Open Trace ..." In the file dialog select a
2.1 Open Trace (File) text trace and select open. Trace will be opened with auto-detected trace type Manual Pass
Open Trace (File) with Use Menu "File -> Open Trace...". In the file dialog select a Verify that the same trace that was previously linked into the Traces
2.2 previously opened text trace |text trace and select open. Use same trace than 2.1 folder is opened and not a new trace entry is created Manual Pass
Use "Menu File -> Open Trace ..." . In the file dialog select a | Verify that the trace is linked to the Tracing project, the kernel
2.3 Open Trace (Directory) file of Kernel CTF trace directory and select open. analysis trace type is selected and trace is opened. Manual Pass
Open Trace (Directory) with  |Use "Menu File -> Open Trace ..." . In the file dialog select a
previously opened Kernel CTF |file of Kernel CTF trace directory and select open. Use same |Verify that the same trace that was previously linked into the Traces
2.4  |trace trace than 2.3 folder is opened and not a new trace entry is created Manual Pass
Use Menu "File -> Open Trace ..." In the file dialog select a
text trace and select open, where the name of trace is the Verify that the new trace is linked to the Tracing project and the
Open Trace File with name same than 2.1, but the trace is located at a different location |trace is opened. Verify that the new trace name has a integer
2.5 conflict on disk number a suffix added. Manual Pass
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Use "Menu File -> Open Trace ..." . In the file dialog select a
file of Kernel CTF trace directory and select open, where the
name of trace is the same than 2.3, but the trace is located at

Verify that the kernel trace is linked to the Tracing project, the
kernel analysis trace type is selected and trace is opened. Verify that

2.6 Re-do 2.5 a different location on disk the new trace name has a integer number a suffix added. Manual
2.7 Open file Open file that is not a trace Trace is imported (linked) however default icon (from Eclipse) is set| Manual should it open?
Verify that RCP is restarted with the previously open perspective
2.8 Restart Use Menu File -> Restart and trace Manual
2.9 Exit Use Menu File -> Exit Tracing RCP exits Manual
3 Window Menu
Use Menu Window -> Show Perspective -> Tracing
3.1 Open Perspective Perspective Tracing perspective is opened Manual
Use Menu Window -> Show View -> Select Tracing ->
3.2 Open View Sequence Diagram Sequence diagram view is shown Manual
3.3 |Preferences Use Menu -> Preferences Preferences dialog is shown Manual
Make changes of perspective by moving views and use menu
window -> Save Perspective As. Enter a perspective name and
3.4 Save Perspective As select Ok Perspective with new name is stored Manual
Make changes of perspective by moving views and use menu |After confirming the reset operation the perspective is reset to the
3.5 Reset Perspective Window -> Reset Perspective. default layout. Manual
4 Help Menu
4.1 Help Contents Use Menu -> Help -> Help Contents Help content browser is opened. All Tracing related help is included Manual
4.2 Help Contents (shortcut) Use key F1 Help content browser is opened. All Tracing related help is included Manual
Use Menu -> Help -> Install New Software... to install new
4.2 Install new Software Eclipse feature Installation is successful Manual
About dialog is opened all relevent information (e.g. version,
4.4  |About Use Menu -> Help -> About copyright years etc) is up-to-date and correct. Manual
Go over all tracing features and plug-ins and verify that all have the
4.5  |Version + Copyright Use Menu -> Help -> About -> Installation details correct version and copyright years Manual
5 Content
5.1 TMF presence Open Tracing perspective Tracing perspective opens Manual
5.2 LTTng presence Open LTTng Kernel perspective LTTng Kernel perspective opens Manual
PCAP Network analysis
5.3 presence Open Network analysis perspective Network analysis perspectiv opens Manual
5.4 BTF presence Open BTF trace BTF trace opens correctly Manual
6 Upgrade
Upgrade from previous
6.1 release Use Help -> Check For Updates RCP is upgraded Manual Tested with RC2
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O P o Do O
Trace Synchronization 13 0 0 3
Target:
Test Case Action Verification Comment
0 Prerequisites
Import the scp_dest and scp_src traces in the
0.1 Import traces synctraces.tar.gz file
0.2 Create experiment 1 Create an experiment containing those 2 traces
0.3 Create experiment 2 Create an experiment with any other trace
1 View Management
Open Synchronization Use menu Window— Show View — Other ... —
1.1 View Tracing — Synchronization Verify that 'Synchronization' view is shown Manual Pass This view should be in properties | agree
1.2 Delete view Close the Synchronization View Synchronization' view is removed from perspective Manual Pass  The view also makes no sense to mere mortals.
Use menu Window— Show View — Other ... —
1.3 Open view Tracing — Synchronization Synchronization' view is displayed and remains empty Manual Pass
Open the experiment containing the 2
1.4 Open Experiment synchronizable traces Verify that the view is still empty Manual Pass
After a time, the view is populated with synchronization
result that say 'accurate'. And one of the original traces
Right-click on the experiment and select has been replace by a trace with the same name, but
1.5 Synchronize experiment |'Synchronize Traces' with an'_" at the end. Manual Pass
1) Close Synchronization View
Open view when traceis |2) Load LTTng experiment Verify that view is populated with synchronization data
1.6 already loaded 3) Open 'Synchronization' view from currently opened experiment Manual Pass
Synchronize experiment
1.6.5 with constant offset Try to offset a trace by a second Visually verify that a synchronized trace is now offsettedq Manual Pass
1.7 Open trace Open an Lttng Kernel trace Synchronization view is empty Manual Pass
Open the experiment containing the 2
1.8 Re-open experiment synchronized traces View shows synchronization data from the experiment | Manual Pass
Verify that view is populated with synchronization data
1.9 Restart Restart Eclipse from experiment Manual Pass
2 Functionnalities
Open the experiment containing traces that do not
21 Open experiment 2 synchronize Verify that the 'Synchronization' view is empty Manual Pass
Go back to previous Re-open the experiment with the synchronizable Verify that the 'Synchronization' view contains the data
2.2 experiment traces from the experiment Manual Pass
After the syncronization job finishes, the synchronized
Right-click on the experiment and select 'SynchroniZexperiment is closed and experiment 2 is selected. The Absent is not displayed, the view is empty. Patrick:
2.3 Synchronize experiment traces' synchronization view is empty. Manual Pass Updated the verification text
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Section Type ToDo Comment
LTTng 2.0 - Memory
Analysis 20 2 0 12
Target: |Ubuntu 14.04 64 bit
Step Test Case Action Verification Type Comment
0 Prerequisites
. Note: Traces generated with LTTng 2.7 and later won't populate the view
Download UST tra_ce with memory events because the libc tracepoint names were changed. https://bugs.eclipse.
from http://secretaire.dorsal.polymtl. org/bugs/show_bug.cgi?id=470186
0.1 Download traces ca/~gbastien/traces/eclipse_mem_ust.tar.gz works now!
Import trace with memory |Import the LTTng UST trace downloaded
0.2 event above in Tracing project
Import one of the LTTng UST trace that does
Import trace without not contain the memory events, for exampleg,
0.3 memory event the one used for the callstack view
0.4 Import non-UST trace Import one LTTng Kernel trace
1 Project View
In the project explorer, expand the trace that
1.1 Check analysis can executgcontains the memory events "Ust Memory" analysis is present and "normal” Manual Pass
In the project explorer, open and expand the
Verify help message when |trace that contains the memory events, right-
1.2 applicable click the memory analysis and select Help |A generic help message appears with the name of the analysis{ Manual Pass
Check analysis cannot In the project explorer, expand the UST trade
1.3 execute that does not contain memory events "Ust Memory" analysis is present, but striked-out Manual Pass The trace need to be opened
In the project explorer, open and expand the
UST trace that does not contain memory
Verify help message when |events, right-click the memory analysis and | The help message mentions the analysis is impossible to
14 not applicable select Help execute and contains the requirement that is not fulfilled Manual Pass
Check analysis for another |In the project explorer, expand a LTTng
15 trace type Kernel trace "Ust Memory" analysis is not present Manual Pass
2 View Management
Open the UST trace with memory events
and expand the "UST Memory" analysis in
21 Populate analysis's view |the project explorer "Ust Memory Usage" View appears under the analysis Manual Pass
Double-click the UST Memory View under [The UST Memory Usage view opens and triggers the memory
2.2 Open view the memory analysis analysis. After the analysis, the XY chart is populated SWTBot Pass
2.3 Close trace Close the trace The UST Memory Usage view is emptied. Manual Pass
With the view already opened, open the
2.4 Open trace trace The UST Memory Usage view is populated. SWTBot Pass View not populated. Bug 467751
25 Close view Close the UST Memory Usage view The view is closed. Manual Pass
Double-click the UST Memory Usage view
under the memory analysis in project
2.6 Re-open view explorer. The view opens and is automatically populated. Manual Pass
3 Mouse handling
Drag move xy chart left and right with middleTime range is dragged. When mouse button is released, the
3.1 Drag move time range button view refreshes with the new time range Manual Pass But while dragging, nothing visible happen
Time range is zoomed in and out, relative to mouse cursor.
Zoom time range (mouse |Zoom with mouse wheel up and down, When mouse wheel is stopped for a short time, series are
3.2 wheel) cursor inside xy chart updated and new time range is propagated to other views. Manual Pass
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Selection highlighted. When mouse button is released, time
range is zoomed to selection, series are updated and new time

Status bar is not updated. Note that the status
bar hasn't been implemented for XY charts. So
we should not test for it

Status bar not updated

time range is NOT updated to include the new st

3.3 Drag select time range Drag select time graph with right button range is propagated to other views. Manual
3.4 Mouse hover Hover mouse in xy chart anywhere Tool tip shows values for each thread at the given timestamp Manual
Selection highlighted. New selection is propagated to other
3.5 Drag mouse selection Drag select xy chart with left button views Manual
Click select with left button (begin time),
press shift key and click select another time| Selection highlighted. New selection is propagated to other
3.6 Shift key selection (end time) views Manual
Selection highlighted. Status bar of Eclipse is updated with time|
information: T, T1, T2 and delta, where T is the time of the mou
position, T1 the first selected time, T2 the second (draggged)
Drag mouse selection selected time and delta the time difference between T2-T1 (can|
3.7 (Status bar) Drag select xy chart with left button be negative) Manual
Selection highlighted. Status bar of Eclipse is updated with time|
information: T, T1, T2 and delta, where T is the time of the mou
Click select with left button (begin time), position, T1 the first selected time, T2 the second (draggged)
Shift key selection (Status |press shift key and click select another time|selected time and delta the time difference between T2-T1 (can|
3.8 bar) (end time) be negative) Manual
4 Synchronization
Have the Histogram and UST Memory
Preparation Usage views both visible
4.1 Time synchronization Select a random time in another view Selected time line is updated. Manual
Select a new time range in UST Memory
4.2 Time range synchronization|Usage view or in Histogram view. Time range is updated. Manual
Time range selection In any other view that supports range
4.3 synchronisation synchronization, select a new range. Selection range is highlighted. Manual

time range is NOT updated to include the new st
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2.1.0-TraceCompassTestCases - LTTng 2.0 - CPU analysis

26

Test Case

Action

Verification

0 Prerequisites
0.1 Import traces Import LTTng Kernel traces in Tracing project
1 Project View
In the project explorer, expand a LTTng Kernel
1.1 Check analysis can executgtrace "CPU usage" analysis is present and it's not crossed out Manual
In the project explorer, open and expand the
Verify help message when [LTTng kernel trace, right-click the CPU usage |A generic help message appears with the name of the
1.2 applicable analysis and select Help analysis Manual
Check analysis for another |In the project explorer, expand a non-LTTng
1.5 trace type Kernel trace "CPU usage" analysis is not present Manual
2 View Management
Open an LTTng kernel trace and expand the
21 Populate analysis's view ["CPU usage" analysis in the project explorer |("CPU Usage" View appears under the analysis Manual
The CPU usage Usage view opens and triggers the cpu
Double-click the CPU usage View under the |analysis. After the analysis, both tree viewer and xy charts an
2.2 Open view CPU usage analysis populated. Manual
2.3 Close trace Close the trace The CPU Usage view is emptied. Manual
2.4 Open trace With the view already opened, open the trace |The CPU Usage view is populated. Manual
2.5 Close view Close the CPU Usage view The view is closed. Manual
Double-click the CPU Usage view under the
2.6 Re-open view CPU usage analysis in project explorer. The view opens and is automatically populated. Manual
3 View selection
A new series is added to the xy chart, corresponding to the
3.1 Select an entry Select an entry in the tree viewer section selected TID Manual
A new series is added to the xy chart, and the previous TID's
3.2 Select another entry Select another entry from the tree viewer series is not displayed anymore Manual
4 Mouse handling
Time range is dragged. When mouse button is released
Drag move xy chart left and right with middle |series are updated and new time range is propagated to
4.1 Drag move time range button and shift mouse wheel other views. Manual
Time range is zoomed in and out, relative to mouse cursor.
When mouse wheel is stopped for a short time, series are
updated and new time range is propagated to other views,
Zoom time range (mouse |Zoom with ctrl mouse wheel up and down, including the tree viewer beside the chart. The selected
4.2 wheel) cursor inside xy chart process remains the same. Manual
Scroll with mouse wheel up and down, cursor |Table scroll up and down. Selected process does not change.
43 Mouse vertical scroll outside xy chart Vertical scroll bar updated. Manual
Tree viewer scrolls up and down. Selected process does not
4.4 Vertical scroll bar Click and drag vertical scroll bar change. Manual
Selection highlighted. When mouse button is released, time
range is zoomed to selection, series are updated and new
Drag select time graph with right button in xy [time range is propagated to other views. Selected process
4.5 Drag select time range chart remains the same. Manual
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Pass

Pass

Pass

Pass

Pass
Pass
Pass
Pass

Pass

Pass

Pass

Pass

Pass

Pass

Pass

Pass

Comment

[

Sonia: The help message doesn't explain the
role of the view or how to use it. There should
be more details available

Sonia: If you select an entry in a trace than
open a new trace the previous TID(selected) ig
not removed from the category labels
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Tool tip shows the total and selected process (if any) cpu

It would be nice to display the process name
instead of the tid.Sonia:lf you select an entry
in a trace then open a new trace, the tool tip

shows the previous process. It would also be
nice to crop the percentage

Status bar is not updated. Note that the status
bar hasn't been implemented for XY charts. Sq
we should not test for it

Status bar not updated

4.6 Mouse hover Hover mouse in xy chart region anywhere usage at the time Manual
Selection highlighted and selection range is propagated to
4.7 Drag mouse selection Drag select xy chart with left button other views Manual
Click select with left button (begin time), press
shift key and click select another time (end Selection highlighted and selection rang is propagated to
4.8 Shift key selection time) other views Manual
Entries are sorted in ascending then descending order on the
4.9 Sort columns Click on column headers once then twice column value. Selected process does not change. Manual
Selection highlighted. Status bar of Eclipse is updated with
time information: T, T1, T2 and delta, where T is the time of
the mouse position, T1 the first selected time, T2 the second
Drag mouse selection (draggged) selected time and delta the time difference
4.10 (Status bar) Drag select xy chart with left button between T2-T1 (can be negative) Manual
Selection highlighted. Status bar of Eclipse is updated with
time information: T, T1, T2 and delta, where T is the time of
Click select with left button (begin time), press |the mouse position, T1 the first selected time, T2 the second
Shift key selection (Status |shift key and click select another time (end (draggged) selected time and delta the time difference
411 bar) time) between T2-T1 (can be negative) Manual
5 Keyboard handling
Keyboard navigation in tree| With focus on table, use UP, DOWN, HOME, |Selected process is changed. xy chart selection is updated.
5.1 viewer END keys Vertical scroll bar updated. Manual
6 Synchronization
Selected time line is updated. If selected time is outside
6.1 Time synchronization Select a random time in another view current range, time range is updated to include it. Manual
Select a new time range in CPU usage view or|
6.2 Time range synchronization|in Histogram view. Time range is updated. Manual
Selection is highlighted. If the most left time (T1) of
Time range selection In any other view that supports range selected time range is outside the current range, then time
6.3 synchronisation synchronization, select a new range. range is updated to include it Manual
CPU usage works with
experiments Manual

Sonia : The cpu usage works only on
experiments with one trace , it would be nice if|
it displays the CPU usage of two traces per
example in the same graph

works wit 1 kernel
trace experiments
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Network Trace analysis

2.1.0-TraceCompassTestCases - Network Analysis

11

Ubuntu 14.04 64 bit

Test Case

Action

Verification

Comment

0 Prerequisites
0.1 Import traces Import the trace linked here
1 Trace Import
Open the Network Tracing|In the project Explorer, expand any LTTng Verify that the events view, the properties and
1.1 perspective kernel trace stream list are displayed SWTBot
The trace is given a "network" icon. When
openned, the events view and histogram view is
1.2 Open trace Double-click on the "TeamSpeak2.pcap" trace |opened SWTBot
2 View management
2.1 Populate the views Open the "TeamSpeak2.pcap" The views are updated SWTBot
One stream is available with endpoint A being 00:
2.2 Look up stream Open the Stream list 0c:29:7c:ab:f9 Manual
2.3 Close the trace Close the trace The stream list is emptied Manual
2.4 Close view Close the view The view is closed Manual
Open view when trace is The view opens with the correct title and is
2.5 already loaded Re-open the trace. Open The Stream List correctly populated. Manual
2.6 Open a non pcap trace Close the trace The stream list is emptied Manual
3 Stream List
3.1 Re-open trace Ensure only "TeamSpeak2.pcap" is opened The trace is opened Manual
Create a filter from the Right click on stream 0, and select "Extract as |A filter named "FILTER stream eth 00:0c:29..." is
3.1 stream list Filter" created Manual
In the events table, right click on an event and
select "Apply preset filter-> stream eth 00:0c:
3.2 Apply filter 29.." 24/24 events pass the filter Manual
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Pass

Pass

Pass

Pass

Pass
Pass

Pass

Pass

Pass

Pass

Pass

Bruno : 1 wasn't able to import a pcap
traceusing the import trace, | needed to
use the opentrace option

In SWTBot other trace is used

Bruno : The icon for the filter is a red 'X', which is g
bit weird | find.




2.1.0-TraceCom

passTestCases - XMLanalysis

XML analysis 40 0 0 7
Target: |Ubuntu 14.04 64 bit
Test Case Action Verification Comment
0 Prerequisites
0.1 Import traces Import LTTng kernel traces
Download the test XML file here: http://secretaire.dordal.
0.2 Get a test XML file polymtl.ca/~gbastien/Xml4Traces/Kernel. Linux.xml
The XML files are located in <workspace directory>/.
metadata/.plugins/org.eclipse.tracecompass.tmf.analysis.
Make sure the XML file does |xml.core/xml_files. Delete the linux kernel XML file iftoTE: XML haven't files haven't been update to latest Kernel tracepoints
0.3 not exists in the project exists. and syscall changes. So, they only work with trace LTTng 2.5 and older
1 XML file handling
1.1 Verify analysis not present | In the project Explorer, expand any LTTng kernel trac¢Verify that there is no 'Xml kernel State System' analysis Manual Pass
Right-click the Traces folder, select Manage XML
analyses.... In the opened dialog import the Kernel. Lin{iXerify that the 'Xml kernel State System' analysis is now present]
1.2 Import XML file xml file and close the dialog. under a LTTng kernel trace Manual Pass
ght-click the Traces folder, select Manage XML
analyses.... In the opened dialog, select Kernel.Lunux ¢ Verify that the XML editor opens. The editor should have Desig
1.3 Edit XML file click Edit and Source sub-tabs Manual Pass
2 View management
The 'Xml kernel State System' analysis should have a + next to i
expand it and there should be 2 views under it: "Xml Control Flo
2.1 Populate the views Open an LTTng kernel trace View' and 'Xml Resources View' Manual Pass
Open the 'Xml Control Flow |Double-click the "Xml Control Flow View' under the |A view titled 'Xml Control Flow View' should open and it shoul
2.2 View' analysis look quite similar to the Control Flow View Manual Pass
A view titled 'Xml Resources View' should open and it should look
Double-click the 'Xml Resources View' under the quite similar to the Resources view's CPU entries. Both XML vi¢gws
2.3 Open another XML view analysis are opened. Manual Pass
2.4 Close view Close both XML view The view are closed Manual Pass
Open view when trace is
2.5 already loaded Double-click one of the views under the analysis The view opens with the correct title and is correctly populated. | Manual Pass
2.6 Close traces Close all opened traces The view is emptied. Manual Pass
2.7 Open trace Open an LTTng Kernel trace The view is populated Manual Pass
2.8 Open another trace Open a non-LTTng Kernel trace The view is emptied. Manual Pass | The root entry which corresponds to the traci
2.9 Open LTTng Kernel trace Open an LTTng Kernel trace The view is populated. Manual Pass
3 View selection
3.1 Select an entry in the table Select an entry in the table Same entry is highlighted in time graph. Manual Pass
Same entry is highlighted in table. Selected time line is updated.
3.1 Select entry in time graph Select an entry in the time graph (empty region) Other views are synchronized to selected time. Manual Pass
Same entry is highlighted in table. State is highlighted in time graph.
Selected time line is updated. Other views are synchronized to
2.3 Select state in time graph Select a state in the time graph selected time. Manual Pass
4 Mouse handling
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Time range is dragged. When mouse button is released, states art

"the new window range"

4.1 Drag move time range Drag move time graph left and right with middle buttoupdated and new time range is propagated to other views. Manual

Time range is zoomed in and out, relative to mouse cursor. When
Zoom time range (mouse Zoom with CTRL + mouse wheel up and down, cursorymouse wheel is stopped for a short time, states are updated and

4.2 wheel) inside time graph new time range is propagated to other views. Manual
Time range is zoomed in and out. When mouse button is released,

43 Zoom time range (mouse drag)Drag in time graph scale left and right with left button |states are updated and new time range is propagated to other viewsManual

Scroll with mouse wheel up and down, cursor outside |Table and time graph scroll up and down and remain aligned.

4.4 Mouse vertical scroll time graph Selected entry does not change. Vertical scroll bar updated. Manual
Table and time graph scroll up and down and remain aligned.

4.5 Vertical scroll bar Click and drag vertical scroll bar Selected entry does not change. Manual
Selection highlighted. When mouse button is released, time rangg is
zoomed to selection, states are updated and new time range is

4.6 Drag select time range Drag select time graph with right button propagated to other views. Manual
Time range is reset to full range, states are updated and new timg

4.7 Double-click reset time range | Double-click left button on time scale range is propagated to other views. Manual

4.8 Mouse hover (empty region) |Hover mouse in time graph over empty region Tool tip shows entry name only. Manual
Tool tip shows entry name, state name, date, start time, end time

4.9 Mouse hover (state) Hover mouse in time graph over state duration. Manual
Selection highlighted. Status bar of Eclipse is updated with time
information: T, T1, T2 and delta, where T is the time of the mousge
position, T1 the first selected time, T2 the second (draggged)
selected time and delta the time difference between T2-T1 (can he

4.10 Drag mouse seleection Drag select time graph with left button negative) Manual
Selection highlighted. Status bar of Eclipse is updated with time
information: T, T1, T2 and delta, where T is the time of the mousge
position, T1 the first selected time, T2 the second (draggged)

Click select with left button (begin time), press shift kggelected time and delta the time difference between T2-T1 (can He
4.11 Shift key selection and click select another time (end time) negative) Manual
5 Keyboard handling
Keyboard navigation in table |With focus on table, use UP, DOWN, HOME, END |Selected process is changed. Time graph selection is updated.
5.1 (entry selection) keys Vertical scroll bar updated. Manual
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Keyboard navigation in table

With focus on table,
in Windows use LEFT, RIGHT keys while parent or
child process is selected

in Linux use SHIFT LEFT, RIGHT keys while parent

For parent process, tree is expanded or collapsed. Time graph ite
expansion is updated. Vertical scroll bar updated. For child proc
oleft changes selection to parent, time graph selection is updated.

Passed on Linux.

Comment from 1.0 testing: Not all displayed

colors are in the legend
This is still a problem in 1.1 when using

traces generated with LTTng 2.6 and older

More filter buttons are available in cfv

5.2 (tree expansion) child process is selected Vertical scroll bar updated. Manual
Keyboard navigation in time | With focus on time graph, use UP, DOWN, HOME, |Selected process is changed. Table selection is updated. Vertical
5.4 graph (process selection) END keys scroll bar updated. Manual
Keyboard navigation in time Previous or next state is selected. Selected time is updated in other
5.4 graph (state selection) With focus on time graph, use LEFT, RIGHT keys  |views. Manual
6 Tool bar handling
6.1 Show Legend Click Show Legend button The legend dialog is opened and can be closed. Manual
Time range is reset to full range, states are updated and new timg
6.2 Reset Time Scale Click Reset Time Scale button range is propagated to other views. Manual
Previous or next state is selected. Selected time is updated in othgr
6.3 Select Previous/Next Event | Click Previous/Next Event button views. Manual
Selected interval (process/resource) is changed in table and time
6.4 Select Previous/Next Process |Click Previous/Next interval button graph. Vertical scroll bar updated. Manual
Time range is zoomed in and out, relative to center of time rangg.
States are updated and new time range is propagated to other
6.5 Zoom In/Out Click Zoom In/Out button views. Manual
6.6 Filter Dialog Open Filter Dialog Verify that all buttons are working correctly Manual
1) Open Filter Dialog
2) Deselect several processes
6.7 Filter Processes 3) Press Ok Verify that only selected entries are displayed in the view Manual
7 Synchronization
Selected time line is updated. If selected time is outside current
7.1 Time synchronization Select a random time in another view range, time range is updated to include it. Manual
Select a new time range in Resources view or in
7.2 Time range synchronization |Histogram view. Time range is updated. Manual
Time range selection In any other view that supports range synchronization,|Selection is highlighted. If begin time (T1) of selected time rangg is
73 synchronisation select a new range. outside the current range, then time range is updated to include if Manual
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Critical path

2.1.0-TraceCompassTestCases - Critical Path

45

Target:

Test Case

Action

Verification

Comment

0 Prerequisites
Import the 3
django traces
from the test
0.1 Import traces traces
Create an
experiment with
0.2 Create experiment|the 3 traces in it
Synchronize the
experiment, it
should be
accurate and 2
Synchronize of the traces will
0.3 experiment be udpated
View
1 management
Expand the Views element under the trace.
The LTTng Kernel Exec Graph analysis is
Open any of the [there and "normal". The Critical Path
django traces in |analysis is there and the Critical Flow view
1.1 Open trace Project Explorer|is available under it. Manual Pass
Expand the Views element under the trace.
The LTTng Kernel Exec Graph analysis is
Open the djanggthere and "normal". The Critical Path
experiment in  [analysis is there and the Critical Flow view
1.2 Open experiment |Project Explorer|is available under it. Manual Pass
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Expand the
Views element,
then the Critical
Path analysis
and click on the

Critical Flow
1.3 Open view View Critical Path view is opened and empty Manual
Close the
Critical Flow
14 Close view View Critical Path view is closed Manual
Expand the Views element under the trace.
Openatrace |The LTTng Kernel Exec Graph analysis is
that is not a not there. The Critical Path analysis is there
LTTng kernel  |and the Critical Flow view is available undet
1.5 Unapplicable trace|trace it. Manual
Open an Expand the Views element under the trace.
experiment that | The LTTng Kernel Exec Graph analysis is
does not contain|there, but striked out. The Critical Path
Unapplicable LTTng kernel  |analysis is there and the Critical Flow view
1.6 experiment traces is available under it. Manual
2 View population
With the django-
client trace and
the critical path
view opened, in
the control flow
view, find the
process named
python (TID
9496). Right-
click on the
process and The LTTng kernel exec graph is executed
Populate the view |select "Follow |and at the end, the critical path view shows
21 with trace python/9496" |the interaction between 3 workers. Manual
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This should be re-tQ

The execution grapt
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Select an empty

But there should be

The critical path is n

region in the Same process is highlighted in table.
Select worker in  |time graph Selected time line is updated. Other views
2.2 time graph section are synchronized to selected time. Manual
Same process is highlighted in table. State
is highlighted in time graph. Selected time
Select state in Select a state in|line is updated. Other views are
23 time graph the time graph [synchronized to selected time. Manual
Select a worker
Select worker in  |from the tree
24 tree viewer viewer section |Same process is highlighted in time graph. Manual
Repeat steps of
2.1, with django-
client trace and
process Ittng-
Populate the view [sessiond (TID
25 with empty path  |9355) The Critical Path View is emptied Manual
Repeat steps of
2.1, and select
python/9496
255 Select again again The critical path should be the same as 2.1 Manual
Close the
django-client
trace, reopen it
and repeat The Critical Path View should be populated
2.6 Re-opening steps of 2.1 like in step 2.1 Manual
Repeat steps of
2.1, but with the
django- The LTTng kernel exec graph is executed
Populate the view |experiment and at the end, the critical path view is
2.7 with experiment  |instead populated with elements from the 3 traces. Manual

Because of the bug

75



2.1.0-TraceCompassTestCases - Critical Path

Re-open
django-client
trace. In the
Control Flow
View, select a
time after the
python process

exited, then
Populate with follow the
trace with time python/9496 The Critical Path View should be populated
2.8 selection process like in step 2.1 Manual
3 Mouse handling
Ctrl-Drag move
time graph left |Time range is dragged. When mouse buttor]
Drag move time |and right with  |is released, states are updated and new
3.1 range middle button |time range is propagated to other views. Manual
Zoom with
mouse wheel up
and down, Time range is zoomed in and out, relative td
cursor inside mouse cursor. When mouse wheel is
time graph while|stopped for a short time, states are updated
Zoom time range |holding the Ctl |and new time range is propagated to other
3.2 (mouse wheel) button views. Manual
Drag in time Time range is zoomed in and out. When
graph scale left |mouse button is released, states are
Zoom time range |and right with |updated and new time range is propagated
3.3 (mouse drag) left button to other views. Manual
Scroll with
mouse wheel up
and down, Table and time graph scroll up and down
Mouse vertical cursor outside |and remain aligned. Selected worker does
3.4 scroll time graph not change. Vertical scroll bar updated. Manual
Click and drag |Table and time graph scroll up and down
vertical scroll  |and remain aligned. Selected process does
3.5 Vertical scroll bar |bar not change. Manual
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Drag select time

Drag select time
graph with right

Selection highlighted. When mouse button i
released, time range is zoomed to
selection, states are updated and new time

3.6 range button range is propagated to other views. Manual
Double-click left| Time range is reset to full range, states are
Double-click reset |button on time |updated and new time range is propagated
3.7 time range scale to other views. Manual
Hover mouse in
Mouse hover time graph over
3.8 (empty region) empty region Tool tip shows process name only. Manual
Hover mouse in
Mouse hover time graph OVer | 1 tip shows worker name, state name, priority, date,
39 (state) state start time, end time, duration. Manual
Selection highlighted. Status bar of Eclipse is updated
Drag select time with time information: T, T1, T2 and delta, where T is the
. time of the mouse position, T1 the first selected time,
Drag mouse graph with left |15 second (dragged) selected time and delta the
3.10 selection button time difference between T2-T1 (can be negative) Manual
Click select with
left button (begin
time), press shift selection highlighted. Status bar of Eclipse is updated
key and click with time information: T, T1, T2 and delta, where T is the
time of the mouse position, T1 the first selected time,
. . S_eleCt anOt.her T2 the second (dragged) selected time and delta the
3.1 Shift key selection [time (end time) |time difference between T2-T1 (can be negative) Manual
Keyboard
4 handling
Keyboard With focus on
navigation in table |table, use UP, |Selected process is changed. Time graph
(process DOWN, HOME, |selection is updated. Vertical scroll bar
4.1 selection) END keys updated. Manual
With focus on table,
in Windows use
LEFT, RIGHT keys
while trace or worker
is selected
Keyboard in Linux use SHIFT
. . . LEFT, RIGHT keys |For trace, tree is expanded or collapsed. Time graph
naV|gat|on m_ table while trace or worker |item expansion is updated. Vertical scroll bar updated.
4.2 (tree expansmn) is selected For workers, it does nothing. Manual

Tested in Linux
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With focus on

Keyboard time graph, use
navigation in time |UP, DOWN,
graph.(process HOME, END Selected worker is changed. Table selection is
4.3 selection) keys updated. Vertical scroll bar updated. Manual
Keyboard With focus on
navigation in time [time graph, use
graph (state LEFT, RIGHT |Previous or next state is selected. Selected
4.4 selection) keys time is updated in other views. Manual
5 Tool bar handling
Click on the Align
View Button, with
another time graph [ When it is pressed, moving the line between tree viewer
view, eg the Control |and time graph will move the line of the other view. If not
Flow view opened pressed, the line can be moved without affecting the
5.1 Align views above or under other views Manual
Click Show The legend dialog is opened and can be
5.2 Show Legend Legend button |closed. Manual
Click Reset Time range is reset to full range, states are
Time Scale updated and new time range is propagated
5.3 Reset Time Scale |button to other views. Manual
Select Click
Previous/Next Previous/Next |Previous or next state is selected. Selected
54 Event Event button time is updated in other views. Manual
Click
Select Previous/Next | Previous/Next S_elected workeri is changed in table and
5.5 Element Element button |time graph. Vertical scroll bar updated. Manual
Time range is zoomed in and out, relative td
center of selection or window. States are
Click Zoom updated and new time range is propagated
5.6 Zoom In/Out In/Out button  |to other views. Manual
Select a time, and
click on the Add The bookmark is added and is displayed in the other
5.7 Add Bookmark Bookmark button views as well (if enabled) Manual
Add more
bookmarks, then The time graph view navigate between the bookmarks,
click on the States are updated and time selection is propagated to
next/previous marker | other views. When on a bookmark, the Add bookmark
5.8 Next/Previous marker buttons buttons changes to Delete bookmark Manual
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5.9

Delete bookmark

With next/previous
marker, when on a
bookmark, click the
delete bookmark
button

The bookmark is deleted from all views

Manual

5.11

Do not show markers

Click on the down
arrow at the extreme
right of the view, then
expand Show
markers and
uncheck the
Bookmarks box

All remaining bookmarks disappear from the view, but
remain in other views where the they are enabled

Manual

5.12

6.1

Show markers
Synchronization

Time
synchronization

Same as above,
recheck the
Bookmarks box

Select a random
time in another
view

The bookmarks come back

Selected time line is updated. If selected
time is outside current range, time range is
updated to include it.

Manual

Manual

6.2

Window range
synchronization

Select a new
window range in
another view

Window range is updated.

Manual

6.3

Selection range
synchronization

In any other view
that supports
selection range
synchronization,
select a new
range.

Selection is highlighted. If the left time (T1)
of selected time range is outside the current
range, then window range is updated to
include it

Manual

6.4

Out of region selection

With a critical path
displayed, select a
time in another view
that is not in the
range of the
process being
displayed in the
critical path view

Selected time is updated and the critical path view is

synced with the other

Manual
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Section Comment

LTTng 2.0-1/0
Analysis 18

Step Test Case Action Verification Comment
0 Prerequisites
Import LTTng
Kernel traces in
0.1 Import traces | Tracing project
1 Project View
Bruno : In the
'Views' tree item,
thereis a
Input/Output item,
but im not sure
"Input/Output” what it means to be
In the project  |analysis is :‘:m:l"isiz?ev'eve
explorer, present and striked-out (added
Check analysis |expand a LTTng|"normal" (not it to the verif step),
1.1 can execute Kernel trace striked-out) Manual Pass it is a pass
In the project
explorer, open
and expand the
LTTng kernel  |A generic help
trace, right-click [message
Verify help the Input/Output|appears with the Bruno : The help
message when |analysis and name of the messaée doesn't
1.2 applicable select Help analysis Manual Pass explain much
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In the project
explorer,

Check analysis [expand a non- |"Input/Output"
for another tracelLTTng Kernel |analysis is not
1.5 type trace present Manual
View
2 Management
Open an LTTng
kernel trace and
expand the "Disk 1/0
"Input/Output" |Activity" View
Populate analysis in the |appears under
2.1 analysis's view |project explorer |the analysis Manual
The Disk I/0O
Activity view
opens and
triggers the
Double-click the |input/output
Disk I/0O Activity |analysis. After
View under the |[the analysis, the
Input/Output xy charts is
2.2 Open view analysis populated. Manual
The Disk 1/0
Activity view is
2.3 Close trace Close the trace [emptied. Manual
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Bruno : Not really a
bug, when opening
the trace the zoom
is so small that the
I/O graph seems
empty Geneviéve:
it is the same time
range as other
views, so if no
read/write was
done in that time, it
is normal that it
looks empty

With the view |The Disk I/O
already opened, |Activity view is
24 Open trace open the trace |populated. Manual
Close the Disk |The view is
2.5 Close view I/0 Activity view |closed. Manual
Double-click the
Disk I/0O Activity
view under the |[The view opens
Input/Output and is
analysis in automatically
2.6 Re-open view |project explorer.|populated. Manual
3 View selection
Mouse
4 handling
Time range is
dragged. When
mouse button is
released, series
Drag move xy |are updated and
chart left and new time range
Drag move time [right with middle|is propagated to
4.1 range button other views. Manual
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4.2

Zoom time
range (mouse
wheel)

Zoom with
mouse wheel up
and down,
cursor inside xy
chart

Time range is
zoomed in and
out, relative to
mouse Cursor.
When mouse
wheel is
stopped for a
short time,
series are
updated and
new time range
is propagated to
other views.

Manual

4.3

Drag select time
range

Drag select time
graph with right
button in xy char

Selection
highlighted.
When mouse
button is
released, time
range is
zoomed to
selection, series
are updated and
new time range
is propagated to
other views.

Manual

4.4

Mouse hover

Hover mouse in
Xy chart region
anywhere

Tool tip shows
the puntual disk
activity, with
units in <unit>/s

Manual
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Bruno : The tool tip
is showing but is
not folowing the
mouse, so the infos
are updated but the
black box remain at
the original place.
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4.5

Drag mouse
selection

Drag select xy
chart with left
button

Selection
highlighted and
selection range
is propagated to
other views

Manual

4.6

Shift key
selection

Click select with
left button (begin
time), press shift
key and click
select another
time (end time)

Selection
highlighted and
selection rang is
propagated to
other views

Manual

Bruno : Does not
work Matthew:
works for me

4.70

Drag mouse
selection
(Status bar)

Drag select xy
chart with left

button

Selection
highlighted.
Status bar of
Eclipse is
updated with
time
information: T,
T1, T2 and
delta, where T is
the time of the
mouse position,
T1 the first
selected time,
T2 the second
(draggged)
selected time
and delta the
time difference
between T2-T1
(can be

negative)

Manual

Status bar is not
updated. Note that
the status bar
hasn't been
implemented for XY]
charts. So we
should not test for
it
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Click select with
left button (begin
time), press shift

Selection
highlighted.
Status bar of
Eclipse is
updated with
time
information: T,
T1, T2 and
delta, where T is|
the time of the
mouse position,
T1 the first
selected time,
T2 the second
(draggged)
selected time
and delta the
time difference

Shift key key and click between T2-T1
selection select another |[(can be
4.8 (Status bar) time (end time) [negative) Manual
|
Keyboard
5 handling
6 Synchronizatioi
Selected time
line is updated.
If selected time
is outside
current range,
Select a random|time range is
Time time in another [updated to
6.1 synchronization |view include it. Manual
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Select a new
time range in
Disk I/0O Activity

Time range view or in Time range is
6.2 synchronization |Histogram view. |updated. Manual
Selection is
highlighted. I
the most left
time (T1) of
selected time
In any other range is outside
view that the current
supports range |range, then
Time range synchronization|time range is
selection ,selectanew |updatedto
6.3 synchronisation|range. include it Manual
Disk I/0O Activity
works with
6.4 experiments Manual
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Bruno : Did not
work when zooming
out, "An internal
error occurred
during: "". " dialog
popup Geneviéeve:
It randomly works
or not (didn't work
on an experiment |
just opened,
apeared to work on
the already opened
experiment when
opening trace
compass) Matthew:
worked for me!




Section

LTTng 2.0-VM
Analysis

2.1.0-TraceCompassTestCases - LTTng 2.0 - VM analysis

39

To Do

Comment

Step

0.1

Test Case

Prerequisites

Import traces

Action

Download
traces here:
http://secretaire.
dorsal.polymtl.
ca/~gbastien/tra
cingSummit201
4/mpi_traces.
tgz and import
the 3 kernel
traces in the
vmnet directory

Verification Comment

0.2

Create
experiment

Create an
experiment with
the 3 traces in it

0.3

Synchronize
experiment

Synchronize the
experiment, it
should be
accurate and 2
of the traces will
be udpated
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Right-click the

experiment,
click "Select
experiment
type..." and
select "Virtual
Set experiment |Machine
0.4 type Experiment"
View
1 management
Expand the The Virtual
Views element [Machine
of the Analysis is
1.1 Analysis present experiment present Manual
Expand the
Views element
under the trace,
then the Virtual
Machine
Analysis
Open the vm element. The
Open experimentin  |Virtual CPU
1.2 experiment Project Explorer|view is present Manual
Expand the Virtual CPU
Views element, |view is opened,
then the Virtual [the virtual
Machine machine
analysis and analysis is
click on the triggered and
Virtual CPU the view gets
1.3 Open view View filled Manual
Close the Virtual Virtual CPU
1.4 Close view CPU View view is closed Manual
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Open an
experiment that

Expand the
Views element
under the trace.

is not of Virtual |There is no
Unapplicable Machine Virtual Machine
1.6 experiment Experiment type|Analysis. Manual
View
2 population
The view is
populated with
the VM element
as the only
parent and 2
virtual guests
With the VM having 3
Populate the experiment, VCPUs each
view with open the Virtual |and a collapsed
21 experiment CPU View Threads entries Manual
A list of
processes is
shown, in
numerical order
Expand the and their time
View guest's Threads entry of|graph viewer
2.2 threads a guest part is filled Manual
Zoom in the
VCPUs time
graph around
the "interesting" |2 new states are
region, where |easily
there is more  [recognizable:
action (around [WAIT_VMM and
VM specific the second half [VCPU_PREEM
2.3 states of the trace) PTED Manual
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Select a region
with the
CPU_PREEMP
TED state and
scroll down the
threads entries

We can observe
alpha'ed states

to around 405- |corresponding
406: mpi- to the cpu
Preempted imbalance preempted
24 thread states processes states Manual
Close the VM
experiment, The view is
2.5 Re-opening reopen it populated again Manual
Mouse
3 handling
Time range is
dragged. When
mouse button is
released, states
Ctrl-Drag move |are updated and
time graph left |[new time range
Drag move time |and right with  |is propagated to
3.1 range middle button |other views. Manual
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Zoom with
mouse wheel up
and down,
cursor inside

Time range is
zoomed in and
out, relative to
MOuSe CUrsor.
When mouse
wheel is
stopped for a
short time,
states are
updated and

Zoom time time graph while|new time range
range (mouse |holding the Ctl |is propagated to
3.2 wheel) button other views. Manual
Time range is
zoomed in and
out. When
mouse button is
released, states
Drag in time are updated and
Zoom time graph scale left |new time range
range (mouse |and right with  |is propagated to
3.3 drag) left button other views. Manual
Table and time
graph scroll up
and down and
remain aligned.
Scroll with Selected worker
mouse wheel up|does not
and down, change. Vertical
Mouse vertical |[cursor outside |scroll bar
3.4 scroll time graph updated. Manual
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Table and time
graph scroll up
and down and

remain aligned.

Click and drag |[Selected
Vertical scroll  |vertical scroll process does
3.5 bar bar not change. Manual
Selection
highlighted.
When mouse
button is
released, time
range is
zoomed to
selection, states
are updated and
Drag select time|new time range
Drag select time|graph with right |is propagated to
3.6 range button other views. Manual
Time range is
reset to full
range, states
are updated and
Double-click left [new time range
Double-click button on time |is propagated to
3.7 reset time range|scale other views. Manual
Hover mouse in | Tool tip shows
Mouse hover  [time graph over |process hame
3.8 (empty region) |empty region |only. Manual
Hover mouse in | Tool tip shows entry
Mouse hover |time graph over |gaec,oee e
3.9 (state) state time, duration. Manual
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3.10

Drag mouse
selection

Drag select time
graph with left
button

Selection
highlighted. Status
bar of Eclipse is
updated with time
information: T, T1,
T2 and delta, where
T is the time of the
mouse position, T1
the first selected
time, T2 the second
(dragged) selected
time and delta the
time difference
between T2-T1 (can
be negative)

Manual

3.1

4.1

Shift key
selection

Keyboard
handling

Keyboard
navigation in
table (process
selection)

Click select with
left button (begin
time), press shift
key and click

select another
time (end time)

With focus on
table, use UP,
DOWN, HOME,

END keys

Selection
highlighted. Status
bar of Eclipse is
updated with time
information: T, T1,
T2 and delta, where
T is the time of the
mouse position, T1
the first selected
time, T2 the second
(dragged) selected
time and delta the
time difference
between T2-T1 (can
be negative)

Selected entry
is changed.
Time graph
selection is
updated.
Vertical scroll
bar updated.

Manual

Manual
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With focus on table,
in Windows use
LEFT, RIGHT keys
while expandable

For expandable
element, tree is
expanded or

collapsed. Time

element is selected [graph item
Keyboard expansion is
navigation in in Linux use SHIFT  [updated. Vertical
LEFT, RIGHT keys |scroll bar updated.
table (tl’.ee while expandable For other entries, it
4.2 expansion) element is selected | does nothing. Manual
Keyboard With focus on
navigation in time graph, use |Selected entry is
time graph UP, DOWN, Chlang_ed-,Tab'g e
selection is updated.
(process HOME, END | ygrtical scroll bar
4.3 selection) keys updated. Manual
Previous or next
state is
Keyboard With focus on |selected.
navigation in time graph, use |Selected time is
time graph LEFT, RIGHT [updated in other
4.4 (state selection) |keys views. Manual
Tool bar
5 handling
When it is pressed,
moving the line
between tree viewer
and time graph will
Click on the Align move the line of the
View Button, with other view. If not
another time graph | pressed, the line
view, eg the Control |can be moved
Flow view opened without affecting the
5.1 Align views above or under other views Manual
The legend
dialog is
Click Show opened and can
5.2 Show Legend |Legend button |[be closed. Manual
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Time range is
reset to full
range, states
are updated and

Click Reset new time range
Reset Time Time Scale is propagated to
5.3 Scale button other views. Manual
Previous or next
state is
selected.
Select Click Selected time is
Previous/Next |Previous/Next |updated in other
54 Event Event button views. Manual
Selected entry
is changed in
table and time
Click graph. Vertical
Select Previous/Next | Pr€Vious/Next | scroll bar
5.5 Element Element button |updated. Manual
Time range is
zoomed in and
out, relative to
center of
selection or
window. States
are updated and
new time range
Click Zoom is propagated to
5.6 Zoom In/Out In/Out button other views. Manual
The bookmark is
added and is
Select a time, and displayed in the
click on the Add other views as well
5.7 Add Bookmark Bookmark button (if enabled) Manual
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The time graph view
navigate between
the bookmarks,
States are updated
and time selection is
propagated to other

Add more views. When on a
bookmarks, then bookmark, the Add
click on the bookmark buttons
Next/Previous next/previous marker | changes to Delete
58 marker buttons bookmark Manual

With next/previous
marker, when on a
bookmark, click the | The bookmark is
delete bookmark deleted from all

59 Delete bookmark button views Manual

Click on the down
arrow at the extreme |All remaining
right of the view, then | bookmarks

expand Show disappear from the
markers and view, but remain in
Do not show uncheck the other views where
5.11 markers Bookmarks box the they are enabled Manual
Same as above,
recheck the The bookmarks
512 Show markers Bookmarks box come back Manual
6 Synchronizatiol
Selected time
line is updated.
If selected time
is outside
current range,
Select a random|time range is
Time time in another |updated to
6.1 synchronization |view include it. Manual

; Select a new .
Window range | indow range in Window range

6.2 synchronization |another view is updated. Manual
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6.3

Selection range
synchronization

In any other viewrange is outside

that supports
selection range
synchronization,
select a new
range.

Selection is
highlighted. If
the left time (T1)
of selected time

the current
range, then
window range is
updated to
include it

Manual
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Target:

LAMI
Ubuntu 14.04 6:

2.1.0-TraceCompassTestCases - Lami

Test Case

Action

Verification

Comment

0 Prerequisites
0.1 ‘Imporl traces |any trace since we use stub for the result ‘ | | |
Download analysis | https: eclipse. i
0.2 stubs |fmm bug: https://bugs.eclipse.org/bugs/show_bug.cgi?id=493941
Custom
external
1 analysis
Create the following analysis ($name, $command): All new external analysis are present under the "External Analysis"
node in the Project explorer view.
analysisEmpty, analysisEmpty All new elements do NOT have the strikethrough text style applied
. EXCEPT for the tuple (invalidAnalysis, invalidAnalysis)
analysisOneRow, analysisOneRow
multipleReports, multipleReports
invalidAnalysis, invalidAnalysis
errorResult, errorResult
clone, analysisOneRow
Right click on "External Analyses” node
Click the "add" action
Insert $name
Insert "fullpath/Sexecutable” which is the full path to the stub executable.
ex: " e y:
Add all stubs The path do NOT support ~ or relative path Nothing appears. But we could see all the properties files under /~/runtime-EclipseApplication/.metadatal.
1.1 analysis i eclipse. nalysis.lami -defined-co
1.2 Actions availables | Right click on a non-strikethrough custom analysis. The run action can be clicked and in enabled text mode.
Actions avaliables |Right click on a custom analysis. The run action CANNOT be clicked and is in disabled text mode.
Right click on the tuple (clone, analysisOneRow)
13 Delete analysis __|Select the delete action for the node The analysis does not appear in the list anymore.
analysisEmpty should return a message to the user regarding the emptiness of the report.
errorResult should return an error message to the user and display the result of the command.
14 Run analysis Launch remaining analysis via righ-click and run action All other one have resuit and should result in a new table and new report node under the report node.
2 Reports
The "Reports” node under the Project Explorer should contain 4
report:
analysisMultipleRow Report
analysisMultipleSimilarRow Report
analysisOneRow Report
21 Reports node Expand the "Reports" node under the Project Explorer multipleReports
An additional node should be present under the "Reports” node:
analysisOneRow Report #2
Note: This behaviour is subject to change in the following year but
22 Same name report | Execute the "analysisOneRow" analysis again. still an action will be taken on same name report creation.
23 Delete node Right click on the duplicate "analysis OneRow" node and click on the delete action The node reports is not present anymore
24 Open a report Right click on any report and select the "open” action A new panel should open with the result table of the analysis
Open the same
25 report again Right click again on the same report to open it A new panel should open with the result table of the analysis
26 Multiple report | Open the "multipleReports” report. Validate that a user is able to navigate between sub tab of a report
3 Result Table
31 isi Open the i p
32 Hide table Click the "Toggle" button in the right corner of the result table The result table is hidden
33 Show table Click the "Toggle” button in the right corner of the result table The result table is shown
Sort all column by clicking on the column name. Clicking multiple time on the name should change the ordering
34 Sorting sorter. Validate that the order make sense
35 Colum Resizing | Resize the column Validate that the resize works
36 Multiple selection | Select multiple rows by holding ctrl and clicking on muttiple rows of the table Muttiple selections are hi in the table
37 Unselect selection | Deselect multiple rows by holding ctrl and clicking on muliple selected rows of the table The clicked row should not be selected anymore
4 Bar Chart
4.1 Create Use the menu on the upper right of the result table and select "create bar chart"
42 Series dialog add | Select any x and any y click add Series are added to the series list
Series dialog
43 remove Remove all newly created series via the delete button User should be able to delete series
Abar chart should be created
44 Creat chart Select any x and y and click add and "ok" Note: a bar chart does NOT perform agregation of categories values
The corresponding row should be selected in the table and the chart
45 Selection Click on any bar inside the chart should highlight the selected bar
46 Multi selection Cri+click on other unselected bar lections should be hi in the result table and the chart
The clicked bar should be removed from selection and the result tablp
a7 Deselection Cri+click on other selected bar update with the current selections
Y axis should be in log scale mode
Note: check for zero value and negative handling since log scale do
48 Y axis Recreate the same graph but with the y log scale option enabled not support zero and negative
Keep the chart
49 open Keep the chart open
Hide the table
4.10 results Hide the table results
5 Scatter Chart
5.1 Create Use the menu on the upper right of the result table and select "create scatter chart"
A scatter chart should be created
52 Creat chart Select any x and y and click add and "ok" Note: a bar chart does NOT perform agregation of categories values
53 Selection Should be the same behaviour as the bar chart Should be the same behaviour as the bar chart
54 Multi selection Should be the same behaviour as the bar chart Should be the same behaviour as the bar chart
55 Deselection Should be the same behaviour as the bar chart Should be the same behaviour as the bar chart
56 Mouse hovering | Hover mouse in the graph On mouse hovering a cross should snap to the nearest point

98




2.1.0-TraceCompassTestCases - Lami

Full

Click in the chart when no hovering cross is present

Al selected objects should be desele
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Flame Graph

19

Windows 7 64 bit

Test Case

Action

Verification

0 Download the test resources Download this
1 Preparation
Use menu
Window — Show| Verify that 'Flame
View — Tracing |Graph View' view
1.1 Open TMF Flame Graph View — Flame Graph |is shown Manual
Import a trace that
does not have any
call stack
information, like 4 Verify that nothing
standard kernel |is shown in the
1.2 Import generic trace trace view Manual
Verify that the
Flame Graph
Import the trace in View is populated
the "trace" with some
directory of the |callers/callees
1.3 Import cyg-profile trace downloaded zip |information. SWTBot
Verify that the
Flame Graph
Import a trace in |View is populated
the "trace-fast" |with some
directory of the |callers/callees
1.4 Import cyg-profile-fast trace downloaded zip |information. SWTBot
2 Manage View
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Pass

Pass

Pass

Pass
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Close the 'Flame

Flame Graph' view
is removed from

2.1 Close view Graph' View perspective Manual
Use menu
Window — Show
View — Other ...|Flame Graph' viey
— Tracing — is displayed and
2.2 Open view Flame Graph re-populated Manual
Verify that view i3
populated with
Open "trace(- callers/callees
2.3 Open Trace fast)" trace information Manual
1) Close 'Flame
Graph' view
2) Open
"glxgears-cyg-
profile(-fast)" trac
located in the git ij Verify that view is
ctf test populated with
Open view when trace is already [3) Open 'Flame |callers/callees
2.4 loaded Graph' view information Manual
Open Experiment | Verify that view is
with 2 or populated with all
moreFlame Graph|callers/callees
traces. information
(You can use both|(separated by
2.5 Open Experiment traces) trace). Manual
Verify that view i
Restart Eclipse  |populated with
with Flame Graph|callers/callees frof]
2.6 Restart trace opened trace Manual

This is problematic

when the experiment
is too large. we need
to reset the time base
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2.7

Close all traces

Close traces and
experiment one by
one from the
editor tab

Verify that Flame
Graph view is
cleared after
closing the last
trace

Manual

3.1

Sorting

Thread name sorting

Open a trace
multiple Flame
Graph thread or
open experiment
with 2 or
moreFlame Graph|
traces. Then selecf
'Sort threads by
thread name'

The view is sorted
by thread name.

Manual

3.2

Thead id sorting

Open a trace
multiple Flame
Graph thread or
open experiment
with 2 or
moreFlame Graph|
traces. Then select
'Sort threads by
thread id'

The view is sorted
by thread id.

Manual

4.1

Synchronization

Time synchronization

Select a random
time in another
view

Selected time line
is not updating.
Nothing happen.

Manual
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1. Open the 'Call
Stack' View

2. In the 'Flame
Graph' view, right
click on a random

- The 'Call Stack'
view is populated
- The call stack
view is
synchronised to
rthe range of the
maximum call

entry in the graph | duration of the
3. Select'go to  |'Flame Graph'
4.2 Go to maximum maximum' selected entry Manual
- The 'Call Stack'
view is populated
1. Open the 'Call |- The call stack
Stack' View view is
2. In the 'Flame |[synchronised to
Graph' view, righttthe range of the
click on a random|minimum call
entry in the graph | duration of the
3. Select'go to  |'Flame Graph'
4.3 Go to minimum minimum' selected entry Manual
5 Function name import
1. Open the 'Call
Stack' view with
the 'Flame Graph'
view and the cyg-
profile trace Both 'Call Stack'
opened and 'Flame Graph'
2. Import 'cyg-  |views display
profile-mapping. |function name
txt' as mapping  |instead of function
5.1 Function name import text file address. Manual
5 Mouse handling
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Hover mouse in
time graph over

Tool tip shows

5.1 Mouse hover (empty region) |empty region |depth only Manual
Tool tip shows
Total time and
Hover mouse in |self times with
time graph over |standard
Mouse hover (state) state statistics. Manual
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Section # Bug Reports # Open # Fixed
Bug Reports 13 13 0
Test Case Bug Title Found Bug Report Status

[TMF] Sequence Diagram Overview feature nqt

Sequence Diagram 5.23|working well on recent platform versions 0.1.0 |https://bugs.eclipse.org/bugs/show_bug.cqi?id=436442 Open

LTTng 2 - Memory

Analysis 3.7, 3.8, CPU |[TMF] Status bar is not updated when

Analysis 4.10, 4.11 selecting time range in XY charts 0.1.0 |https://bugs.eclipse.org/bugs/show_bug.cqgi?id=436853 Open Enhanceme

LTTng 2 - Memory

Analysis 4.3, CPU [TMF] Time range selection outside current

Analysis 6.3, range should update current range in time

XmlAnalysis 7.3 graph views 0.1.0 |https://bugs.eclipse.org/bugs/show_bug.cqgi?id=436855 Open

LTTng 2 - Memory

Analysis 4.1, CPU [TMF] Time selection outside current range

Analysis 6.1 should update current range in xy charts 0.1.0 |https://bugs.eclipse.org/bugs/show_bug.cqi?id=436861 Open
[TMF] Original experiment reappears after

Project View 6.5 rename and copy 0.1.0 [https://bugs.eclipse.org/bugs/show_bug.cgi?id=436888 Open
[Ittng rcp] Opening a second trace with --open

RCP 1.4 activates the wrong editor 0.1.0 |https://bugs.eclipse.org/bugs/show_bug.cqi?id=443461 Open
Sequence diagram interaction tooltip is hard tg

Sequence Diagram 3.1 |read on Ubuntu 0.1.0 [https://bugs.eclipse.org/bugs/show_bug.cgi?id=455523 Open
Button gets disabled in print dialog of

Sequence Diagram 5.24{sequence diagram after clicking on it 0.1.0 |https://bugs.eclipse.org/bugs/show_bug.cqi?id=455546 Open

Memory analysis 2.4/ |[TMF] XY chart view is cleared after being filled

CPU Analysis when restarting or opening a trace 0.1.0 [https://bugs.eclipse.org/bugs/show_bug.cgi?id=467751 Open

Control view 17.9 NPE trying to destroy a session 1.0.0 |https://bugs.eclipse.org/bugs/show_bug.cqi?id=469424 Open
SWTException widget is disposed trying to

Control view 17.9 import trace from Control view 1.0.0 [https://bugs.eclipse.ora/bugs/show_bug.cgi?id=469425 Open

Project view Import to experiment will swallow exceptions 1.1.0 [https://bugs.eclipse.org/bugs/show_bug.cgi?id=476475 Open

Time Chart 2.3 IOException in FlatArray.insert 1.1.0 [https://bugs.eclipse.ora/bugs/show_bug.cgi?id=476487 Open
Deleting a project with the delete key does not

Project Explorer 3.21 work 2.0.0 |https://bugs.eclipse.org/bugs/show_bug.cqi?id=486505 Open
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